CXprofD
USER GUIDE

(%)
<
>
)
—
m
=
m
o)
0
<
(@)
@)
=
_|
o)
@)
—



an04dxD

© Cylon Controls Ltd. 2019. All Rights Reserved.

CXpro"® (MANO0133 rev 9)

Information in this document is subject to change without notice. The software described in this document is furnished under a
license agreement or nondisclosure agreement. The software may be used only in accordance with the terms of those agreements.
No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or any means electronic or
mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written
permission of Cylon Controls Ltd.

TRADEMARKS
All trademarks and trade names used in this document are acknowledged to be the copyright of their respective
holders.

UniPut™ technology is covered by UK Patent GB 2 400 991 and Irish Patent 84413

Cylon’)

www.cylon.com

2 © Cylon Controls Ltd. MANO133 rev 9



Style conventions used in this document:

Ul Text: Text that represents elemets of the Ul such as button names, menu
options etc is presented with a grey background and border, in
Tahoma font which is traditionally used in Windows Uls. For example:

Ok

Standard Terms (Jargon): Text that is not English Language but instead refers to
industry standard concepts such s Strategy, BACnet, or Analog Input
is represents in slightly condensed font. For example:

BACnet

Code: Text that represents File paths, Code snippets or text file
configuration settings is presented in fixed-width font, with a grey
background and border. For example:

$config file = c:\CYLON\settings\config.txt

Parameter values: Text that represents values to be entered into Ul fields, or
displayed in dialogs is represented in fixed-width font with a shaded
background. For example:

10°C

Product Names: Text that represents a product name is represented in bold
coloured text. For example:

CBX-8R8-H

Process or Feature: Text that represents a particular task that the product
performs (Download, LivelLog), or a specific attribute of the product
that appears as a separate entity (log) is displayed bold and
condensed. For example:

LiveLog

PC Keyboard keys: Text representing an instruction to press a particular key on
the keyboard is enclosed in square brackets and in bold folt. For
example:

[Ctrl]+[1]
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The Cylon BACnet Building Management System is made up of several components, which fall into two main
categories:

e Hardware - the products that monitor and control a building's environment.

e Software - the interface which allows users to configure and monitor Cylon Hardware.

HARDWARE COMPONENTS

Cylon BACnet uses the following main hardware components:
e Routers.
e |/O Field Controllers.
e Keypad
e PC

There may also be other supplementary hardware components such as printers, modems, pagers etc., but these
are not essential to the basic system.

Routers

CBR devices route communications between BACnet IP and BACnet MS/TP networks.

Aspect® MATRIX Series and NEXUS Series devices are programmable communications controllers, which provide
supervision of Cylon BACnet networks, and route communications between BACnet IP and BACnet MS/TP
networks.

3rd-party BACnet Routers can also be used with the Cylon BACnet system.

1/0 Field Controllers

PC

CBM and CBT Field Controllers take inputs from sensors and Building Control plant, and send output to Building
Control plant in response. They are available as programmable or unitary controllers, with various input/output
configurations.

These I/O controllers can be programmed with Strategies, which configure them to send specific outputs to
connected devices in response to events occurring on their inputs. For example, you can create a Strategy in
CXpro"'® and download it to a Field Controller specifying that a valve be opened if the temperature being input to
the controller rises above a predetermined level.

Cylon Field controllers are networked together using RS485 by BACnet Routers, which in turn are networked by
Ethernet. A Field Controller can also be linked directly to a PC, as well as to a modem or a printer.

The PCis connected to a Cylon network by Ethernet, RS232 or modem connection. The PC can also be connected
directly to a Field Controller for small installations with stand-alone controllers.

CXpro"'® software - which is used to configure the controllers, schedule events and extract reports - is run on the
PC., which must have Windows 10 Professional 64-bit and Windows 7 Professional / Enterprise / Ultimate 64-bit
installed and running.

The minimum configuration to run this application is: Core 2 Duo E6300, 1Gb RAM, 80Gb hard drive.
The recommended configuration is: Core 2 Duo E6600, 2Gb RAM, 160Gb hard drive.

Connections between hardware components

The following types of connections exist between the hardware components:
e  Fast Ethernet bus connecting CBR routers and Aspect® devices with the CXpro"® PC.
e An RS485 fieldbus, using shielded twisted pair cables, connecting the BACnet Router to the I/O controllers.

10
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SOFTWARE COMPONENTS

The Cylon suite of software applications is used to set up, maintain and control the Cylon system in operation.

CXpro*"® modules

The following applications are available from CXpro"® group in the Windows Start menu :

Configuration (CCConfig)

The Configuration program contains a blueprint of the system, which can be accessed by other
programs as required. It is used to define systems, networks, sites, authorised users, modem protocols,
port setups, etc. and to activate alarms. Levels of access for different users can also be defined here.
(See also MAN-0100 Configuring the Cylon System.)

Database Interface

The Database Interface program allows you access to the database that contains details of all the point
values on each Field Controller in the network. You can set point values graphically in CXpro"®, or you
can enter or delete them in the Database Interface program.

Datalog Manager

A datalog in CXpro"® logs the value of a specified point in a Field Controller at a specified interval so that it
contains a record of the changes in that point value over a period of time. The Datalog Manager
program allows you to display the contents of a datalog in either graphic or tabular form. (see also
MAN-0043 Datalog Manager User's Guide)

Engineering Tool

CXpro''® is a graphical interface created for programming the Cylon the product range. In CXpro®P,
strategies (which tell a controller how its outputs should respond to conditions on its inputs) can be
designed, edited and downloaded to, or uploaded from, Field Controllers. CXpro"® could be described as
the most important of all the Cylon applications, as it is the application that programs the Cylon
controllers. This manual describes how to carry out a variety of tasks in CXpro*P.

Manage Software Licence

Site Organiser

The Site Organiser is an easy way to configure and examine a complete site or part of a site. Instead of
downloading strategies individually to all the controllers on a site, this can be done in one simple task.
Any combination of strategies can be downloaded to any combination of controllers or to one type of
controller in a .ins batch file. (See also MAN-0020 Site Organiser manual.)

Start CXpro*®

MANO133 rev 9
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CXPRO"P — OVERVIEW

CXpro*"® provides all of the tools required to design, configure, test, commission and maintain Cylon BACnet
systems automatically.

You can use CXpro"® to:

Graphically create strategies that implement solutions to conditions on site.

Save those strategies for future editing, testing or reference.

Test the operation of strategies.

Debug and edit strategies.

Download strategies to the appropriate controllers.

Define and assign 3rd party blocks to carry data across a Fieldbus.

Define and assign wide 3rd party blocks to carry data between Fieldbusses and across the network of a site.
Upload existing strategies from controllers.

Upload analog and digital point values from controllers.

Upload statistical and reference information from controllers.

Record changes that occur on a site as they happen and save the record to a file.

12
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INSTALLING CXPRO™P

To install CXpro"®, run the program CXpro#® Setup.exe from the provided USB drive or download:

El

Marme Date modified Type Size

. DAO3E0 27/07/2018 11:00 File folder

.. Firmware upgrade utilities 27/07/2018 11:00 File folder

L veredist_x86 270772018 11:.00 File folder

Ju veredist_x86_2008 27/07/2018 11:00 File folder

| veredist_x86_2010 27/07/2018 11:00 File folder

¥ | autorun.inf 8/01/2017 12:50 Setup Information 1KB
|ﬁ5‘ CxproHD Setup.exe P 27/07/2018 03:20 Application 138,322 KB
ﬂ doth etdeﬂ_FuII_xSﬁ_xE-d.Qe 19/01,/2017 12:50 Application 44,268 KB
(3] hinstall.exe 21/06/2018 02:12 Application 20,926 KB
[ Isinit.exe 19/01/2017 12:50 Application 524 KB
|| Readme.tt 19/01/2017 12:50 Text Document 2 KB
(577 ShelExec.exe 9/01/2017 12:50 Application 19 KE
29 UnitrenFingerprintCollection. exe 8/01/2017 12:50 Application 1,212 KB
ﬁ' UnitronSymbelsLibrarySetup.exe 19/01/2017 12:50 Application 768 KB
(53] Windowslnstaller-KB293803-186.exe 19/01/2017 12:50 Application 2,525 KB
(27 WindowsXP-KB893418-x86-ENU. exe 9/01/2017 12:50 Application 550 KB

Press Next on the installation screen,

then read and accept the License Agreement

§5! Setup - CproHD

CXpr°

- X

Welcome to the CXproHD Setup
Wizard
This will install 1.01,00-304 on your computer,

It is recommended that you dose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

License Agreement

Setup - CXproHD
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Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

READ CAREFULLY! -~

This Cylon Controls Ltd. End-User License Agreement (" Agreement”) is
alegal agreement between you (either an individual or a single entity
known as "Customer") and Cylon Controls Ltd . which owns a proprietary
computer software engineering system which inchides computer software
and "on-line" or el ic d ion and iated media and
printed matesials (collectively known as Unitron Command Centre, Cylon
Engineering Centre, and Unitron Weblink | and hereafter referred to as

I D i st

i #tam € B

R P i ;minsianoe e e mimesie n ae

(®) I accept the agreement
do not accept the agreement

<Back | Mext> | | cancel

MANO0133 rev 9 © Cylon Controls Ltd. 13
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8 Setup - CXproHD = =

Specify the location into which CXpro"® will be installed. S
Select Destination Location
Where should CXproHD be installed? x

l Setup will install CXproHD into the following folder.

Note: Make sure there are no spaces in the
location, and that none of the following
charactersareused: . ! §

To continue, dick Next. If you would like to select a different folder, dick Browse.

[e:\cxprono] Browse...

Atleast 177.8 MB of free disk space is required.

< Back NEXS Cancel
. Setup - CXproHD - o
Enter a name for CXpro"®'s Windows Program Group. = SRR
Select Start Menu Folder
Where should Setup place the proaram's shorteuts? x

v
Setup will create the program's shortcuts in the following Start Menu folder.
[

To continue, dick Next. I you would like to select a different folder, dick Browse.

[xpronn] Browse...

< Back Nexrg Cancel
i Setup - CXproHD - ©
If you would like a Desktop Icon for CXpro*®, check the box | * SP=CI
e . Select Additional Tasks
on the Select Additional Tasks dialog. \hich scitionsl tasks should be performed? x
You can also specify if you want to use US imperial units for e g7 ke o ok e Sctup i perfom et Ctrer,
sensor readings, or not. tionalicor:

Create a desktop icon

Select the sensor file to use:

(®) Other
Ous
Click Next.
< Back NEXS Cancel
i Setup - CXproHD = =
Ready to Install
Setup is now resdy to begin instaling CproHD on your computer,

Click Install to continue with the installation, or dlick Back if you want to review ar
change any settings.

Destination location:
C:\CXproHD

Start Menu folder:
CXproHD

Additional tasks:
Additional icons:
Create a desktop icon
Select the sensor file to use:
Other

Click the Install button to start the install process...

< Back Ins&ll Cancel

14 © Cylon Controls Ltd. MANO133 rev 9



5 Setup - CXproHD

Installing
Please wait while Setup installs CXproHD on your computer.

Extracting flles...
C:\CXproHDHelp\UC 1632.HLP

o
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|
. . . F Configure Connection Settings
When the install process finishes, you will be prompted to —
configure the BACnet connection settings. -
;E’T?;:’\CE Instance ,214—
The PC Device Instance Number will be set to “-1”. This must - “EE
be changed to a unique Device Instance Number. e
Number of retries e
In the Network Adapter drop-down list, select one of the PC’s Time ot » seconds
network adapters to be used as the channel for all BACnet [ e —
communication. Time to e o
If you wish to connect to a remote BACnet Site, enter that SerilCarne
Site’s IP address in the BBMD settings section. ¥ et
Detected COM 3
If CXpro"® will connect to the BMS Site through a Serial ot Jeom =
. . . . . . Portspesd: [5500  v|
Connection, that connection can be configured in this dialog.
When the Configure Connection Settings dialog is complete,
click Save .
. . . Setup - CXproHD - =
You will be offered the option to install Cylon’s BACnet * S
. . . . . i
exploration/commissioning utility, NBpro. e vkt vhle 5tup ok ot oy compats x
Finishing installation...
Setup

NEPro is a commissioning environment for BACnet controllers. Using
NEPro, users can setup and configure devices to create control
programs and strategies for building automation systems.

Would you like to install NBPro?

Yes I} No

Cancel

MANO133 rev 9 © Cylon Controls Ltd. 15
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NBPro Setup - oIEd

Welcome to the NBPro Setup
Wizard

If you click Yes , the NBpro Setup Wizard will open:

‘This wizard wil guide you through the installation of NEPro.

Itis recommended that you dose all other applications
before starting Setup. This vl make it possble to update
relevant system files without having to reboot your
computer

Click Next to continue.

e Cancdl
BPro Setup - oIEd

=

Choose Components
Choose which features of NBPro you want to install.

Check the components you want to nstall and uncheck the companents you don't want to
install. Click Next to continue,

Select components to install:
Installupgrade Sentinel Super-Pro Dengle
Start Menu Shortouts

Desktop Shortcut

Space required: 32.7MB

<Back Ne;&> Cancel

e NBPro Setup - oIEd

Choose Install Location
Choose the folder in which to install NEPro.

Setup will install NBPro in the following folder.

To install in a different folder, dick Browse and select another folder. Click Next to continue.

Destination Folder

[ 2tprogram Files (x85)\American Auto-Matrix\NEPro Browse...

Space required: 32.7M8
Space avalable: 21.6G8

< Back Insyall Cancel

() BPro Setup

Installing
Please wait while NBPro is being installed.

Registering: C:\Program Files (x86) \CXproHDYNBProlmscomct.ocx

Show detais

NBPro Setup -

Completing the NBPro Setup Wizard

NEPra has been installed on your computer,

Click Finish to dose this wizard.

MANO133 rev 9
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You will be offered the option to generate a licence
request file for the PC on which you are installing
CXprot'®,

i you want to get the licence now, licence details will
. . automatically be created and you will be asked for a file name
You can do this now, or at a later time - see to save them. You will then have to send the file to CYLOMN,

Requesting and Applying a Licence to CXpro*® on page Do youwantto creste the file now?
18 for details.
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If you have already installed a Cylon licence on this PC -
you may skip this step.

If you select Yes, then you will be prompted for a filename and location. Save the Licence request file, and
then email it to Cylon in order to receive the Software Dongle.

CXprot® is now installed. If prompted, you may need 5 Setup - CXproHiD -

to restart the PC before using CXpro*P. Completing the CXproHD Setup
Wizard

HD Setup has finished instaling CXproHD on your computer, The
' x pro application may be launched by selecting the installed icons.
Click Finish to exit Setup.

MANO0133 rev 9 © Cylon Controls Ltd. 17
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REQUESTING AND APPLYING A LICENCE TO CXpro*P

CXpro'P requires a valid licence in order to operate. The licence is provided by Cylon via email.

Note: Before getting a licence, ensure that your computer is not connected to a network through an
external device (such as a docking station). Othewise, the licence may not be valid once the
docking station is disconnected from the PC. A cable directly attached to the PC or a Wi-Fi

connection are OK.

Requesting a licence

When the PC does not contain a licence when
CXprof® is being installed, you will be offered the

s The application will require a licence.

option to generate a licence request file for the PC on .:0:.

which you are installing CXpro*®.

If you want to get the licence now, licence details will
automatically be created and you will be asked for a file name
to save them. You will then have to send the file to CYLON,
Do you want to create the file now?

If you select Yes, then you will be prompted for a filename and location. Save the Licence request file, and

then email it to Cylon in order to receive the Software Dongle.

When running the application

If you choose not to request a licence during the installation process, the software will operate for a period of
time. After that period has expired, you will not be able to use CXpro"®, and a message will be displayed

prompting you to register the software:

CxproHD

% Your licence is invalid or expired.
Do you wish to register it?

Click Yes to open the Licence Details dialog:

Licensee
Serial Humber 0
Status No licence

No licence! ~
To obtain a licence:

Click on the "Request new licence...” button below. A key will be created and ask you to save it to a file,

Select a location and file name and press Save.

Send the file to your local Cylon representative. A new license will be produced and sent to you.
Click on the "Apply new licence...” button below. It will ask you to select the file sent from Cylon.

Select the file and press open.
v

Request new licence... Apply new licence... Close

18
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If you click the Request new licence... button you will be prompted for a filename and location. Save the Licence
Request file, and then email it to Cylon in order to receive the “Software Dongle” (licence file).

Note: If the PC does have an active licence or is still in the grace period, the Licence Details dialog can

be accessed by selecting Licence Details from the File menu.
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File - Home Contraoller Strategy
[ new Recent Documents £ |CEas | 1 [
= Open I:lﬁ Strategy Help Q
1 CACXproHDV.. A\DO2\002_02.532 Configuration Da
™ save Reopen Strategies Ini
— 2 C:\CXproHD\,. \DD1\001_02.532
[] N A
Sarelill 3 003_00_rebuilt.s32
Q Footers

4 CA\CXproHDY,. \00TW001_02.532
gl Page Size

& printer Scaling | 5 CACXproHD\...\0101010_00.532
?-5 Print Setup
= Print

® Licence Details

@ LClose

6 C:\CXproHD\,.\00%\009_00.532

@Heip (D about K Exit

4o CBXSITEMODBUS
To DISCOVERY
2 NEWCBXISITE

Applying a licence
When the licence file is received from Cylon, it must be applied to CXproHD as follows:

Select Licence Details from the File menu to open the Licence Details dialog.

Ltd. Dealer Ve D = R .
Licensee
Serial Number 0
Status Ma licence
Mo licence! ~
To abtain a licence:
Click on the "Request new licence...” button below. & key will be created and ask you to save it to a file.
Select a location and file name and press Save,
Send the file to your local Cylon representative. & new license will be produced and sent to you.
Click on the "Apply new licence...” button below. It will ask you to select the file sent from Cylon.
Select the file and press open.
W

Request new licence... Apply new licence... Close

Click the Apply new licence... button.

MANO0133 rev 9 © Cylon Controls Ltd. 19
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In the Windows Open File dialog, select the file supplied by Cylon, and click Open .

A message is displayed indicating that the licence has been applied successfully:

Cylen Controls Ltd. Dealer Version Dongle - Mot for Resale =
Licensee
Serial Mumber o
Status Mo licence
CXproHD X

No licence! ~
To obtain a licence: i h Licence applied successfully,

Click on the "Request new licence, L — you to save it to a file.

Select a location and file name an|

Send the file to your local Cylon re nd sent to you.

Click on the “Apply new licence...” ent from Cylon.

Select the file and press open,

Request new licence... Apply new licence... Close |

When you click OK , the details of the licence will be displayed:

Cylen Controls Ltd. Dealer Yersion Dongle - Mot for Resale it
Licensee
Serial Number
Dealer
Status Hegistered

Expiry Date 20200418

# Cylon CX pro HD license file ~

# General Information
DateGenerated=2019/04/18
Hardware|D=

Dealer=

SitelD=

Comment =

SerialMumber=
SalesOrder=

QEM = Cylon

Update licence... Apply new licence... Close |

The software is now licenced.

20 © Cylon Controls Ltd.
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STARTING CXPRO"MP

Open the CXpro"® section on the Windows Start menu or start screen , or search for “CXpro"®” in the Application

search box .

Click on the Start CXprotd icon. The CXpro®® interface will open:

Quick-Access Toolbar =1z n KX 5] = B
@

o G Cw Ol CdCq

Alows access to - Configuration Database Datalog S'rle_ Backup ME-Pro
program options b= = LE TEEE T Interface Manager Organiser
Utilities

S0 BACnetIP

S0 BACnet Serial
E_E Sample Apps BACnet
52 001 - Wet Systems
----- - CT Single P
: o e &, 1113 - CT Single P
Site List : g

Right-Hand Pane
For Modules, Module Properties,
..... T Dudl Pun Page Navigation etc.
..... - CT Dual Pui
..... - CT Dual Pui
----- &, 1121- VT Single Py
----- &, 1122- VT Single Py
----- &, 1123 - VT Single Py
----- @,, 1124 - VT Dual Pur
----- @,, 1125 - VT Dual Pur
----- &, 1126 - VT Dual Put
----- &, 1131 - Four Boilers
----- @’, 1132 - Four Boilers

=, 1133 - Two Boilers
..... &, 1134 - Four Boilers
----- &, 1135 - Four Boilers
----- &, 1136 - Two Boilers v

Rl 4444 inasm s o

T 3

Page Mam... Modules Properties
Connected to: Sample Apps BACnet (3], R R .'l \ i

Note: If other Cylon Engineering Softwre, e.g. CEC7 is installed on the same PC, then instead of the
CXpro*P interface opening directly, a “Chooser” dialog opens first allowing the user to select the
software to be opened.

22 © Cylon Controls Ltd. MANO0133 rev 9



THE CXPRO"P INTERFACE

The CXprot® User Interface consists of the following sections:

Site List "} |-

The Site List E@ gites ~ Il

52 001 - Network
-& 001 - 001 - UCU32
&= 001 - 002 - CBM24
To BACnet Serial
E---JE.E Sample Apps BACnet
BB 001 - Wet Systems
----- @’, 1111 - CT Single P
----- @’, 1112 - CT Single P
----- E‘, 1113 - CT Single P
----- &, 1114 - CT Dual Pui
----- &, 1115 - CT Dual Pui
----- @,, 1116 - CT Dual Pul
----- &, 1121 - VT Single P
----- &, 1122 - VT Single P
----- E,, 1123 - VT Single Py
----- &, 1124 - VT Dual Pur
----- &, 1125- VT Dual Put
----- &, 1126 - VT Dual Pur
----- &, 1131 - Four Boilers
----- &, 1132 - Four Boilers
----- &, 1133 - Two Boilers v

This gives an overview of the BMS Sites that
are accessible from this PC

Rl aa-a - L
£ >
2B <« Strategy1 r % | [Mg
The Strategy Drawing Area N - - For
m Anakog Satooint T
) IEn } 7. Room Setpoint i Co
This part of the Ul shows the modules and e — co
. . [ Tenesble Forwerd FID Fi
points in the current Strategy, and the p L
. IO Setpant Output o
connections between them, e e =l
ep o Room Temperature T
e int € | Erati=
qu C } mp:'dam I@ [Emagramn g
ohr L L L L L ;f
<Py Al owem 4
Pur r
Pur L ]
Pur Overc- [ °,
lers [
s =
lers ol
‘> e > Pa
< - '@
The Right-Hand Pane (Inspector) b
Constants »
. . . Contrals
On the right-hand side of the Ul there is an Functons -
area that displays the Modules library, a B anaog Gae

Comparator 2

Module Property editor, a BACnet properties
inspector and Page navigation panels.

Digital Encode

Digital Extract

- Uimit at Min and Max

By default these panels are displayed one- o
by-one in a tabbed interface, 7 wake tnear
:/: Rescale Custom

w s
.7, Rescale from 0 to 100

v |l v
Page Nam... Properties Modules

—_—

iernet R
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but the layout can e g
be Conﬂgured by + X |75h0|wPageNumber;On|
. Page Mumber Page Mame

dragging the tabs S0 o
that the panels can

be displayed all

togetheras  shown

here:

te - BACHet
The Ribbon

At the top of the CXpro"® User Interface, there is a palette similar to many Windows applications called the

Properties i x |
< » 7 |Tuneable Forward PID |
=]
Type Tuneable Forward PID
Service Order 1

Synchronised Stat.. Disconnected

=]
Setpoint Analeg 1 Room Setpo...
Process Variable Analeg (1) Room Te..
Gain Analog
Enable Digital
Integration time | Analog
Derivative time | Analeg
(=]
Integration time 900
Derivative time 0
Service time 1
(=]
Qutput Analog (9) Heating V...
Integration time

Period of integration of difference between the
Setpoint and the Process Variable. Set to zero to

Modules

Favorites

Constants

|-c|_| Digital Constant

Int

_— Integer Constant

’E: Real Constant
Controls
Functions

Math

Schedules, Timers, andL..

Setpoints, Inputs, and Q..

Statistics
WAV
Virtuals

!

Ribbon. The Ribbon allows access to the majority of CXpro"® features.

File - Home Contrgller Strategy
’ Connect 4@ Communications Iil Download I—?:I Compare
4@’ Disconnect % Contraller )‘B Wipe Controller Show Compare
% BACnet Iflk Auto Online

Site Configuration Operations

B 3 1 ﬂ§ &
g X O ltlg
Scan  Override Livelog
:l| Foint T
Testing

T 100%

S =

Interface Configure
Builder

Keypad

The feature options are grouped into tabs each of which contains a different set of options.

The Quick Access toolbar

If there are specific Ribbon feature options that you use often, you can add them to the Quick Access Toolbar

where they will be accessible at all times:

S BEG Q-

Fila = HrAma Camtrallar

To do this, right-click on the feature in the Ribbon and select Add to Quick Access Toobar :

r| r — o= —] —l
I;; | Adf}to Quick Access Toolbar

Tl

ra| = Customize Quick Access Toolbar...

Show Quick Access Toolbar Below the Ribbon

Minimize the Ribbon
=TT

UM

vl lw|lwv|vr|r|r|>r|~

@

24
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CONNECTING TO A FIELD CONTROLLER

Work in CXpro"® can be done on-line or off-line. When on-line, the PC can communicate directly to the
controller. When off-line, there is no direct link between the PC and the controller. For tasks that involve direct
communication between the PC and the controller, e.g. uploading or downloading information, it is necessary to

work on-line.

e To work on-line, you must connect to the controller by clicking on the Connect button in the Home tab

of the Ribbon :

File

I d

&

= Home Controller Strategy

Co§e¢ m Copy Properties Modules EE Strategy
Discinnect LﬁPaite Navigatian Macros |:| Reopen
..... Sits
i_iSelect All Lis: EPage Mames @Search

Site Clipboard View

Site List o x (i Strategy1

B@se [T

B-3g BACnetie |
§oB-=2 o0t -Network ||
i -3 01-001-ucuztv il oo

e To work off-line, click the Disconnect button.

MANO133 rev 9
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OPENING STRATEGY FILES

To open a strategy file in CXpro"®, you can

e (Create a new strategy

or

e  Open an existing strategy file.

It is possible to open multiple files: multiple new strategies in different controllers, multiple existing files, or a

mixture of both (see page 27)

To create a new Strategy, either double-click on a Field Controller in the Site List that does not already have a

Strategy associated with it, or select New from the File menu

8

File -

[ tiew

[=7 Open
Bgave

@ Save As

Save All

Q Footers

QI Page Size

QI Printer Scaling
P, Print Setun

Home Controller

Recent Documents

Site List + B
=) Sites
o-£g BACnet IP
-2 001 - Network
1= 001 - 001 - UCU3213V
&= 001 - 002 - CBM24
B-Fa BACnet Serial
B 001 - Network
E-2a Sample Apps BACnet

Strategy

Properties

Engineering Centre

"""I There is ne Associated Strategy with this controller. Create a new
Y Strategy?

You will be asked if you want to create a new strategy — click Yes .

2 B Modules

Favorites
Constants
| Controls

Functions

Math

Schedules, Timers, andL...

Setpoints, Inputs, and 0.

Statistics
VAV
Virtuals

AR AR AR BE AR SR AR AR AR AFY |

To open an existing Strategy file, double-click on a Field Controller that has an associated Strategy, or select Open

from the File menu:

a8

¥
File -

D Hew
£ open
B Save
@ Save As
[7]) Save Al
@ Footers

Home Controller
Recent Documents

1001_01.532

Engineering Centre -

Strategy

fl Wz BAcnetPe
id 8} Bacnet
rjirs O strategy D
tegy

26
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NAVIGATING A MULTI-PAGE STRATEGY

For clarity, many strategies are drawn over several print-pages. To facilitate navigation through these pages,
CXpro"'® provides a Page Navigation panel.

To open it, select Navigation on the Home Ribbon.

= Engineering Centre - 8.00.00-286
File - Home Controller Strategy
’ Connect @ Copy Properties I[D Modules |Ez| Strategy Help F r." [
b" Disconnect L‘ﬁ Paste Mavigation Macros D Reopen Strategies a =
Ui select Al ?E: Page Names @] search SOTEIER E):tt::::: ;3:
Site Clipboard - View L
Site List g |« 001_01.532 b x| Properties
E@ Sites — — — "

5o BACnetIP

522 001 - Metwork

=, 001 - 001 - UCU32I3V
= 001- 002 - CBM24
%-E BACnet Serial

-2 001 - Network

"%E Sample Apps BACnet

The button turns green to indicate the panel is currently displayed:

-] Engineering Centre - 8.00.00-286

File - Home Controller Strategy

’ Connect @ Copy

Properties |

[[E] Modules |Ez| Strategy Help r‘] r’l [
o =

J Disconnect L‘ﬁ Paste Mavigation | Macros D Reopen Strategies
— Site — Configuration Database Di
{_iSelect All List IE Page Names @ Search Interface Mz
Site. Clipboard View L
Site List 2 E Havigation o E Properties
E‘"O Sites.

s
B-Ig BACnet IP -
E£-32. 001 - Netwark -
-
&}, 001 - 001 - UCU3213V -

- 001-002 - CBM24
-Fo BACnet Serial
-3 001 - Network
“EE Sample Apps BACnet

The Navigation panel appears by default as a docked panel within the CXpro"® window, but by dragging its title
bar it can be repositioned within the window or even ‘popped out” as an independent window that you can
position anywhere on your monitor:

MNavigation H

[]5a"

MANO0133 rev 9 © Cylon Controls Ltd. 27
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The Navigation panel shows blank rectangles to indicate strategy blocks, and a red rectangle to who the current

Strategy Drawing Pane . Dragging the red rectangle moves the display within the Strategy Drawing Pane :

Site Configuration Database Datalog Site Backup
ct All List Page Names @ Search Interface Manager Organiser
ard View Utilities
L x (] 001_01.532 b x | |Properties
ke

Al room e

ork E
n-vcus2wv |- oo oo . o oo

)2 - CBM24

ork
ACnet

Anzlog Sat;

[
Setpoin
MNavigation H

ELN

Analog !
m Room Ten

Labelling the pages within a strategy drawing

An alternative method for navigating a large Strategy is to use page names. A pane is available for this, to open it
click on the Page Names button in the Home ribbon:

[ea [

File - Home Controller Strategy

’Connect @Copy Properties Modules|az|5tr
h” Disconnect Iﬁpaste Navigation Macros |:| Re
i__' Select All Fage Mames @ Search
Site Clipboard View
Site List g3 4 001_01.532

EO Sites

EEE BACnet P

Sty

[ roperies |[Eivtodues [Fstisteqy vt QO EOoOCoOoR
@]. o | B Mecros ] Reapen Sategies 2 Ly Ly Lo le
S LEtodaotion Sackup HE.Pr0
T [[EPeoe rames B sesrn

Configurstion Datshase Dstsiog  Ste
Interface Manager Organiser
vtaties

o@ oo o532 x| TN aE |
LS ~ | 4 X [ ShowPageNumbers On Drawing

&g B Page Number | Page Name

T B 001 - Hetwork o .

= 001 - 091 - UCURZIV
| 001 - 002 CBM24
-5 BaCnet Seral

T 52 001 - Netwark

2g Semple Apps BACnet

There are na items to show in this view. i
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The Page Names panel appears by default as a docked panel within the CXpro"® window, but by dragging its title

bar it can be repositioned within the window or even ‘popped out’ as an independent window that you can
position anywhere on your monitor.

(ve)
Q
@,
(9]
. . —
The Page Names pane allows you to hide the page number on the Strategy Drawing: o
73
(%]
Q=
#F connea | (Ficopy [Eproperties [ Modules [2] sratey Heip
Chseiean | | fg |[Pane ames| ] searcn o e Msags Oraaer T "
Site List = ag . m|_n|.x!1m~ — Ix Page Mames L -
2§ Stes | 4 X T ShowPage Humbers On Drawing
5-1g BAChe P PageNumber | Page Name
=2 = Network
001 - 001 - UCU313V
001 - 002 - CBM24

&S BACnet Serial
= 001 - Network
B-$o Semple Apps BACnet

‘There sre no items to show in this view. i

And allows you to add names for pages instead numbers:

[+ X | Page Names o B
A ® [ Show Page Mumbers On Drawing

Page Number | Page Name |

MNew Page Mame

Fage s ]
T4 K ko Page ke O Dersing

Fogeumbe o

I

5,501 e
g St s Bne

Double-click on the name in the Page Names pane to edit it:

Page Mames a B
+ X [ Show Page Numbers On Drawing
Page Number | Page Name |

Y -] |
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and the new name is displayed on the Strategy Drawing:

Fie - | ome | Comtromer  Sirategy

#F connet | [jcopy E‘Wmﬂrmwnm r|° r‘E m r.r'b mr.

¥ Oisconnect | jpaste | [hamgation [BMocrss [ Reopen Strstegies

T Contigumation Dutabase Ditaioy  Sie._ Backam NE-Pro
Ciseectn | g |[gPage ames [ sewrcn larts Macager gt
s Cinors view frises
shetist o V% | Page Hames amj
) Snes ~ 4+ X [ ShowPage Numbers On Drawing
e-lg Bacnaip Page Humber | Page Hame
| TR 2

| = 001- 001 -ucuszav
| - 001 - 002 - CBM24
&-Fe BaCnet Serial

| @B 001 - Network

@-Zg Semple Apps BAChet

) Rask Tomp o
1
T bea
o
=5
uadberd T
AR
: bnactand 3 1

Click on a name in the Page Names pane to align the top left corner of that page in the top left corner of the

Strategy Drawing Pane :

o = Engineering Centre - 8.00.00-286

File - Home Controller Strategy

’ Connect @Cnpy | Praperties Modules Estrategy Help | m E!'l m Q m G |

_@‘ Disconnect LﬁPaste E Mavigation Macros D Reopen Strategies

Site Configuration Database Datalog Site Backup NB-Pro

Select All List |[[= Page Names  [&] search Interface Manager Organiser
Site Clipboard View Utilities
Site List 1B |« 001_01.532 ] I % | Page Names 1B N
E--@ Sites - + X [ Show Page Mumbers On Drar
B-xg BACnet P mT1OCe. L Page Number | Page Name |
252 007 - Network 1 Inputs
-, 001-001-UCU3213v ||, . B . . . . . . . . 2

.= 001 - 002 - CBM24
EI--EE BACnet Serial
- B2 001 - Network
E-Ig Sample Apps BACnet

P
7 Toreabie Fyseess = |
(@ e Active High [0
71 On Level Active Law [0
~] OF Level :
On level 2.00: level: 4.00
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FINDING AN ELEMENT IN A STRATEGY

CXpro"™s Find pane is a facility for locating specific objects in a strategy, @
Q
(%]
It is opened by either pressing [Ctrl]+[F], or by selecting the search window from the Home tab of the Ribbon . o
[
%
Search Results
X Delete [~ Select All [Module ~| TPe [Boolean | MNeme | <] Number [ ] QUFind Q Q
E- |_ Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - Network: 001 - 002 - CEM24 (2 matches)
.. Boolean
.. Boolean
This pane contains a number of lists in which you can specify a number of filters to reduce the kinds of items that
will be located — for example in the screenshot above, only Boolean modules are shown.
You can then step through all of the matching items in the strategy drawing using the using the mouse or arrow
keys and selecting on the module discovered in the search results . The current match will be highlighted in the drawing:
% Boolzan 1 % Boolzan
EEED Outpt [ 71 Input A Output [
Input B Complement [ [ Input B Complement
3 Input € [ Input C
[ Input D [0 Input D
| <
Search Results
X Delete | Select All [Module ~| e [Boolean | Name | <] Number [ ] QUFind Q Q
El- 7] Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - Network: 001 - 002 - CBM24 (2 matches)
.. Boolean
... Boolean
31
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ZOOMING AND NAVIGATING THE DRAWING AREA

The drawing area can be displayed in an enlarged or reduced view. The default view is 100 %, i.e. full size.
With a mouse, zoom in and out by rotating your mouse wheel with the control button pressed on your keyboard.

If you do not have a mouse with a mouse wheel or are using a trackpad, you may use the zoom slider at the
bottom of the drawing area to zoom in and out.

o A
[ Enable
Int=gration tme: %¥); Dervative... L
>
! 100%

For navigating around the drawing area, you can use the scrolls located on the right and bottom of the drawing
area.

The mouse wheel may also be used to move around the drawing. Scrolling up and down with the mousewheel
will move the drawing up and down. Scrolling up and down with the Shift button pressed on your keyboard, you
may move right and left.

You may also use the right mouse button to drag the strategy around in the drawing area.

If you are using a trackpad, the Navigation Pane makes it easy to get around your strategy.

CHANGING THE DISPLAY

The following features of CXpro"® can be customized:

e Drawing Area (Grid Settings). To simplify positioning modules on the drawing area, you can choose a grid
of either lines or dots. You can also customize the size of the grid from 8-pixel to 56-pixel squares (see
page 33).

e Colours. The colour of either the background or the grid can be customized using the Colour menu
option from the Display menu. In addition to the standard colours available, custom colours can also be
defined (see page 33).

e Macros. If the work you do in CXpro"® involves repetitive strategies or parts of the strategies, you can
create macros (see page 142) to automate much of that work. You can arrange those macros in groups
and, using an art tool, such as Microsoft Paint, you can draw icons to represent the macro groups and
individual macros you have created.

32
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MODIFYING THE DRAWING AREA (GRID SETTINGS)

From the Strategy tab on the Ribbon , choose Grid .

This opens the Grid dialog box, where you can
specify whether or not to show the grid, and if it is
shown, whether you prefer lines or dots. You can
also set the spacing of the grid.

MODIFYING DISPLAY COLOUR SETTINGS

E%;Grid l New Connections
F)"Grid Colour
DBackground Colour
Display
Grid x

¥ Show Grid on Strategy
Style —————— Spacing
" Lines

16 hd
i Dots

Cancel |

From the Strategy tab on the Ribbon, choose Grid

Colour or Background Colour .

In both cases, the Colour dialog box is called. This

allows you to select from a range of colours. You
can also make custom colours, by clicking on the

Define Custom Colours button. When you have
selected the colour you require, click OK. The
colour is applied immediately.

E%;Grid "+ Mew Connections
E}'Grid Colour
r’fﬂackground Colour
Display
Color -
Basic colors:

EEEEEN
HEEN 1]
ERENETT

-

ustom calors:

1l HEEENET
11T "THEEER

mink
171

Define Custom Colors

ok | cancel |

MANO133 rev 9
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SAVING FILES

CXpro"'® allows you store files on disc by:
e Saving anew file
e Saving changes to an existing file
e Saving multiple files at once

Files will be saved in the "strat5" folder of the relevant site directory, under a numbered directory. The number
of the directory matches the number of the BACnet Router to which the targeted controller is attached - for
example:

C:\CXproHD\Lan\strat5\001\001 OlFanCoil.stg

would be a strategy in a controller on the first BACnet Router of the site called "LAN".

Saving a new file

If a file is being saved for the first time, press [Ctrl]+[s] on your keyboard or choose Save from the File drop-down.

a ;

File - Home Controller Strategy
() New Recent Documents

[ Open 1001_01.532

B Save

2001 02,532

=) J"Lﬂ Save (Crl+S)

|
5

3 Save the strategy.

@ Foorers

QI Page Size

jl Printer Scaling
?_ﬁ Frint Setup
= Print

@ Close

@Help (@D About K Exif

JE.E Sample Apps BACnet
%E Sample Apps Unitron

This produces the Save As dialog box allowing you to specify how the file is to be saved:

B Save As

T« strat5 » 001 v & Search 001 y-]

Organise Mew folder == - (7]
|, CAMPBLOR A Name
. ARCHIVE
| dbase
| DRAWINGS
| KEYPAD
. MACROS
| strat3
L 001
.. Upload

J Upload
(] o01_01.532

File name: | [ K= "

Save as type: V6 Strategy (*.532) v

“ Hide Folders Cancel
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Saving changes to an existing file

If you have made changes to an existing file and wish to save those changes, but do not wish to rename the file,

nor save it to a different location on the PC, you can save the file in two ways:

Saving more

If you have a number of files open and wish to

Press [Ctrl]+[s] from the keyboard or

choose choose Save from the File drop-down.

@ ;

File - Home

D Mew
[ 9pen
IE Save
m Save As

Controller Strategy
Recent Documents
1001_01.532

2001_02.532

B sa [F] save As

Q Fo Save the strategy with a new name.

QI Page Size
EI Printer Scaling

iF&Print Setup
&= Print
@glose
@ﬂelp ®
| -..JE_E Sample Apps BACnet l[ o

than one file

saves each of the files.

File ~ Home Controller Strategy
D Hew Recent Documents §1¢
— Open
= 1001_01.532 rd
(] save ul
[%) save s 2 CACXproHD.\D01\001_01.532 ate
v

= SEVEPL'\\) 3 C\CproHDY,..\DD1_03VAV.532 -
Q Footers .
QI Page Size
EI Printer Scaling
‘f& Print Setup
=8 print

®L1cen(e Details

@Qose

@ueip (@ About K Exit

B-=00T - Wet Systems

-, 1111 - CT Single Pump DPS

Rl 4447 TP Tl

save them all, choose Save All from the File drop-down. This

If one of the open files is being saved for the first time, CXpro"® will prompt you to specify a drive, directory,

name and file extension for that file by calling the Save As dialog box.

MANO133 rev 9
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PRINTING

Including a footer in a printed strategy

CXpro'® can generate a hard-copy printout of the current strategy.

When you print files created in CXpro"®, they include additional information at the end of the printed page in the
form of a footer. The footer includes the name of the site, as well as the BACnet Router and Field Controller for
which the strategy is designed. You can edit the footer to include your name, your company’s name, the name of
the project to which the file belongs, the number of the drawing, if any, and the date and details of any revisions

made to the drawing.

How to edit the footer that will appear with the strategy when it is printed:

Choose Footers from the File tab of the Ribbon .

This opens the Footers Details dialog box:

Footer Details

Company Mame

Cylon Controls Ltd,

Project Title I Open-Plan Office

File |uu1_u1.53..1

Company Address Clonshaugh Business and Technology Park.
Clonshaugh
Dublin 17
D17 Agg2
— Project

User I E. Peelo

Project Mo. I 14

Drawing Mo, I 5

— Revision
Rev Date

Drrawing

Checked Remarks

A |23ﬂm15 |3

IEF‘ IDId

B
<
D

Save I

Cancel

Enter the required details and click Save.
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Altering the print set-up

To define how the strategy is to be printed, choose Print Setup from the File Tab of the Ribbon to open the

standard MSWindows Print Setup dialog box, where you can specify the required printer, paper, etc.

Type: Brother HL-2170W

Comment:

Where:  WS5D-63b62ecc-3045-4af 1-b52e-8efalb 00681 1.006F

Print Setup x
— Printer
Name: Properties... |
Status: Ready

Crientation

— Paper

Size: I Letter

Ll " Portrait

Source: I.Pu_rtumaticalhr Select

;I * |Landscape

Metwork ... |

QK I Cancel

MANO133 rev 9
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Printing a file

To print a file, choose the Print option from the File tab of the Ribbon . This opens the standard MSWindows
Print dialog box to specify the required printer, pages to be printed and number of copies.

@ ;
X
File - Home Controller Strategy
~ Printer
[ iew Recent Documents
[= Open Name: Brather HL-2170WW series Printer ml
- 1001_01.532
B Save Status Ready
m Save As 2001_02:532 Type: Brother HL-2170W
Save Al Where:  W5D-63b62ecc-9045-4af1-b52e-8:faBb 0068 11.006F
@ Foater-s Comment [ Fors 1n fle
QI Page Size r— Prirt range Copies
#] Frinter Scaling (] Mumber of gopies: |1 =]
T_a Print Setup " Pages from: |1_ to: |12_
& Print 1 52| h3| T colate
€ Selaction ll—l 2|—| 3|—|
() Close 9 Print (Ctr+P)
Print the strategy. delp @ 0K Cancel
- [©
E-Ig Sample Apps BACnet o

Changing the size of a Printout

If a strategy is large, it may not be possible to view enough modules on each page with a standard printout.

CXpro"'® has a Printer Scaling option, which allows you to decrease the printed size of the strategy so that more
of itis visible per page.

Also, if you have set a strategy up for printing on a particular printer, you may find that if you try printing on a
different printer it may not fit properly on the page. The Printer Scaling option allows you to adjust the printout

size to compensate for this.

To resize a printout, select Printer Scaling... from the File menu

This opens the Printer Scale dialog box:

Printer Scale | 100 = %

v Apply to all open documents

Cancel

Enter a scaling factor between 20% and 300%.

e  Factors from 20% to 99% will decrease the size of the modules in the printout.

e  Factors from 101% to 300% will increase the size of the modules in the printout.

Ticking the Apply to all open documents box will set all currently-open Strategies to print with the same scale.
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Fitting a Strategy to a page size when printing.
The Strategy drawing indicates where Modules will appear on the printed page, by drawing gray borders on the
Strategy drawing. In this example, the printer scaling is 100%

S)sej alseg

The Printer scale setting will change the size of the pages relative to the modules. Below shows an example of

the printer scale of 200%

The physical page size represented by the gray borders is set by selecting Page Size from the File tab of the

Ribbon . This opens the Page Size dialog:

Page Size

' Use Custom Page Size

= -
130 = « |?99 _I:l

|
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CLOSING FILES

You can close an open Strategy file in two ways:

Click the Close button at the top right-hand corner of the file window,

= CXproHD - 8.00.00-304 - O X
File ~  Home | Controller  Strategy @
Connect Copy Properties Modules §7]strategy Help
L B e e b B0 GIERG
#¥ Disconnect | [FPaste [ wavigation [[&] Macros [ Reopen strategies
Site | — Configuration Database Datalog  Site  Backup NB-Pro
List |[E Page Namﬁ\@iwm Interface Manager Organiser
Site View Utilities
Site List 8 x | 001_01.532 3 1\ Properties P x |
- Sites ~
BT BACnet IP
252 001 - Network [ Int  Iresser Gonstart
,
=, 001 - 001 - UCU3213VAV u Cal
=}, 001- 002 - CBM24 Oapa AL O AS)
o ; Outpur B [T Output B O
[]---E_E BACnet Serial [T [T &
[-3Ig DLL Stuff DD @ [T
2} EE fred Gonstant A: 0; Constant B: 1; ‘ |Gonstant A: 1; Constant B: 2;
=] |Constant C: 0; Constant D: 1 |Constant C: 3; Constant D: 4
3o Local Network
-Zg Sample Apps BACnet
T Sample Apps Unitron
i
[-Ig Sample Strategies v0.1
‘Coaling Oy A N 'Coaling Oy B s
[]---EE Test BACnet \ﬁ- e Opma=r \'1. e Opsmasr b
@ Surwme | Demand [ Mancay [ Smrup ) 63 Sempei
& swopremp | S 0| |5 Tuescay | Stuadown ©| RIS
< > Page Names  Modules  Properties
Strategy saved successfully. Connected to: BACnet IP (3), Remote - E Y % NUM

or

Select Close from the File tab of the

Ribbon.

==

File ~ Home

D MHew

[=7 Open

m Save

@ Save As
Save All
E Footers
QI Page Size
EI Printer Scaling
?_5 Print Setup
= Print

E’] Close

Controller Strategy
Recent Documents
1001_01.532

2001_02.s32

Close

Close the strategy.

rII:I o

o ~ample Apps Unitron

Is]

Io Sample Strategies v0.1
Test BACnet

E:Iln

“Help (§) About

If changes have been made to the file since the last save, CXpro"® will prompt you to save it before closing.

If more than one file is open, selecting Close from the FileTab of the Ribbon closes the active window.
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SECTION 3 : USING MODULES
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MODULES - OVERVIEW

an04dxD

Modules are the building blocks from which strategies are constructed. They are the basic units of operation in
CXpro*P.

Modules perform tasks within a strategy such as

bringing controller inputs into the strategy

changing the values of points in the strategy according to mathematical rules
comparing the values of points in the strategy

recording the values of points in the strategy

sending point values to the controller’s outputs.

Modules can be grouped and saved as in order to avoid repetitive tasks, i.e. if you use a particular strategy or
part of a strategy frequently, you can save it as a macro and reuse it without having to repeatedly re-create it.

ACCESSING MODULES

By default, Modules are available from the right-hand pane, by clicking the Modules tab at the bottom of the

Pane:

L [T AAR — -

ition Database Datalog Site EBackup MEBE-Pro
Interface Manager Crganiser

Utilities
I % | [Modules R x |

~

®

Favorites

Constants

Controls

Functions
.Math
I Schedules, Timers, and...
- Setpoints, Inputs, and...
.Statistics
vav
IVirtuaIs

v | v |V | Vv | Vv Vv | V| Vv W W

> Page Mam... Properties Mo:{ﬂes

sample Apps BACnet (3), ¥
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The

Schedules/Timers , Setpoints/I/O , Statistics, VAV and Virtuals . To access individual modules, click on one of the

groups:
—

Modules

bl —
onfiguration Database Datalog Site

Pane groups the available modules into

— — —w

Backup NB-Pri

—h

Interface Manager Crganiser

Utilities

I X | Modules

~
Favorites

Constants

Fcl_l Digital Constant

Int Integer Constant

/E, Real Constant
Controls

Functions

Math

Schedules, Timers, and...
Setpoints, Inputs, and
Statistics

Vav

Virtuals

> Page Mam... Properties Mod

ted to: Sample Apps BACnet (3), | I

Constants ,

Controls ,

Functions ,

Math ,

c
@,
>
@
<
9)
a
=
™
%

There is also a “ Favourites ” group, where you can set up a custom list of modules that you use frequesntly or

want to be able to access quickly.

To add a module to the Favourites group, right-click on the module in the Modules Pane and select Pin to

favourites

.Setpoints,lnputs,an._. -

Al analog Input

AO analog output

l(?]An

loa Catnaint

Se 8a

BACnet 2

Add to Strategy
Pin to Favorites l}

Help

i BACnet Binary

To remove a module from the Favourites Group, right-click on ity and select Unpin from Favourites:

Modules » B
®
Favorites p
@ Analpn Setnnint b1
Add to Strategy
A:-B L
& Unpin fﬁm Favorites
I_E.E Inte Remove from list
il
Al anal Help
Constants » |1
Controls N
Functions »
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PLACING A MODULE ON THE DRAWING AREA

In order to use a module in a strategy, you must place it in the strategy’s ‘drawing area’.

To do this, click on the module name in the Modules pane:

a :

File - Home Controller Strategy
’ Connect @ Copy
.ﬂ Disconnect LﬁPaste

roperties I

CXproHD - 1.00.00-320

Modules

Mavigation Macros D Reopen Strategies
E Page MNames |@ Search

C3

Configuration Database Datalog Site

Y |
®
v O G

Backup MB-Pro

[s

Interface Manager Organiser

Site Clipboard View Utilities
site List aHl |« Strategy1 b X | Modules » a8
E‘“@ Sites Ll ~ ®
= ‘E‘E BACnetIP Favorites [
3-8 001 - Network =t
= 001- 001 - UCU32 e L
& 001 - 002 - CBM24 Controls >
BACnet Serial Functions »
Sample Apps BACnet r I
Io
=158 001 - Wet Systems .Math 4 |
3, 1111 - CT Single P Schedules, Timers, a »
@J 1112 - CT Single P Setpoints, Inputs, an.. -
Ef 1113 - CT Single P
B, 1114 - CT Dual Pu Al analog Input
&), 1115 - CT Dual Pur
i
&, 1116 - CT Dual Pur AO  analog Qutput
.3, 1121 - VT Single P1 (A
4 ~) analog Setpoint
&), 1122 - VT Single Py b e
B, 1123 - VT Single P e BACnet Analog
@J 1124 - VT Duzl Put
-, 1125 - VT Dual Pur BACnet Analog Priority...
B, 1126 - VT Dual Pur e .
&), 1131 - Four Boilers Q) EETSHEy
B, 1132 - Four Boilers i M
DACrAt Dinans Nrinete o
§ 1133 - Two Boi.\ers v IR >
< > < > Page Nam... Properties Modules
Connected to: Sample Apps BACnet (3], ]

Then click on the Strategy Drawing Area at the position where the module is to be placed (note the cursor
changes to the “Module Cursor”

CXproHD - 1.00.00-320

Modules

Mavigation Macros El Reopen Strategies
E Page Names |@ Search

View

Strategy1

during this process):

Ca

Configuration Database Datalog Site

- oW
@
T L

Backup MB-Pro

[e

Interface Manager Organiser

==
File - Home Controller Strategy
’ Connect @ Copy
", Disconnect LEPaste
Site
71 Select ANl | | List
Site Clipboard
Site List o g |4
E--@ Sites [l

5-5g BACnetIP
&322 001 - Network
LB 001 - 001 - UCU3Z
= 001 - 002 - CBM24
JE.E BACnet Serial
JE_E Sample Apps BACnet
£ 32 001 - Wet Systems
&, 1111 - CT Single P
B, 1112 - CT Single P
B, 1113 - CT Single P
&, 1114 - CT Dual Pur
Ef 1115 - CT Dual Pu
&, 1116 - CT Dual Pu
&=, 1121 - VT Single Py
B, 1122 - VT Single Pr
B, 1123 - VT Single Pr
E,; 1124 - VT Dual Pur
B, 1125 - VT Dual Pur
B, 1126 - VT Dual Pur
Ef 1131 - Four Boilers
E,¢ 1132 - Four Boilers
&), 1133 - Two Boilers
. A4

[ PRI

< » <

Connected to: Sample Apps BACnet (3),

Utilities
I X | |Modules i« |
~ ES
Favorites [
Constants »
Controls »
Functions »
Math »
Schedules, Timers, a... »
Setpoints, Inputs, an.. -
Al Analog Input
AO Analog Qutput
rA Analog Setpoint
E: BACnet Analog
BACnet Analog Priority...
B
s BACnet Binary
DArnat Din-ne Drinribe & 4
v |l >
> Page MNam... Properties Modules
—
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Some modules (e.g. Analog Input) prompt for basic configuration information when they are first placed. When
this happens, fill in the dialog and click OK

c
= CXproHD - 1.00.00-320 - o
File - Home Controller Strategy @ U%
Connect Copy ] Propert Madul
"' onne @ opy [E| Properties odules m g m m[g:a m r‘] 8-
;”'Disc-:mned LﬂPaste Nauigatiun Macrus D Reopen Strategies = c
ite Configuration Database Datalog Site Backup NB-Pro E
Select All List |[[E] Page Names|[a]search Interface Manager Organiser 73
Site Clipboard View Utilities
Site List ||« Strategy1 b X | Modules 0 x |
Ee Sites " A e
-Ig BACnetlP o R o Favorites s
B-Z2 001 - Network Tt
& 001 - 001 - UCU3Z = U
L..™ 001 - 002 - CBM24 . Point Name L. Controls »
So BACnet Serial : BE Functions S
E-Ig Sample Apps BACnet
= _@_ D01 - Wet Systems Paoint Name | Room Temperature Math [ 3
B, 1111 - CT Single P Schedules, Timers, a.. N
&, 1112 - CT Single P . A Setpoints, Inputs, an... -
-----Efﬂﬁ-CTSmg\eP . A
.=, 1114 - CT Dual Pur . oK cance! .. | Al' analog nput
B, 1115 - CT Dual Pui . T
+
E, 1116 - CT Dual Pur Lo Lo Lo AO Analog Output
=, 1121 - VT Single P S S P A
: ~) analog Setpoint
., 1122 -V Single P S S P L. g Setp
=, 1123- VT Single P R B o 2% Bacnet Analog
B, 1124 - VT Dual Pur
&, 1125 - VT Dual Pur BACnet Analog Priority...
E, 1126 - VT Dual Pur S S e B _
.....EJ’ 1131 - Four Boilers [ Lo FE L. g BACnet Binary
.=, 1132 - Four Boilers A T A ) » -
= EE S S DhZost Dingo, Boisgbo l
’_( 1133 - Two Boilers i v L€ >
< > < > Page Nam... Properties Madules
Setup block updated. Connected to: Sample Apps BACnet (3), f}f

The module is displayed on the Strategy Drawing, and as it has just been placesd it is automatically selected. This
is indicated by a green outline:

= CXproHD - 1.00.00-320 = =
File - Home Controller Strategy @

"Cannect @Copy ] Properties Modules Fﬂ F. Du m[h D& F
=

;”'Disc-:mned LEPaste Nauigatiun Macrus DReupenStratEgiEs

ite Configuration Database Datalog Site Backup NB-Pro
Select All List Page Names @Sear(h Interface Manager Organiser
Site Clipboard View Utilities
Site List L x (R Strategy1 b X | [Modules L x |
- Sites ” A ®
El-fg BACnet P o o Favorites [
- &2 007 - Network Al Femsbes R o e
& 001 - 001 - UCU3Z """’“'r“"“‘“:: = BRI o T b
= 001 - 002 - CBM24 L F FE Controls »
o . | overc= 0]
-5 BACnet Serial P P Functions R
B %.E Sample Apps BACnet e
EE D01 - Wet Systems 2 4
E, 1111 - CT Single P Schedules, Timers, a._
-, 1112 - CT Single P o o R Setpoints, Inputs, an... -
.=, 1113 - CT Single P L L o
=, 1114 - CT Dual Pui o o C ... Al analog input
3, 1115 - CT Dual Pur
+
@,1115-CTDuaIPU| Lo Lo P AO Analog Output
[, 1121 VT Single P S S P A
$ ~) analog Setpoint
=), 1122 VT Single P o L I |« g Setp
&), 1123 - VT Single P1 2: BACnet Analog
B, 1124 - VT Dual Pur
@, 1123 - VT Dual Pur S T, S BACnet Analog Priority...
E, 1126 - VT Dual Pur S S e B _
.....E,nn.;ourgguers [ Lo FE L. g BACnet Binary
E,WB!-Fouerlers i .
_____@’ 1133 - Two Boilers . . BACnet Binary Priority A...
[ APPEPR
< > < > Page Nam... Properties Modules
Setup block updated. Connected to: Sample Apps BACnet (3), f}f
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It is possible to examine and edit the properties of the selected module by clicking on the Properties tab at the

bottom of the Right-Hand pane:

==
File ~ Home Cantroller
’ Connect @ Copy

Lﬁ Paste
i Select All
Site Clipboard

b”D\sc:mnect

Site List

Strategy

Site
List E Page Names @ Search

1R ¢

E--@ Sites
- Fa BACnet IP
£ 52 001 - Metwark

- 2o BACnet Serial
5

E-1Io Sample Apps BACnet

=, 1111-
=, mz-
....@!1113_
....@!1114_
....@,1115,
....@,1115,
=, 1121 -

&, 1131 -
....@!1132_

<

Setup block updated.

- 001 - 001 - UCU32
.= 001 - 002 - CBM24

252, 001 - Wet Systems
CT Single P
CT Single P
CT Single P
CT Dual Pui
CT Dual Pui
CT Dual Pul
VT Single P
-, 1122 - VT Single P
-, 1123 - VT Single Py
-, 1124 - VT Dual Pur
-, 1125 - VT Dual Pur
&, 1126 - VT Dual Pur
Four Boilers
Four Boilers
=, 1133 - Two Boilers
v

B aams r onon

[| Properties

MNavigation Macros

CXproHD - 1.00.00-320

Maodules E Strategy Help

D Reopen Strategies

View

Strategy1

Cs

[s

Configuration Database Datalog Site

Interface Manager Organiser
Utilities

I ¥ | Properties

~

‘Analog Input B
Al oom Temperature

Pont €3]
Dverz [0

> <

Y |

g

@

Backup NB-Pro

B ? =

L = |

= |
Type Anzlog Input
Service Order 1
Name Room Tem...
Synchronis... Discennect...

=]
Pointty.. Input Anal..
Low thresh... 0
High thres... 0
Lower sens... 0
Upper sens... 0
Input errer 0.0000
Exponential... 60
Sensortype  PT1000
Unit °C
Averaging 0

® -l

v
> Page Mam... Propertjgs

Connected to: Sample Apps BACnet (3], |

E Modules

You can edit the properties of the selected module by clicking in the propety’s value in the righ-hand pane. Help

text relevant to the property being edited is displayed in the lower portion of the Right-Hand pane

=
Fil F - Home Cantraller
H C
_’Connect @ Copy
ﬂDisc:mnect Lﬁ Paste

Strategy

Na\ﬂgat\on Macros

Site.

Properties

CXproHD - 1.00.00-320

[DModules EStratengelp
[[] Reopen Strategies

Ca

Configuration Database Datalog Site

- o EN

®:.

[s Cu G Cd0s

Backup MB-Pro

{_iSelect All List |[= Page Names |[&] search Interface Manager Organiser
Site Clipboard View Utilities
Site List L x (I Strategy1 - % | Properties g x |
B @) Sites - o 2 [Analog Input 111 =]
E-2a BACnet 1P - g =
- Analog Input 1 |
E E gT .-)Dr\‘:e_t:;'g;k_ — Al poom Té“p:xum Type Analog Input
= 001-002- CEM24 Pont @ Service Order 1
= . Overd= [§ Name Room Tem...
Io BACnet Serial . . -
E“JE-.E Sample Apps BACnet Synchronis... Disconnect...
- B2 001 - Wet Systems = :
@’ 1111 - CT Single P Pointty... Input Anal...
=, 1112 - CT Single P Low thresh... | 0
-, 1113 - CT Single P High thres... 0
e --E’ 1114 - CT Dual Pu Lower sens... ':'
-3, 1115 - CT Dual Pui Upper sens... 0
@, 1116 - CT Dual Pui Input error  0.0000
....@, 1121 - VT Single P1 Exponential... 60
""@y 1122 - VT Single P Sensortype  PT1000
&, 1123 - VT Single Pr Unit e
-, 1124 - VT Dual Pur Averaging 0
&, 1125 - VT Dual Pur =) =]

....E’1131_

<
Setup block updated.

-, 1126 - VT Dual Pur

Four Boilers
&), 1132 - Four Boilers

-, 1133 - Two Boilers .

M aama e e

> <

Connected to: Sample Apps BACnet (3], |

Lower sensor range
The settings specify the range of

the input, after analog-to-digital

> Page Nam... Properties
—

Modules

Note: If you have multiple strategies open at once, ensure that you select the strategy into which you

would like to place the module before you select the module from the modules bar.

The module can now be selected, and edited, moved, copied, cut, or joined to other modules.
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Selecting modules on the drawing area

Before you can move, copy, cut or delete a module, you must first select it. This can be done by:

C
@,
Clicking on the module symbol, &
<
(o]
=3
Analog Input 1 Analog Inipast 1 =
Al Room Temperature ’ Al Room Temperature <

I}, poim@m Point €3 T

Ohvemide [ m Ovemide [

Or by clicking and dragging from the top left to the bottom right of the module symbol(s) as shown. When you
release the mouse button, the module will be selected

D!T Analog Inpast ] Analog Inpast o) Analog Inpast 1
Al Room Temperature ) Al Room Temperature ) Al Room Temperature
Polm@m Point £ Fﬂ Point £ m
Ovemid= [[ Ovemid= [[ Ovemid= [[
R

To select more than one module on the drawing area:
You can select multiple modules at once by the following methods:
Press and hold down the [Ctrl] button while clicking the modules required.

if you want to select every item in the drawing simultaneously, click on Select All in the Strategy tab.

troller Strategy

£ Copy |:

! = W
Stéd Al Mo
oller Clipboard

Click and drag a box around all the modules you want to select. When you release the mouse button, all
the modules within the box will have been selected.

~

) > Taneats Fomzig PO ¢

S oo S

} Tuneable Forad PID 2

IS Seore omn Oy

) > Tuneatk Forzie P 7|

I Seone e Oy

Tralog Tk
Al room remperarure

Selected modules (and points, whcih are represented by lines) are surrounded by coloured borders. Most
modules will have a red border, but one will be green. This is the module (or point/line) whose properties are
currently displayed in the Properties Pane —i.e. the module that is “in focus”.
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Move, Delete, Cut or Copy a module or modules on the Strategy drawing area

You can change which of the selected modules is “in focus” by using the navigation controls at the top of the
properties pane, eith the arrows:

4 Strategy1 [ > | Properties LR |
B £ ﬁ ? |Analog Setpoint[* +
m Analog Satpoint 1 R E
/ Room Setpoint Value 0.000000
[ Poin € pres =
b Tunesble Forward PID. - 2 =l PointD... Analog 1Reo..
. MNu. 1
(€3 Sztpoint Output €3
Analog Input 1 RE] T_)'Pe f\r:flog
Al Room Temperature " & Gain Value 0.00
[ Point CJ [ [F Enab= MName Room Setpoint
[ overmc=[F (€ Integration Unit  *C
) & Derative
Int=gration time: $00; Derivative._. |

Or the drop-down, which lists the currently selected modules and points:

4 Strategy1

4

4

Properties

A € > 7? |Tunesble Forward «

» B

= (=] _Analog Input [1]
0\ R:f;::mlir:t ' Analog Setpoint [1]
po _ . Tuneable Forward PIC
[ Point Ofry N Lo Set
} Tureable Forward PID 2
. (=]
© Setpoint Oup @ Setpoint  Analog 1R..
Analog Input 1 £ By
Al Room Temperature © can Process... Analog (1) ..
| Point €3 fpm [0 Enabk Gain Analog
| ovem[[ ) Intzgration Enable Digital
€ Dervative ) Integrat... Analog
Integration time: $00; Derivative... . o

In order to Move, Delete, Cut or Copy a module or modules, you must first select the module(s) as described

above. Then:

Moving modules

To move the selected module(s) on the drawing area, drag any one of the selected modules. The modules and
their connected points (lines) will move together. Alternatively, you can also use the arrow keys on the PC’s
keyboard to move all of the selected modules at the same time.

Deleting modules

To delete the selected module(s) from the drawing area press the [Delete] button on the PC’s keyboard.

Copying modules on the drawing area

To copy the selected module(s) to the PC’s clipboard, in order that they can be pasted to another part of the
drawing area or to a different Strategy, either

e press [Ctrl]+[c] on the PC’s keyboard, or

e clickon Copy inthe Home tab:

Home Controller
innect @ Copy D\f‘
sconnect IE Paste

I select All
site Clipboard

A copy of the module(s) will be saved on the Clipboard until placed (pasted) elsewhere.
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Then, paste the module(s) to a specific point within the same strategy, or to another strategy, by first either

e  pressing [Ctrl]+[v] on the PC’s keyboard, or

e clicking on Paste inthe Home tab:

Haome Controller

c
@,
>
@
<
9)
a
=
™
%

nnect ﬁ Copy

sconnect EPast:R
]

L.|sele
site Clipboard

then click on the drawing area in the target Strategy with the mouse. The top left-hand corner of the module(s)
will be positioned on the point where the mouse was clicked.

Note: Pasted hardware point modules may adapt some parameters to the destination point but retain
others. For example, an analog input configured as PT1000 when pasted to a UniPut will change

to a voltage input, but retain the max and min limits (in the Advanced button) which for PT1000
could be min 0 and max 0, leading to incorrect operation of the UniPut.

Tool Tip Data on Modules

To view details of a specific Module, hover the mouse pointer over the Block in the Strategy drawing.

‘Analog Output =

AO Heating Valve
; W§O Type: Cutput
.,.gT Analog/Digital Type: Analog
e 1B bit range: 0-255
| Type of Input Sensor: Volts
- |Lower actuator: 0
- |Higher actuator: 10000

- - - - - |Strategy lower: 0
— . . . . . |Strategy upper: 100
= . . |Cutputerrer: 0.00
. |5ensor Type: 0-10Kohms
. |Sequence on period: 0
| Unit °C

L]
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JOINING MODULES IN A STRATEGY

Modules in a strategy must be joined together to allow information to flow from input to output. The flow is
from left to right, so that controller input connection points are on the left of the drawing area, controller
outputs are on the right, and the modules are positioned between the inputs and outputs in the centre of the
drawing area.

Notes on joining modules
e A connection is possible only if both the input and the output are of the same type (analog or digital).

e An output of a module can be linked as often as required with inputs of other modules.

e Aninput of a module can be linked with only one output of a module.

Module connection points

How

Connection points are marked on module symbols as blue circles or squares on the left and right edges of the
module. When the mouse pointer is placed over a connection point, it changes to a cross-hair.

e  Circular connection points are analog.

e Square connection points are digital

If you want to connect two points, make sure they are both either digital or analog. You cannot connect analog
to digital or vice versa.

to join modules

Place the mouse pointer over the required output () Analog Setpoint 1

of the first module so that it changes toa cross-hair. o o) Reom Setpoint |
Poiz: ©3

B Tuneable Fo
€ Setpaint

Click and drag the mouse from the output to the () Analog Setpoint 1

required input of the other module. You will see i "1 Room Setpoint _

that the cross-hair changes back to a mouse pointer [ Point G|

once you have left the blue connection point and ———————— l } Tunzzblz Fo
return to cross-hair format when you reach the next -~~~ W [o

Fllntanratinm im

blue connection point.

Release the mouse when you have reached the m Analkeg S=tpoint 1
required input. The two modules are now joined. Room Setpoint

The connection between the two modules is Point ©
marked by a coloured line. The default colour is
black, but this can be customised by clicking on the
connection line with the right mouse button.
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How connections

are represented

By default, the connection between 2 modules is represented by a black line with the numbers of the points at
each end of the connection also displayed (as in the above example).

You can customise the way in which all connections are represented by right-clicking on the Drawing Area to

open the Display Options menu:

Display Options v

Point |
@

This give access to the following options:

Hide All Lines
|| Display Options v || Display Lines vl Show All Lines |

© | Oy Lo+ [ il |
Show All Lines

’ | Display Options > DisplayLines >\ ShowpliLines |
8] | Displey Labels » ‘ Hide A Lines |
Hide Labels

o DisphyOpions | DisplayLines v

01T

Display Labels  » Hae

‘Shbw Number

IE Show Name

7 A=
T M T
Show Number

il

4 Display Options » | DisplayLines v ]

| | Display Labels ’ Hide

Show Value Only (simulation)

Shom Number
g Show/Name

e I

| 3

él

rl]....

[ﬁ

2]

: 1 |69 Setpoint
W@

F Tunzzblz Forward PID L

el

1) S

@ &ain
|9 Enabie

: T € Setpoint

eyl BN

3l
L

[ﬁ

2]

e

@ &ain
|9 Enabie

F Tunzzblz Forward PID L

€ Setpoint
o

8l
el

I Gain

~—S Setpoint

Output &)

EEZETS] o I

1815)
EN

—me

& Gain
5 Enable
(€ Integration

Fae—c—
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Show Name

e
_| Display Optiens »|  Displaylines v
|

Display Labels » Hide

Show Number

j - . . Shotd Value Only (simulation) - put @)
o | "
=) Tew . ..
EE .....
Show Value Only (Simulation) :
IR e B
[ | Diploy Options B [t o] - Lo o
- Display Labels  » Hide ’ o Toreabe Forad PD 1]
Show Number b
Show Name 1 Output €
! =10 Show Valyg Only Gimulation) . ],,,
:J I T T O = ; = @—I e
EE .....

You can customise the line and label visibility of a single point (line) in the properties panel:

Properties L |

<>?| -

= Point Details Analog 1 Room 5.

Mumber 1
Type Analog
Value 0.00
MName Room Setpoint
Unit “C
=
Show Line True
Labels Show value onlyE

You can also change the default visibility using the New Connections option on the Strategy tab of the Ribbon :

Strategy
ECopy E 3R r|§|BACr|et Paints E @_ Create # # % #Ix Logging %Gnd E‘l New Cgnnections
?jPasle q= BACnet Units Manager ’ [ “E‘Conflguratlon ?}'Gnd Calour
| View Add [f{s] Reorder _ Strategy View Start/Pause Stop  Reset
__iSelect All | Modules Text Terminals Modules nﬁ' Strategy Details  Help Macros FIl"l Save New - l"/ Background Colour
Clipboard Strategy Macras Simulation Display
= =< Strateavt I % | IModules

This opens the New Connections dialog, where you can set the appearance of new module connections:
New Connections
v Display lines on newly created connections.

Configure how point information is display on newly
created connections.

IShow value anly [simulationLI

Show name

Cancel

Show value only {simulation]
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Connectors

Lines are a convenient and intuitive way to connect modules that are close together in the Strategy drawing.

However, clicking and dragging to connect modules that are far apart in the drawing can be impractical. To BZ3
overcome this, CXpro"® provides an alterative way to connect modules using named Connectors . =
8
0 Input C
wwTemp 'l §
W“) < E HWSHowTenp ] [[1wShonTemo — e T
Override [ ) o wMimp
) LTmp
HWSHILImIt 7] Do il HiLS
N — e =
WSHiLimit & 0B
| Point [ rar<. ) HwsHiLimit 5 DSoD
Override [1] Analog Setpoint s 7 LS
m, HWSTempDB 3 LSip
| Point £ ol B

A Connector creates an invisible channel of information between a single Source and multiple Destinations.

Add a Source Connector

To set up a Source Connector, right-click on any output on any module and select Add Source Connector .

Maximum 4
Nax

I Inp A Masimum G —
J Input B Show lines
Jmpuc |

3 Input D |
3 Input E Convert LirLE to Connectors
3 Input F
Jinpmc | Simulation Properties

3 Input H )

Add Source Connector

In the dialog that opens, enter a name for the point that will be exposed by the Source Connector you are
creating.

Point Name

Paoint Name | MaxHWater

0K I Cancel |

The Source Connector is now created.

Maxamum 4
lax
} Input A Mazimum 69 zé. 3 MaxHiliater
¥ Input B
¥ Input C

Note: Points exposed by Source Connectors must be named.
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Adding a Destination Connector

To connect a module to a point exposed by a Source Connector you must create a Destination Connector as follows:

Right-click on any input of any module and select Add Destination Connector .

A-B Comparator 1
OptA |  Owp[@mmy
It B | Comolement Elq i

Show lines

- Add Destination Connector

Corla®rt Lines to Connectors

Simulation Properties

A list of Source Connectors will be displayed.

Select Source Connector

Mame I
[MacWater |

Adder/Scaler Block 13 Output
‘WeatherCom Block 3001 Inpu

oK [:! Cancel |

Choose the appropriate Source Connector and click OK to complete the connection. The new destination

connector is added to the input of the module.

MaxHWater £

Deleting Connectors
The rules for deleting connectors are as follows:

Source: If a Source Connector is deleted, all Destination Connectors connected to the Source Connector will also be
deleted.

Destination: If a Destination Connector is deleted, it is the same as disconnecting an input from any output.
If the Destination Connector is the last one connected to the source, a dialog will be displayed asking the user to if

they want to delete the source. If they decide to do so, then the Source Connector will also be deleted. If the user

does not delete the Source Connector , that point will be available for new Destination Connectors .
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Quick Searching for Connectors
e Jumping from a Destination Connector

Right-click on the Destination Connector and choose either Jump to Source or Jump To Other Destination .

[ Inpun A
MasHVizter () Srpemm——s () Inpi 8 | comp

Jump to Source
Jt Spto Other Destination

If you choose Jump to Source you will immediately be taken to that Connector .

c
@,
>
@
<
9)
a
=
™
%

If you choose Jump To Other Destination and there is only one available, you will immediately be taken to that Connector .

If you choose Jump To Other Destination and there is more than one available Destination, then the Search Results

window (below the Strategy Drawing window) will display them as a list so that you can select which one to view.

& npuza

[ & % Qe |G

Wasimum T

E Mezmm Sy <O ez
1mp DPS = 1 Sire G v
imp Trip < >
1mp Speed Search Results | x |
ap DPS
np Trip X Delete ™ Select All [Module ~| Type
ap Speed
o] N Numb:
1mp DPS [ 5| = | [E
i [ ]amaa
P Spee - [ Search results for "MaxHWater Destination Connectors” in strategy PL Office: {
p DPS.
Source Connector : MasHWater
p Trip

Destination Connector 1: MaxHWater
Destination Connector 2 : MaxHWater
Destination Connector 3 : MaxHWater

p Speed
OnOff
Modulating

e Jumping from a Source Connector
Right-click on the source connector and choose Jump to Destination .

w S
Jump to Destination I
Lo | P I

Ay

If there is only one Destination Connector , then that Connector will immediately be displayed. If there is more than
one, then the Search Results window (below the Strategy Drawing window) will display them as a list so that you

can select which one to view.

oS : Ma;a'naﬂ@“ - E;gumwmy I

Trip =

Speed 0 v
ps < >

P Search Results x|
pesd r Type

DPS X Delete [ Select All [Module | Tyee | ~|
Trip Name Number [ ] QUFind @ @

Speed
Ps

fip

oeed
S
lulating

[ [T Search results for "MaxHWater Destination Connectors” in strategy PL Office: 001 - Netwao
Source Connector : MaxHWater
Destination Connector 1: MaxHWater
.. Destination Connector 2 : MaxHWater
- Destination Connector 3 : MaxHWater

Convert Lines to Connectors

It is possible to quickly convert an existing Line to a set of Connectors (one Source and one Destination).

Right-click on a Line and choose Convert Line to Connector .

ET Leg trigger
Datalog number 1; Update

Convert Line to Connector

Simulation properties

If the point is not named, you will be given the option to name it.
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Viewing Point properties

The Properties panel in the CXpro"® Right-hand pane can be used to examine points and routing. To do this,

select a line (representing a connection between two modules, usually meaning a point). The properties of the

point are displayed in the Properties panel:

Properties R |
? B
=l Point Details Analog (9) Heati..,
MNurmber 9
Type Analog
Value 0.00
MName Heating Valve
Unit =C
=
Show Line True
Labels Show value only ..
Number

The point number that represents a
path of data in a strategy. There are a

Properties Page Mames Modules

Some attributes of a point (such as Name or Unit ) are editable, and can be changed directly in the Properties panel.

Viewing BACnet properties

If the BACnet Properties option is enabled in the Home tab of the Ribbon,

Home Controller Strategy

nnect @Capy EI Proper‘ties Page Names @Sear(h
connect E Paste @ BAGnet Properties Modules EE Strategy Help
o Sity
{_iSelect All L:sf Mavigation Macros [] Reopen Strat

ite Clipboard View

then in the right-shand pane, alongside the Properties panel, there is a BACnet Properties panel:

- € Input £
3 ot F Y — —
> Properties BACnel':groperties

:

When a BACnet-exposed point (the line representing the point has hexagon indicators near each end) is selected

Al

Analog Input 51 [ A& HymEemm
Temperature o .g-
Point £ #T.”@ Tnput Aot
=g
o 0 [Om 2.00; OF: 4.00

B

and the controller is connected in CXpro*®

File ~ Home C

/G/C-Jrﬂ?ect @c
5‘ Disconnect Lﬁ[
] i

Site Cli
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then CXpro"® will interrogate the BACnet network in real-time, and live BACnet property values for the selected
point will be displayed in the BACnet Properties panel.

BACnet Properties O x |
[” Device properties
=
object-name (77}  Temperature
object-type (79) 1]
object-identifier (... Analog Input (0), ...
present-value (83)  1000.000000
status-flags (1...

-

c
@,
>
@
<
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a
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™
%

event-state (36) normal

reliability (103) Mo Fault Detected
out-of-service (81)  False

units (117) 62

min-pres-value (.. 73.000000
max-pres-value (.. 120.000000
cov-increment (22)  0.100000

time-delay (113) 0 —
notification-class.. 0

high-limit (43) 0.000000

low-limit (39) 0.000000

deadband (25) 0.000000
limit-enable (...

event-enable ..,

acked-transiti... to-offnormal, to-..

notify-type (72) Alarm ;I

Properties BACnet Properties

Viewing Module BACnet Properties

The BACnet Properties panel can also be used to view and edit BACnet information related to certain modules as
well as points.

The following modules are supported:

e Binary input/output

e Analog input/output

e  Setpoints

e BACnet Schedules

e Unitron Schedules

e Broadcast transmit and receive
e Modbus Analog and Digital

e  Accumulator

e BACnet Trendlogs
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Viewing Device BACnet Properties

At the top of the BACnet Properties panel there is a Device Properties checkbox:

BACnet Properties

[~ Device properties
=

lhiccd s FTT

P S,

Checking this box changes the contents of the panel from the properties of the selected point or module, to the
BACnet properties of the device that contains that point or module:

BACnet Properties

[ Device properties

(=
ohject-name (77)
object-type (79)
object-identifier (...
present-value (85)
status-flags (1...
event-state (36)
reliability (103)
out-of-service (81)
units (117)
min-pres-value (..
max-pres-value (...
cov-increment (22)
time-delay (113}
notification-class...
high-limit (43)
low-lirit (39)
deadband (23]
limit-enable {...
event-enable ...

acked-transiti...
notify-type (72)

o a2

Temperature

0

Analeg Input (0, ...
1000.000000

normal

Mo Fault Detected
False

62

78.000000
120.000000
0.100000

0 —
0

0.000000

0.000000

0.000000

to-offnormal, to-...

Alarm ﬂ

Properties BACnet Properties

-Eﬁgn et Properties
I_@Device properties

ohbject-name (77)
object-type (79)
object-identifier (...
system-status (112)
vendor-name (121)
vendor-identifier ...
muodel-name (70)
firmware-version ...
application-softw...
location (38)
description (28]
protocol-version ...
protocol-revision...
protocol-servi..,
protocol-obje..
ohject-list (76)
max-apdu-length...
segmentation-su...
local-time (537)
local-date (36)
utc-offset (119

A x |
CBx CCBXBIS002F |
a
Device (8), Instan...
Operational

Cylon Controls, L.
1m
CBx
CBx 7.9.0f 18-08-2...

Plant Controller

Location not set-.. —
Plant Controller

1

14
acknowledgeAlar...
analog-input, an...
DES13002 A12A13..
430

Segmented Both
12:29:59
26/04/2019

’ =

Properties BACnet Properties
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HOW TO ADD TEXT TO A STRATEGY

You can add text comments to a Strategy drawing by selecting Add Text from the Strategy tab onthe Ribbon :

Strategy
o [BO] B
EjPaﬂe
View | Ad I/c
..iselectAll | Modules Text Termir
Clipboard

Click the drawing area at the point where you want the text to be displayed.

|4 Strategy1
L
N S —
................. ( 2 Room Secpaint
................ —
T o
. |AI Room Temperature |~

The Add Text dialog box will be displayed:

Add Text ———

> mmzy

ialog Setpoint
‘om Setpoint
Paint

Font | caneel |

[ TAl Room rempersture |

c
@,
>
@
<
9)
a
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™
%

To select the type of font in which the text should be displayed, click Font . The standard Windows Font dialog
box will be displayed in which you can choose a font, style, point size, etc. Once you have chosen the required

font, click the OK button.

Font
Fant: Font style
[ial] [Regular

Arial ~
\Arial Unicode MS
BankGOTHIC LT B

BankEOTHIC MD
[Baskerville Old Face « |Bold italic v

- Effect: Sample
I Stoksout
I Undedine AaBhyzz

Colour.

I Eiack - Script:
Westem =

Note: It is recommended that you always use "True-type" fonts. When the printing is scaled, non true-
type fonts do not scale properly.
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In the Add Text dialog box, type the text that you would like to include in the strategy

hop

-

s Add Text S

B1 DS floor temp sensors|
walog Setpoint
om Setpoint
Paim
Fant | oK Cancel |
I ' |AI Room Temperature |
And click OK .

The text will then be displayed on the drawing area on the point at which you clicked the mouse.

3 |4 Strategy1
L]

BiDSfoor temp sensors,

(}l Anzlog Setpoint
4 10 Room Setpoint
| Point

Analog Input 1
AI Room Temperature

How to change text that has been added to the stategy drawing

To change text, select the text and edit its content or font directly in the Properties pane.

1.532 I ¥ | Properties O x |
o A€ > ? -
iOutput =1ifInput = 18 deaC ; I J
{Output = 0 if Input = 23 degC | - R =
S Text Output = 1if Input < 18 degC...
Font Arial(g)
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VIRTUAL MODULES

Virtual modules are so-called because they do not result in point values being downloaded to the Cylon
controllers, i.e. they do not represent real points. The basic function of a virtual module is to allow for greater
flexibility in connecting modules, e.g. backward connection of modules. Virtual modules are also used when
creating macros, as they allow one external point of a macro to be connected, via a virtual, to many internal
macro points. There are two virtual modules on a floating toolbar — one analog and one digital.

c
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@
<
9)
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Analog Virtual Module: |@'| |@'|
Digital Virtual Module: El |E—|

Placing Virtual modules on the drawing area

The procedure for placing virtual modules on the drawing area is similar to that for any other module.

Select the required module from the Virtuals group — Meduls L
in the Moules panel: — ,
Constants »
Controls »
| Functions =
Math »
Schedules, Timers, and Logic -
.Setpuints, Inputs, and Outputs » |
| Statistics =
VAV 3
Virtuals -
V Analngwtuall{\\)
V'  Dpigital virtual
Properties Page Mames Modules
o . S L P ) _
And click in the drawing area (note the cursor [ | B
changes to the “Module Cursor” during this - ¥
process) fture &1
Pont ] =X
e p— =
e . .
Point €3
ven1deﬁ1n|
. L 1 bl |
The top left hand corner of the module’s symbol will =~~~ ] | E
be placed on the point where the mouse was clicked. ; -
ture @
Pant @] ] ] =X
femride [ = 9] =k
£ 1
=X
[ine=
e . .
Point €3
verndeﬁml
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Rules for connecting to virtual modules

1. If the point being connected to the virtual module has a point number, then this becomes the number
of all the inputs and outputs of the virtual module. Any modules that are then connected will have the
same point number.

2. If the point being connected to the virtual module does not have a point number, CXpro"? chooses a
new number and this becomes the number of all the inputs and outputs of the virtual module.

e Rules 1 and 2 describe how the inputs and outputs of the virtual module are numbered once a
connection has been made. This is why CXpro"® will not allow you, once the first connection has been
made, to connect another module that has a number. You can, however, connect a module if its point
number box is blank.

Numbering virtual modules

Since virtual modules are not downloaded, they do not use any memory in the controller and do not need to be
numbered in the Block Manager like other modules.

Virtual modules have their own numbering system. The first virtual module used in a strategy is numbered V1,
the second V2, etc.

Virtual modules in macros

Virtual modules are useful when creating macros as they allow one input to be used several times.

For example, to create a macro from the strategy shown, it would be necessary to include two inputs in the

%} Boolzan H

macro.
Digital Input B
DI Trigger :
Foint L] oy
Overmide [[ =

.3]3 Input A Output [
7 tnput B Complement [
[ Input €
[ input D

gh} Boolean g

DI Trigger

........

_ w@ Input A Output [
[ Input B Gomplement 3]
[ npur €
[ tnput D

.3]3 Input A Output [
[ input B Complement [T
3 Input C
3 Input D

&} Boolean 3

Output [
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WHAT ARE POINTS?

A Point is an area in a Controller where data is collected and stored. The data stored by the point is referred to as
the Point’s “value”. Controllers in the Cylon system include input, output, set and virtual Points.

Note: Cylon’s Controllers are sometimes referred to as “universal controllers”, where “universa

that they can contain both analog and digital Points.

WHAT ARE BLOCKS?

I”

means

An important aspect of CXpro"® is the concept of blocks.

Blocks can be seen as units of measurement for the number of modules and points used in a Strategy — one block
corresponds to one module, one hardware input Point, one hardware output Point or one virtual point.

The Managers dialog, accessible from the View menu, allows you to see at a glance which of the blocks in the

controller are occupied and which are not.

When Points or Strategies are downloaded to a Controller, the Controller must also be informed of how many blocks
are needed to store the required information.

e |f you are using Automatic Download (see page 69), CXpro"® automatically recognizes how many blocks are

required and it sends this information to the Controller.

e If you are not using Automatic Download you must, when downloading Points and Strategies, send specific
“Setup” information to the Controller, instructing it as to how many blocks it must service in the Strategy.
This procedure is called Sending Setup (see page 169).

BLOCK NUMBERS

An important aspect of CXpro"® is the concept of blocks.

Blocks can be seen as units of measurement for the number of both modules and points used in a strategy.

e In the CBM, CBV and CBT controllers, the Hardware Point numbers are from 1 to 1024 and Strategy blocks go
from 1 to 1024. Note however that only Hardware Points 1-24 are used on the CBM24, only Hardware points 1-

16 are used on the CBM16 etc.

Block Allocation

Strategy blocks.

for strategy modules.

Point Numbering

In these controllers,
outputs), numbered 1 - 24.
numbered 1 - 1024.

numbered 1 - 1024.

in CBM, CBV and CBT controllers
In these controllers, there are a total of 1024

in CBM, CBV and CBT controllers
There are a total of 24 hardware points (inputs or
There are a total of 1024 digital virtual points,

There are a total of 1024 digital virtual points,

controller memory
(CBM, CBV and CBT controllers)

Hardware

Hardware points in these controllers do not use Analog
strategy blocks, so that all 1024 blocks are available or

Digital
Points
(inputs or
outputs)

Virtual virtual Strategy Blocks
Analog Digital
Points Points

1024
1023
1022
1021

26
25
24
23
22

000 00000 6006
000 00000 0096
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POINT NUMBERS

In CXprof®, the connections between modules are referred to as ‘Points’. These Strategy Points can represent
physical inputs and outputs on a Controller, or Analog/Binary values (referred to in CXpro*® as ‘Virtual Points’).
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Each Analog Input, Analog Output, Binary Input, Binary Output, Analog Value and Binary Value is assigned a number, and
how these points are numbered depends on the controller type.

In CBM, CBV and CBT controllers, controller terminals (i.e. inputs and outputs) - “hardware points” in CXpro"® - are
assigned numbers between 1 and 24. Each terminal can be either an input or an output, so that there cannot be
two hardware points with the same number. For example if there is an Analog Input 3 there cannot be an Analog
Output 3 or Binary Input 3 at the same time.

Note: In theory, hardware Point numbers could be up to 1024, but is limited by the Controller hardware
so that the current maximum is 24.

Analog Values (“Analog virtual points”) can be numbered 1-1024, and Binary Values (“Digital virtual points”) can be
numbered 1 — 1024, so that there could be for example both AnalogValue 3 and Binary Value 3.

Note: The combined number of Analog Values and Binary Values that can be exposed on a BACnet
network by a single CBM or CBT is 225. As a result, it is recommended to keep the total number
of defined setpoints in a Strategy below this value.

However it is possible to have up to 100 additional setpoints that are not exposed on BACnet.
Such setpoints in effect act as constants, because they cannot be changed by the Strategy nor via
BACnet, but can be set using CXpro*'®.

In Strategy drawings generated by CXpro"® for CBM, CBV and CBT controllers, it is possible to identify a Strategy
Point’s nature as follows:

e If the number has brackets around it is a “hardware point” — Analog Input, Analog Output, Binary Input or
Binary Output.

e If the number is not bracketed, but is connected to a circular connection point, it is an Analog Value
(“analog virtual point”).

e If the number is not bracketed, but is connected to a square connection point, it is a Binary Value (“digital
virtual point”).

e If the line representing the point has a hexagon near each end, then that point is exposed on the BACnet
network.
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DEFINING HARDWARE POINTS

Hardware points are the inputs and outputs of Field Controllers.
To define a hardware point it is necessary to define the following features:

e Point number

e Point name

e Point type (input, output, digital, analog)
e Unit of measurement

e  Damping (for analog inputs only)
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Once the required hardware points have been defined in CXpro"®, they are then downloaded to the Field

Controller for which they are intended.

How to define hardware points
The procedure for defining hardware points is as follows:

o  Specify (Target) the controller for which the hardware point is being defined
e Choose the module from the modules bar

e  Place the module on the drawing area

e Complete the module dialog box

e Save the hardware point definition

e Login to the Field Controller

e Download the hardware point definition to the Field Controller

Defining Hardware points — Target the controller

in the Site List select the BACnet Router and Field Controller that you want to target. This specifies the Field Controller

on which the hardware point is being defined and the location in the database on the PC's hard disk in which the

point definition will be stored.

MANO133 rev 9 © Cylon Controls Ltd.
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Defining Hardware points - Place the module on the drawing area

Once you have selected a module from the modules bar , place it on the drawing area by simply clicking the

drawing area. A dialog box will appear prompting you to enter a name for the hardware point.

Enter a name and click OK to close the dialog box.

The top left hand corner of the module’s symbol, i.e. the graphical symbol for the analog input point, will be
placed on the point on the drawing area where the mouse was clicked.

e Expandable I/O — Hardware Points on CBX + FLX devices

In the Strategy drawing, 10 blocks can be added up to the total on the configured FLX modules plus the CBX

onboard 10.

Note: If a FLX module is deleted from a CBX configuration (in CCConfig) after the Strategy drawing has
been set up, the blocks associated with that FLX’s 10 will be ‘greyed out’ to indicate that they are

inactive.
‘Analog Input 3 Hystaresis Digial Output g
Tempe iy i ! DO Hysteresis Block 15
emperature . ] e T Active High ) - DO
e .- RETE ),
Gy " .o L
Overide | B T [ 5]
Oni 2,00; OFf: 4,00
.................... o P o B
Al Absohne Value 3 [ Hysteress Bock 15 Actve High -
= = N YT I reer i SRR
S pr A s = Mastifister ) Sul——ty]® lopuB_ | Compemeni@| |
.......... —_— L L L
Max
.......... SEEE — L
.......... S oeE L
_—— - —1 |
Al Heating Water ©@eec ||
emp ©besd | |
|63 Input E Eﬂ BACnet Schedule
Oves S o F @ ScheduleNo. 1
..... . [Breas A S [ SEED o Ol
[ nput H Complement [
""""" —— VAV Flow Calaulaton o
Al [ Ty ks
............... @—WPB e T
63 Flow/k K-Factor £
............... — A  Saturday: 09i0
............... SIS y: 09:00 - 17:00
I

Note: Unlike CBM UniPuts, if UniPuts on CBX/CBXi devices are configured as Analog Inputs, they have all of
the parameters that are available in Universal inputs. Also, the “ Operation Mode ” parameters, which

are applicable only to certain CBM UniPuts, are not used by CBX/CBXi.

Defining Hardware points - Save the hardware point definition

Save the edited strategy by choosing Save or Save As... from the File menu. The Save As dialog box appears:

= Save As
4« BACNETIP » strat5 » 001 v @& | Searchooi o
Organise *  Newfolder B~ @
BACNETIP A Name ‘
Archive
DBASE No items match your search.
DRAWINGS
Keypad
Macros
strats
001
Strategy v < >
File name v
Save as type: | V6 Strateqy (*.532) v
= Hide Folders Cancel
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Enter a name under which the strategy should be saved. CXpro"® enters a default file name that identifies the
BACnet Router and Field Controller for which the Strategy has been designed, e.g. if Field Controller #3 on BACnet
Router #1 was connected to a VAV, its strategy might be named: "001_03VAV.s32".

When the Save As dialog box is complete, click OK . The name of the strategy will appear in the Drawing tab:

4 001_03VAV.532
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Connect to the controller

Connect to the controller by clicking the Connect button onthe Strategy tab of the Ribbon

File - Home Controller Strategy
~ Conrllgct 3 £t copy [
’a, Disconnect u LEPaste
Download | .,

Tiselect All | g
Site Controller Clipboard

Download the hardware point definition.
You can download a strategy to a controller in just one step, provided you are using Automatic Download.

To enable Automatic Download, choose Communications from the Controller tab of the Ribbon .

T Home Contraller Strategy
¥ Connedt l$Com nications lil Download @Cc
¥ Disconnect % Cont’:%er )‘D‘J\.’ipe Controller Sk
%, BACnet 4 Auto Online
Site Configuration

This opens the Communications Configuration dialog:

Communications Configuration

Download Options | Scan Options I

¥ Automatic Download ¥ Wipe controller
— Automatic Download Wipe Defaults
—Common
¥ Wipe Strategy
V¥ Wipe Points

[~ Wipe Time Schedules
[ Wipe Hardware Paints

— BACnet

[ Wipe BACnet Objects (Excluding Devi
[ Wipe BACnet Binary Unit Strings
[~ Wipe BACnet Device Name

—Other
[ Wipe Keypad

[ Automatic Online Downloading
I~ Automatically Send Setup

Field Controller will be wiped before download.

ok | Cancel |

which allows you to enable Automatic Download by clicking the Automatic Download check box.
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Click OK to close the Communications Configuration dialog box, and download the hardware point definition to the

Field Controller by choosing Download from the Controller tab of the Ribbon .

h e o CL S
ne Controller Strategy

*& Communications | D-:-wnl-ﬁd
ct % Controller )t} Wipe Co
%, BAChet & Auto Online

Configuration

trolle

CXpro"'® will automatically wipe the Field Controller’s memory, download the hardware point and send the set-
up to the UC, i.e. the number of blocks it is to service. While it is doing this, it will display the Downloading
window. As the point is being downloaded, the Downloading window displays the progress and in the System
status section it shows which of the 3 stages (wiping memory, downloading strategy or sending set-up) CXpro"P
is currently completing. If only one hardware point is being downloaded, the process will take place so quickly
that the downloading window will appear only for a brief moment.

It is more usual to download an entire | Dewnloading X
strategy, with several hardware points and Controller
other modules. In that case, the araware point: R | ©
Downloading window will remain visible for strategy Elocks N | 00
i I |

longer and the progress of the download W 29

. . Digital Setpoint Values _|314
will be measured in the progress bars. acnet oint Contio. N | =

Sending BACnet data via file transfer...
x|
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Summary of procedure for defining hardware points
In practice, the procedure for defining hardware points is as follows:

e Define all hardware points whose values are already known, in the module dialog boxes and place the
corresponding modules somewhere on the drawing area.
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e Save the strategy.

e  (lick Communications Setup from the Communications menu and enable Automatic Download.
e Llogin

e Choose Download from the Communications menu.

Point numbers for inputs and outputs

When another input module is selected, CXpro"® automatically assigns to it the next unused input, i.e. the
unused input with the smallest point number.

Defining digital and analog outputs follows the same principle. As outputs are numbered in the range 9 to 16,
CXpro"® assigns point number 9 to the first output.

For CBX and CBXi devices, point numbers are defined by the I/0 module in which they reside — internal 1/0 on
the CBX/CBXi device are I/O module “0”, any attached FLX devices are I/O modules 1,2 or 3

I/O Module Terminal Number  Type
CBX8R8 1..8 Universal Input
9..16 UniPut™
FLX8R8 adress 1 101 ..108 Universal Input
109 ... 116 UniPut™
FLX8R8 adress 2 201 ...208 Universal Input
209 ... 216 UniPut™
FLX8R8 adress 3 301 ...308 Universal Input
309 ... 316 UniPut™
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A short cut to defining hardware points

To save time when defining the hardware points you can bring the definitions directly to the database by using
the Database Interface.

The types (“A” for analog, “D” for digital), point names and point numbers and units can be written as comma-
separated or tab-separated lists in a word processing application, copied and pasted via the clipboard to the
Database Interface. This avoids unnecessary writing work and typing errors. Using external applications for text
handling also saves time because of their Copy, Search, Replace and Pasting features.

The point list shown below was created in Microsoft Windows Notepad. Other software applications, such as
Excel and Word may also be used.

A Room Temperature 1 °C
A Room Temperature 2 °C
A Outair Temperature South-East °C
A Outair Temperature North-West °C
A Supply Water Temperature 1 °C 5
A Supply Water Temperature 2 °C 6
A Valve 1 %
A Valve 2 % 10
D Pump 1 ON/ OFF 11
D Pump 2 ON/ OFF 12
When preparing a hardware point definition list you must separate the values (type, point name, unit, point
number, etc.) by using tabs or commas, not spaces.
Note: This shortcut for defining hardware point values should only be used for UCs that do not already
have hardware point definitions in the database on the PC’s hard disk, since existing database
entries are not deleted. The Database Interface does not check for uniqueness. This means that
there is a danger of defining more than one entry per point, which will cause a lot of confusion in
later use of the point in other programs.
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WHAT ARE UNIPUTS™?

A UniPut™ can act as an input or an output, so that you can now have a controller that fits your BMS design
exactly - no need to use an extra controller to gain an extra output while leaving an input on the original
controller unused. BMS sites can make more efficient use of a smaller number of controllers, saving on cost and
complexity.
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A UniPut™ can be configured as any one of the following:

or

an Active Input, reading between @ ... 10 V at 40 KQ, with 9-bit resolution.
an Active Output, outputting @ ... 18 V at a maximum load of 26 mA
a Digital Volt-Free contact.

a digital input detecting the presence or absence of 24Vac

a relay switched output.

The Cylon range of controllers has a number of different combinations of UniPuts™ and standard Universal Inputs.

UniPuts™ are used in controller strategies through standard Analog and Digital Input and Output modules.
However, before it is possible to add a module for a UniPut™ to the strategy, the UniPut™ must be configured

using CXpro

HP's 1/O Terminals dialog box.

MANO133 rev 9
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CONFIGURING THE FIELD CONTROLLER’S INPUTS AND OUTPUTS

Cylon controllers have a mixture of Universal Inputs and UniPuts™. The Universal Inputs are fixed as inputs, but
UniPuts™ may be configured as analog or digital inputs or outputs using the I/O Terminals panel.

How to open the " 1/0 Terminals " panel.

The 1/0 Terminals panel is opened by clicking the I/O Terminals button in the Strategy tab of the Ribbon :

roller Strategy

|Input.."0utput | ”~ Defaults |

£ Copy E T MgBacnetF
[F] Paste & BAcnet L
ad | -, Add [fle] Reorder
L_i Select All Text Terminak Modules T Strategy
ler Clipboard Strategy
T
/O Terminals
Terminal Number |Type |InpuUOutput | ~ Defaults |
oo Analog Input
o002 Analog Input Configure |
003 Digital Input
004 Analog Input
005 Digital Input
006 Digital Input
o007 Universal Input
008 Universal Input
009 Analog Cutput
oo Analog Cutput
o011 Digital Cutput
o2 UniPut UniPut
013 UniPut UniPut
014 UniPut UniPut
015 Un!Put Un!Put v Delete |
06 UniPut UniPut
[V Hide I/0 Terminals when finished. OK I Cancel |
H H T™M
How to configure a UniPut
To configure a particular UniPut™ (UIO), /0 Terminals
double-click on its terminal number in the .
Terminal Humber | Type
H om Analog Input
I/O Terminals panel. o it i
003 Digital Input
() Analog Input
005 Digital Input
006 Digital Input
oo7 Universal Input
008 Universal Input
009 Analog Cutput
oo Analog Output
011 Digital Output
o1 UniPut UniPut
014 UniPut UniPut
015 UniPut UniPut
oe UniPut UniPut

|7 Hide I/O Terminals when finished.

Configure |

" Delete |
G|
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The Configure IO Types box opens

Note: Terminals marked Universal
are not UniPuts™, so the
Configure 10 Types dialog for
these terminals does not allow
the terminal to be changed
from Input to Output

Set whether the UniPut™ is to deal with Analog or Configure 10 Types B
Digital signals (the following illustrations show the _ o
R . Point Type Point Direction
UniPut™ being set as an analog output), =
Analog " Input
thigital  Qutput
OK I Cancel |
and whether it is to be an input or an output Configure 10 Types Ex
Point Type Point Direction
% Analog " Input
 Digital ﬁOutput
OK I Cancel |

/O Terminals

Terminal Number | Type | Input/Output | ”~ Defaults |

oM Analog Input

002 Analog Input Configure |
003

004 Configure 10 Types “
005

006 Point Type Point Direction

007

008 " Analog " Input

009 " Digital  output

010

o1

o

o [== |
014

015 uniPut un!Put v Delete |
016 UniPut UniPut
[V Hide I/0 Terminals when finished, OK Cancel |

/O Terminals
Terminal Number | Type | Input/Cutput | ~ Defaults |
o Analog Input
002 Analog Input Configure |
003
004 Configure IO Types “
005
006 Point Type Point Direction
007
008 L\\,  Analog & Input
o003 " Digital € Dutput
010
o
oz
o3 == ]
04

015 uniFut un!Put v Delete |
016 UniPut UniPut
[¥ Hide I/0 Terminals when finished, OK Cancel |

Clickon OK to close the Configure IO Type box, Configure 10 Types
Point Type Point Direction
% Analog " Input
 Digital * Qutput
OK Cancel

MANO133 rev 9
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a Point Name dialog opens:

Enter a name for the point and click OK .

and the I/O Terminals panel will display the

UniPut™'s configuration (in the illustration, terminal
012 has become an Analog Output)

Point Mame

Point Mame ||

614

Cancel

Point Name

Point Name I HW_\raI\re|

OE{ I Cancel

1/0 Terminals

Repeat this process until all required UniPuts™ have been configured.

Terminal Number Type I Input/Output | A Defaults
001 Analog Input

002 Analog Input Configure
003 Digital Input

004 Analog Input

005 Digital Input

006 Digital Input

007 Universal Input

008 Universal Input

009 Analog Output

oo Analog Output

o Digital QOutput

"2 Analog Qutput

013 UniPut UniPut

014 UniPut UniPut

015 UniFUt UniFUt - Delete
016 UniPut UniPut
[ Hide I/ Terminals when finished, OK | Cancel

Note: When the 1/O Terminals dialog is closed, point modules will be added to the strategy drawing for
any newly-configured terminals which were not already in the strategy.
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Changing the configuration of a UniPut™

If you want to change the configuration of an existing UniPut™, you must 'delete' its configuration from the I/O

Terminals panel.

Note: The Delete button on the I/O Terminals panel will not work if there is a module in the strategy for

that point. If you click on Delete when a point is selected for which there is a module in the

strategy, a message will appear to alert you of this fact.

CXproHD

Paint 12 is used in the strategy.
You must remove it frem the strategy if you want to change its
cenfiguration.

In order to proceed in this case you must delete the module representing that point from the

Strategy drawing area by selecting it and pressing the [Delete] button on the PC’s keyboard.

Open the I/0 Terminals panel, by clicking on the 1/O Terminals button in the Strategy tab of the Ribbon :

roller Strategy

£ copy E A

[F"] Paste
== View | Add [fle] Reorder
i_iselect All | |podules| Text Termi Madules T Strategy

ler Clipboard Strategy

g BAcnetF
& sacnet L

Select the terminal number

I/0 Terminals

[V Hide 1/O Terminals when finished.

and click on Delete

1/O Terminals

Terminal Mumber Type |\nputl'0utput I ~ Defaults |
001 Analog Input
002 Analog Input Configure |
003 Digital Input
004 Analog Input
005 Digital Input
006 Digital Input
007 Universal Input
008 Universal Input
009 Analog Qutput
010 Analog Output
011 Digital Qutput
012 Analog Qutput
013 UniPut UniPut
04 UniPut UniPut
013 UniPut UniPut . Delete |
o1e UniPut UniPut

Cancel |

[V Hide 1/O Terminals when finished.

Terminal Humber Type | Input/Qutput | ~ Defaults |
o0 Analog Input

002 Analog Input Configure |
003 Digital Input

004 Analog Input

005 Digital Input

006 Digital Input

007 Universal Input

008 Universal Input

009 Analog Qutput

010 Analog Qutput

011 Digital Output

012 Analog Qutput

013 UniPut UniPut

o014 UniPut UniPut

015 un?Put UniPut v Delete
016 UniPut UniPut AH

e _|

MANO133 rev 9
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[~ Defaults
Configure

.

OK Cancel

. 1/O Terminals
The selected terminal has now been returned i
to the blank 'UniPut' configuration. o ol B | input/Output
001 Analog Input
002 Analog Input
003 Digital Input
004 Analog Input
005 Digital Input
006 Digital Input
007 Universal Input
008 Universal Input
009 Analog Output
010 Analog Output
o1 D\gital Ou.tput
The terminal can now be re-configured as o i g
. . . 014 UniPut UniPut
detailed in How to configure a on page 74. 0 Oniput Oniput
016 UniPut UniPut
¥ Hide IO Terminals when finished.
Example: Configuring Analog Input module properties
01_01.532 Properties A x |

Al

Anzlog Input 1
Outside Air
Temperature

Paint £

Qvemide [ )

Al

Anzlog Input 2
Heating Water
Temp

Point £ frem
!

Ovemide [0

e General Information

Type

? |Analog Input [1]

Type
Service Order
MName

Synchronised Status

Point type

Low thresheld
High threshold
Lower sensor range
Upper senser range
Input error
Exponential filter
Sensor type

Unit

Averaging

Point

Manual override

Analog Input
.

Outside Air Temperature

Checking...

Input Analog
78

120

-50

150

0.0000

20

PT1000

°C

0

Analog (1): 0.00 Qutside Air T...

Digital

Properties Page Mames

(not editable) shows that this is an Analog input.

Service Order

(not editable) indicates the order in which this block will be processed by the controller.

Name

Modules

Shows the text identifier for the point, which must be no more than 24 alphanumeric characters. Spaces,
commas, full stops may also be used. Each point in a Field Controller must have a point name that is unique
within that controller.

Synchronised Status

78
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Shows whether the Strategy Drawing matches the Strategy in the connected Controller.

e Constants
Low Input Threshold / High Input Threshold / Low Strategy Value / Hight Strategy Value

The threshold settings specify the on/off turnover point on a digital input or output.
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Input Error

A constant with the same unit as the input value, which is added to the input value to compensate for errors in
input arising from factors such as resistance of long cables or positioning of sensors. Temperature values (sensor
type PT1000) are corrected in mV. To compensate for 1 °C, the input error is 2.5 mV. For example, a decrease in
temperature of 2 °C requires an input error of -5.0 mV to be entered. This feature is only available for analog
passive inputs.

e Exp. Filter Constant
An individual time constant for the analog input., behaving as a damping filter. The measured input value will be

averaged over the time specified in seconds by the Exponential Filter constant, so that short-term variations of the

measured value can be filtered out if the Exponential Filter value is longer than the sensor response time.
e Sensor Type
Select the required filter from the Sensor Type list. Some of the available options are:

e Pt1000: This configures the analog input for reading temperatures from a standard Pt1000 sensor. The
Controller will convert the measured resistance (voltage) to a temperature signal.

e 0-10 V: This converts the hardware voltage signal 8..16 V DC to a software value in the range 0..100 %.
For example, the voltage signal 6.7 V DC will be converted to 67.0 %.

e 0-20 mA: This converts the hardware current signal 0..20 mA to a software value in the range 0..100 %.
For example, a current of 15.0 mA gives the software a value of 75.0 %.

e Pulse(V/F): This is designed for reading voltage-free contacts, which can be operated at a frequency of
up to 12 Hz. The value of the input will be incremented by 1 after each detected pulse. Evaluation and
resetting of the counter will be done by using the Meter Module (module 63).

Additional sensor types can be allowed for by defining extra units of measurement - see Appendix :: Adding
units of measurement to the system on page 209.

e Unit

The Unit list box contains a collection of text strings, one of which will be displayed together with the point

value. Choose from the list the type of unit that corresponds to the type of input, e.g. if an analog input point
represents a temperature reading in degrees Celsius, you may choose DegC from the Units list box. If necessary,
additional units may be defined in the C:\CxXproHD\ (SITENAME)\SYSTEM\site.ini file. Appendix :: Adding
units of measurement to the system on page 209 contains details of how this is done.

e Point

The output of the Analog Point module assumes the type, Name and units of the point module. A point number
is automatically assigned (though this can be edited by selecting the connecting line, which represents the point
itself)

Note: Point numbers 1...8 represent controller inputs 1...8.

Point numbers 9...16 represent controller outputs 1...8.
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Viewing used blocks

To check which blocks have been used in a Strategy, select Strategy Details from the Strategy tab of the Ribbon :

R T T By

Strategy

] Copy T E &3 BACnet Points Ezl
FqPaste 8 BACnet Units

B View | Add 11 Rearder | Strategy
_iselect All | modules| Text Terminals Modules EFIE StI'EtE%DEtEHS Help

Clipboard Strategy

n Ml And nd ~37

This opens the Strategy Details dialog:

Strategy Details

Strategy Blocks | Controller | Resources | Peints Manager |

001 Comparater ~
002 BACnet Schedule

003 Absolute Value

004 Masimum

005 Analog Gate

006 Limit to Dor 100

007 Rounding

008 Integer Constant

003 Real Constart

010 VAV Dfferential Pressurs
011 Mot Used

012 Mot Used

013 Net Used

014 Not Used

015 Mot Used

016 Not Used

017 Mot Used

018 Not Used

019 Net Used

020 Mot Used

021 Net Used

022 Mot Used

023 Mot Used o

Viewing the list of blocks

Click on the Strategy Blocks tab to see which of the available blocks have been used in the active strategy and
which have not.

Strategy Details

Strategy Blocks | Controller | Resources | Points Manager |

007 Comparstor ~
002 BACnet Schedule

003 Absolute Value

004 Maimum

005 Analog Gate

006 Limitto Dor 100

007 Rounding

008 Integer Constant

003 Resl Constant

010 VAV Differential Pressure
011 Not Used

012 Not Used

013 Not Used

014 Not Used

015 Not Used

016 Not Used

017 Not Used

018 Not Used

019 Not Used

020 Not Used

021 Not Used

022 Not Used

023 Not Used v

In the above example, the Strategy Blocks tab indicates that the first block (block no. 001) is being used as a

Comparator module.
Block 802 is an BACnet Schedule module, block 903 is an Absolute Value module etc.
Blocks 011 to 023 have not been used in the strategy.

To view the remaining blocks (in the above example, blocks 024 ... 1824), use the horizontal scroll bar to move
down the Strategy Blocks tab.
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Viewing the blocks associated with each point

The Points Manager tab allows you to examine points in a strategy, listing the strategy blocks to which each point is
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connected.
Strategy Details “
Strategy Blocks I Cortroller | Resources  Points Manager
Analog Points
[#--3= Digital Poirts

In this example, Analog Point number 2 is connected to strategy blocks numbered 3 and 4.

MANO0133 rev 9 © Cylon Controls Ltd. 81



an04dxD

KEEPING CXpro"® AND CONTROLLER STRATEGIES IN SYNC

Strategy Compare

When connected to a site, it is possible to compare the strategy in CXpro"® with that in the Controller.

To compare CXpro*? and Controller strategies,

Connect to the Controller by clicking on the Connect button in the Home tab of the Ribbon :

Qo =

File - Home Controller Strategy

’ CoEed: m Copy Properties I Modules | Strategy
ﬂ Disconnect LEPaste - Navigatiun ||E| Macros |:| Reopen
..... ite
L_iSelect All List E Page Mames @ Search
Site Clipboard View
Site List a B |« Strategy1
E--@ Sites
B-Fg BACnetIP
| 8- 001 - Network
H =001 - 001 - UCU3213V

Right-click on the Field Controller in the Site List and select Strategy operations > Compare Strategy To Controller ,

i = W .............
Sample Apps | =7 | OPEN 0010132 a0 Wl - - - IS

R e TR £ | utside
B2 001 - wet Dutside A

Copy Strategy To

Strategy operations 4 E‘t Reorder Module Blocks

Export Aspect Data

Update BACnet EDE Data Compare Strategy To Controller
----@,, B L L —

Alternatively you can select Compare from the Controller tab of the Ribbon .

1®e Controller Strategy
%Communications I't'l Download @Co are E:';Version r.{B
1 %Controller )BWipe Controller Sh-:an-:umpare %Time and Date 'ﬂm
% BACnet Ii"l‘ Auto Online "_|:!| Maximums :.' L
Configuration Operations

Only strategy modules are compared.

Note: Parts of the strategy that can be modified using tools other than the Engineering Tool (e.g.
CCView) are not compared. For example, the sample interval on a Datalog module is excluded
from the comparison, but the Type of datalog is included.
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Compare Process
When the Compare process is requested, the Select Items to Compare dialog is displayed:

Select ltems to Compare

¥ Hardware Blocks

[~ Range | 001-024

v Strategy Block:

[™ Range | 007-1024

¥ Analog Setpoint Values

[” Range | 001-1024

¥ Digital Setpoint Values

[~ Range | 001-1024

¥ BACnet Points
[~ Range |001-224

¥ Select/ deselect all
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Compare | Cancel |

This allows specific subsets of the strategy to be compared if required.

Clicking the Compare button starts the process, and shows the Uploading progress dialog:

Uploading X
Controller

Hardware Points ’i
Strategy Blocks _
Analog Setpoint Values ’7
Digital Setpoint Values ’7
BAChnet Point Config ,7

Receiving analog setpoints...

RENER

e | [Croon ]

and when upload is complete, a comparison report dialog is displayed

=
o
o
=)

Site : BACnet Real Comms Contreller No.: 2 Field Controller No.: 1

Select blocks to update

Type [ Service Or... | Block Type | Difference

FLX Module 1 Configuration FLXModule at agdress <1> Is configured on controller but is not configure
Strateqy Blacks 1 Boalean The Output “Complement” has address: - <Unconnected> on the Contralle
Strategy Blocks 3 Adder/Scaler The Input “Input B* has address: - <Unconnected> on the Controller - <2>
Strategy Blocks 6 Modbus analog The black of type Modbus analog at address 6 on the strategy is not presen
Strateqy Blacks 1025 FLX part configurat.. The ‘Module at 1° valug is: - <FLX=4R4> on the Controller - <None> on the
< >

1 Show only blocks with differences © Showall blocks
PC Controlier

A Jump to, A

I Compare is complete, (Select to start a new upload.)

This dialog lists all of the differences between the PC version of the Strategy and the Controller version, with a
facility to jump to each of the modules that contains a difference, so that the difference can be manually resolved.

When the differences have been resolved, clicking on the Close button terminates the Compare process.
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Strategy Synchronization

CXprot® will evaluate whether its copy of the strategy and the Controller's are fully synchronized at the following
times:

e When a module is selectedin the Strategy drawing
e When a strategy is closed following a partial download
e When Scan Mode is enabled
If any potential discrepancy is found, the user will be prompted to run the Strategy Compare feature.

Modules in the drawing that do not match the controller strategy are marked with an icon showing a red circle

containing an “x” to indicate that it is no in sync:

A-B TR .1
7S Inpz A ouput [y
) Input B Complement [

The user is not blocked or forced to take any action, and no changes take place in the background.

Note: The checks apply to all strategy modules with the following exceptions:

* Macros

¢ DI Modules

¢ Set Point Modules

¢ |0 Modules (On UC16 controllers)
e Comment Modules

When a module properties are edited:

When a module is selected, its Synchronised Status is displayed in the properties inspector:

Synchronised Status Checking...
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When a strategy is closed following a partial download:

A partial download takes place when Automatic Download is disabled (see How to download a strategy manually on
on page 120). In this case selecting Compare from the Controller tab of the Ribbon will open a Select items to

Download dialog allowing different subsets of the strategy to be downloaded individually.
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This dialog is similar to the Select Items to Compare dialog used in the compare process (see Strategy Compare on

page 82).

However, if you carry out a partial download the setup block is not downloaded. The next time you close the
strategy, the Synchronisation process will register a discrepancy between PC and Controller strategies. When this
happens, a warning will be displayed stating that the “setup block was updated but not downloaded”and
suggesting that the setup is downloaded:

Cylon Engineering Centre

'0' The setup block was updated but not downloaded to the controller.

k. *
This may cause synchronization issues between the controller strategy
and PC strategy. It is strongly recommended that you download the

setup to the controller before continuing.

Do you want to continue anyway?

Yes | Mo |

Clicking on the No button will allow you to save the setup block. If you do not wish to do so, click the Yes
button and the strategy will be closed without updating the setup block on the Controller.

When Scan mode is enabled

When Scan Mode is activated (see Activate scan mode on page 130) the PC version of the strategy is compared to

the Controller version and if any discrepancies are found, the mismatched modules will be identified by a flashing
‘highlight box” and a message in the status bar will inform the user
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READING LIVE POINT VALUES (LIVELOG)

The LiveLog feature in CXpro"® allows you to read the values of points in the controllers on your site (i.e. it
reports “live” or in real-time from the site).

As well as reading point values, the Livelog also scans time schedules, the BMS network and its Fieldbusses and,
if configured to do so, it will log those values to a text file. It can also show HOA values.

Configuring Live Log
Livelog can scan just one strategy or all open strategies, can either append to the log or wipe the log each time it
starts, and can write the log to a file for later analysis.

To set up these options, select LiveLog Setup from the Controller tab of the Ribbon

Contraller | Strategy

+4 Communications |y Download [, compare B version QboardDiagnestis | 1 £ [&= Fﬂ\-i"wg Setup = =
T3 Controller '} Wipe Controller 7 Show Compare | B Time and Date B} statistics Q0 £ [ LiveLog Report 7 <

Scan  Override Livelo. Interface Config:
% BACnet ™ Auto Online PR maximums B3 Lock and Unlock Point o &; Upload BAChet Points | guilder 2

Configuration Operations Testing Keypad

o |4 001_01.532 b x| [Properties
A | ~

B LiveLog Setup
Canfigure Livelog operation.

This opens the Livelog Setup dialog.

Livelog Setup
Scan Update
" Al Opened Strategies " append
' Active Strategy * Overwrite
Scan Interval (<60s) 5

¥ Log To File

| \SYSTEMNiowin.log

In the Update section, select Append to cause the LiveLlog add new scan data to the end of the existing list, or
Overwrite to cause the Livelog list to be replaced each time a scan is completed.

Update
" Append

* Qverwrite

In the Scan section you can either click the All Opened Strategies radio button to allow the Livelog to show point
values from all of the strategies that are currently opened, or else restrict the log to the point values of the active
strategy only, by clicking the Active Strategy radio button.
Scan
" All Opened Strategies
(v Active Strategy

Scan Interval (< 60s) 5

If you chose to scan the Active Strategy only, enter a number between 1 and 60 in the Scan Interval edit box. This
represents the number of seconds CXpro"® will remain idle after scanning the strategy before it will scan the
strategy again. (The LivelLog continuously scans the strategy until you press the Stop Scan button on the Livelog

dialog)
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If you would like the results of the LivelLog to be written to a text file and saved, click the Log to File checkbox. By
default, logs are saved to \SYSTEM\iowin.log

To view the contents of the Livelog text file, click LiveLog Report in the Controller tab of the Ribbon :

Controller | Strategy

& Communications | ph Download [Z, compare B version I3 Board Diagnostics rIQ EI@ =] [ livelog Setup I:I’ 3
3 Contraller %} Wipe Controller 7] show Compare | T Time and Date B statistics T [ LiveLog Report
o o =] Scan  Override LiveLog T% Interface Cor
# BaCnet 4 Auto Online Maximums S Lock and Unlack Foint ®, uptbad BACnet Points | gyilder
Configuration Operations Testing Keypac
2 B 4 001_01.532 I X | Properties

~ | ~
tiP

This will open the log file in your default text editor:

A iowin.log - Notepad = E

File Edit Format View Help
| Currently Scanning Scanning Real Points (1-16)

881_81.s532 PL Office 881 - Network @@l - @@l - CBM24

281_981.s32 PL Office @881 - Network @al1 - eal1 - CBM24

Running LivelLog

Select from the Site List the site the BACnet Router and Field Controller containing the point that is to be read.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

File - Home Controller Strategy

’COEEG mCopy Properties |Modu\es‘§i|strategy
>ﬂD\sc- nnect L‘ﬁPaste Nawgatmn Macrns [[] Reopen
— it

I select All u;: [ Page Names [ search

Site Cliboard View

Activate Livelog by clicking the LiveLog option in the Controller tab of the Ribbon

File ~  Home  Controller = Strategy

& connet *% Communications | % Download [, compare B version I3 Board Diagnostics rIQ D@ =] B Livelog setup =
¥ Disconnect | G Controller '} Wipe Controller 7 Show Compare | T Time and Date ) Statistics (R LiveLog Report 9
. = = Scan Override Livelol Intert
®y Bacnet 4 Auto Online. ) Maximums & Lock and Unlock Point & Upload BACnet Points | gy,

Site Configuration Operations Testing

Site List 2 B« 001_01.532 P X | [Prog ivelog (Shift+F3)
|E| 3] Sites - I Y A viewiveiog output.
This opens the Livelog dialog:

Ll Livelog

Livelog of Site |
Strategy Target [y Office [ 001 - Metwork [ 001 -001 - CBM24
Paint No__|_Paint Name. [ Point Type | value [ Override | Time ]
e 002 Heating Water Temp Analog 0.01 14:31:58
2 Fonie 003 Qutside Air Temperature  Analog 0.0 1431:58
€ Time Schedules
€ Network
~Scanning
10 Paints
" Analogs
 Digitals
Override Stop Sean Clear
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LiveLog - Scanning Definition

In the LiveLog dialog, you can view the following parameters for the Livelog, and change them where it is
appropriate to do so:

e The name of the current strategy

e The Mode of the Livelog, i.e. whether the LiveLog will log points, schedules or the network status

e The Target Controller for the current strategy

e The type of points to be scanned

e  Whether or not points will be overwritten

Strategy name tab

L] Liveluy —

Livelog of Site ]

The name of the strategy which is actively being scanned is displayed on the strategy name tab . If you chose the
scan Active Strategy option in the Livelog Setup dialog box (see Configuring Live Log on page 86), the file name tab
will display the name of the active strategy. If you chose the scan All Opened Strategies option in the Livelog Setup

dialog box, there will be a file name tab for every open strategy.

Strategy Target

Strategy Target | pL Office | 001 - Network [ 001 - 001 - cBM24

This window shows the target of the currently selected strategy. The values cannot be changed in the Livelog
dialog.
LiveLog mode

hMode

* Paoints
~

~

The LivelLog interface changes, depending on the mode that is being logged:

e Points mode

In this view you can see points in the selected strategy, their types and values, and you can overwrite them if
required.

e LivelLog: Time Schedule mode
You can examine the time schedules in the selected strategy with this dialog box.
e LivelLog: Network mode

You can view the status of the RS485 Fieldbus with this screen, i.e. which controllers are online or offline, and which
controllers are servicing or not servicing.
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Scanning definition =3
. =
Scanning 17
Q

(% |10 Points =
" Analogs >
" Digitals =
<

O

=

(0]
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The Scanning section of the LiveLog window allows you to decide which values to scan.
To scan the values of the controller’'s hardware points, click IOPoints .

To scan analog points only, click Analogs in the scanning section. To scan a specific number of analog points,

enter a range of point numbers in the edit box under Digitals .

To scan digital points only, click Digitals in the scanning section. To scan a specific number of digital points, enter

a range of point numbers in the edit box under Digitals .

Override Status

When a scan has been stopped, you can change the override status of any point listed in the LiveLog window by
selecting the the point from the list and clicking on the Override button at the bottom left of the window.

Point No Paint Mame Point Type Value Cwerride Time
002 Heating Water Temp Analog 0.01 15:44:08

Qutside Air Temperature Analog

O\ret'de Stop Scan | Clear ‘

This opens the Override Point dialog, where the current override status of the point is displayed and can be
changed if necessary.

Override Point

Pairthumber [
Paint Value

Point Type
% Andlog
" Digital
¥ Hardware Poirt
Overiide Duration for Hardware Point
& o £ 1 Hou

" Midnight " Continuous

Ready

Ovenide
For the point currently selected in the LiveLog dialog, the Override Point dialog displays the following:
e The radio buttons labelled Analog and Digital specify whether the point is analog or digital.
e The Point Number box displays the number of the currently selected point.

e A value for the currently selected point can be entered in the Point Value box. The point will be set to

the entered value when the Override button is pressed.

Note: If you want to change the override status of the point in any way, after editing the appropriate
boxes you must press the Override button to close the dialog box and apply the changes.
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MANUALLY OVERRIDING POINT VALUES - THE OVERRIDE POINT DIALOG

Overriding points

Point values can be overridden using the Override Point dialog, which allows you to set a point in a strategy to a
particular value, regardless of conditions at a controller’s inputs or outputs, or conditions within the strategy itself.

e When a hardware output is manually overridden (disabled), the modules in the strategy do not affect the
point value.

e When a hardware input is manually overridden (disabled), the hardware signal which is connected to
the input (PT1000, transmitter, dry contact, etc.) is ignored by the input.

In both cases, the overridden hardware point keeps the value that is assigned to it in the Override Point dialog.

The only way to change the value of a hardware point which has been manually overridden to another specified
value is to use the Override option again, assigning a new value in place of the first.

Note: Some specific controllers, such as CBX-8R8-H and FLX-4R4-H, have “HOA” controls built in to
them. When these HOA controls are active, CXpro"® cannot affect them but can display the
overridden values, but not affect them.

Removing manual override status from a hardware point (enabling) means that the point can now be influenced
by the connected hardware or strategy once again. The length of time that a hardware point will remain in the
overridden state can be set in CXpro*P.

It is only possible to disable and enable hardware point values from CXpro*® if the PCis connected to a controller
(either directly or via a BACnet Router) and CXpro"® Connect button is active.

How to open the Override Point dialog

The Override Point dialog box allows you to

e Override or “disable” a hardware point, i.e. set it to a constant value regardless of conditions at the
controllers inputs and outputs
e “enable” a hardware point, i.e. return the point’s value to the automatic state.

e Change the value of a setpoint

To open the Override Point dialog, select Change Point from the Controller tab of the Ribbon

Controller | Strategy

¥4 Communications | gh Download [, compare B version I Board Diagnostics | [ LA [&5] B vLivetog setup E
L3 Controller %} Wipe Controller F2 Show Compare | &) Time and Date EJ} statistics Qo ¥ F@ Livelog Report
o = = Scan  Override Livelog Inte
&, BACnet 3 Auto Online g Maximums 3 Lack and Unlock Paint #, Upload BACnet Points | gy
Canfiguration Operations Testing
= ] 001_01.532

etlP
et Serial
fice

or click on the Override button in the Livelog dialog.

Ovet'de Stop Scan Clear
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How to select a point to be changed in the Override Point dialog
When changing the value of a point using the Override Point dialog box, you must specify the point by either:
e Entering the number in the Point number box:

Fill in the Point Number field in the dialog of the Override Point dialog
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You must specify whether or not the point is analog or digital, because there could be one point of each type for
each number.

Override Point

Paint Mumber |23
Fairt i alue I

" Analog

— Point Type

& Digital

[ Hardware Poirt

Ovveride Duration for Hardware Point
 Off 1 Hour
€ Midnight = Continuous

Feady...

Overide | Cloze I

e Selecting point before opening from LiveLog window:

If the LiveLog window is not already open, open it by clicking the LiveLog option in the Controller tab of the

File ~  Home  Controller | Strategy
A Connect *& Communications | gy Download [, compare B version W Board Diagnostis . [1 [ [E] Gotivelog setup =
¥ Disconnect | 5§ Controller X Wipe Controller [7] show Compare | T Time and Date ) statistics QU O I B Livelog Report 9
o = = Scan Override livelols gy Interf
B BAChet & Auto Online B Maximums & Lock and Unlack Pai P, Upload BACnet Points | gy,
Site Configuration Operations Testing

Site List 28 4 001_01.532 b x| Prog |%| Livelog (Shift+F3)
|E ) Sites A Py 4| viewLivelog output,
Click Stop Scan :

I

Cverride | Stop Ecan | Clear |

Select the point from the list in the LiveLog window (I/0 window):

| Paint No | Point Mame | Point Type | Value ‘ Override ‘ Time
002 Heating Water Temp Analog 0.01 15:44:08

Outside Air Temperature Analog

Dvet'de Stop Scan | Clear

Click on the Override button at the bottom left of the window to open the Override Point dialog.
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HOW TO OVERRIDE (DISABLE) A HARDWARE POINT
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Hardware points can be overridden by the CXpro"® Override Point dialog, or by HOA switches on the Controller

itself. In either case CXpro"? is aware of the override state and value, and displays it in the LiveLog window.

4 001_01.532 b x| [Navigatic
- II|
Analog Output faid B Livelog X
AO ourpur 209 @
[© Point [ Gemed Livelog of Site I
Strategy Target [ pesk [ cylon BACnet Router (Chri [ 002 - 001 - CBX3RS this cor
Mode | PointNo | PointMame | PointType | Value Override Time
209 Anl Qutput 209  Analog 4 11:31:09
’7 & Points | -
o
4 001_01.532 b x| |Navigatic
- |
ArabgOupr 5| | (W7 Livelog X
AO  ani ourpur 209 @
[© Point [ Gemed Livelog of Site I
Strategy Target [ pesk | Cylon BACnet Router (Chri [ 002 - 001 - CEXBRS this cor

Point No Point Mame Point Type | Walue Override Time |

Made

09 Anl Qutput 209 Analog 15.00 One Hour 11:32:50
@ Points
£ Timma Cotandilne

4 001_01.532 box | [Navigatit

=N

Analog Output 2% 57 Livelog

AO Anl Output 209 @)

© Peint [ Oere(] Livelog of Site |
Strategy Target | pesk | Cylon BACnet Router (Chri [ 002 - 001 - CEXBRS this cor
Mode | Point No ‘ Point Name | Point Type. ‘ Value Override. Time
Anl Output 209 Analog 15.00 Continuous . 11:33:18
¥ Points
& Time Srhedules
q 001_01.532 box | [Navigati
A | -
Ll
ArskgOup 22| | @1 Livelog ~
AO anloutput 209 @]
© Fein: [ o=@ | Livelogof site |
Strategy Target [ pesk | Cylon BACnet Router (Chri | 002 - 001 - CBXSRE this cor
Mode PointNo | PointName | PointType | Value | Ovemde | Tim _

Anl Output 209 Analog 0.00
’V * Points
I Tirma Srhadnlas

The point’s Strategy module has a digital output labelled Override, which is set to a value of 1 if an override is in
effect (i.e. the hardware point is ‘disabled’), or @ if the point is not overridden (i.e. the point is ‘enabled’).

Anzlog Output 17 Digital Output 20
AO Analog Qutput DO Boiler Enable
£ Point | owemi[H) Point | ovemz=[H)
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Using the Override Point dialog:
Open the Override Point dialog by

1. selecting Change Point from the Controller tab of the Ribbon

Controller | Strategy
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¥4 Communications | b Download [, compare B version I Board Diagnostis | 71 [ [E5] Bvivelog setup E
g Controlier %} Wipe Controller =2 Show Compare | B Time and Date Ej) statisties Q o ¥ R LiveLog Report
" o i Sean  Override Livelog Inte
% BaCnet 3 Auto Online B Maximums & Lock and Unlock Point & Upload BAChet Points | gy
Configuration Operations Testing
|« 001_01532
ar

et Serial
fice

2. or by clicking on the Override button in the Livelog dialog

Point No Point Mame Point Type Value Override Time
002 Heating Water Temp Analog 0.01 15:44:08

Outside Air Temperature Analog

Ovet de Stop Scan Clear

and select the point to be overridden
The override facility can be set to one of the following states:

e inactive at all times - 0ff

e active until the controller time passes 00:00 - Midnight

e  active for one hour from the time at which it becomes active - 1 Hour

e active at all times —Continuous

e Ifthe override is caused by a Controller’s HOA switch, the override state is reported as “HOA”

The 'midnight'and 'l hour' options are provided to conveniently avoid problems that could arise if the override
is not removed when it is no longer required.

Note: Even if '0ff' is selected in the Override Duration for Hardware Point section, setting a value (analog)
or state (digital) for the point will still have an effect. When the Override button on the dialog is

pressed, the value is sent to the point in the controller strategy, which stays at that value until the
next time that the controller scans its strategy.

Tick the Hardware Points checkbox in the Point . Hardwars Paint
Type section of the dialog. Overide Duration for Hardware Paink
This will enable the Override Duration for Hardware - of £ 1 Hour

" Midright (" Continuous

Point options.
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Enter a value for the point.

In this instance, a value of 25 is being is being
entered for an analog point.

A value of 1 or 0 can be entered for digital points.
Select the length of time that the value of the

point will be changed in the Override Duration for

Hardware Point section of the dialog.

The point will be set to the entered value when
the Override button is pressed:

Click the Close button to close the dialog.

Notes about overriding BACnet points

AVCIHNIUT TUIn

Paint Murber 1
Paint Walue 29

Fairt Type

¥ Hardware Paint
Override Duration for Hardware Paoint
" 0 fy. 1 Hour

" Midnight " Continuous

] venidT Cloze

Inputs

When an input is overridden via CXpro"®, both the “out of service” and the “override” flags
are automatically set.

When an overridden input comes out of its CXpro"'® override both the “out of service” and the
“override” flags are reset. It will be put into service regardless of the state it was in prior to
going into override.

To override an input via BACnet, the “out of service” flag is manually set by writing to the “out
of service” property. Then the desired value is written to the present-value. The OWS can
clear any CXpro"® override by putting the point back into service and then back out again. From
CXpro"'® side, the “override” flag will disappear and be replaced with an “overridden” flag.

Putting an input in service will clear all overrides both CXpro"® and BACnet and will flag the
change appropriately on both protocols.

Outputs

When an output is overridden via CXpro"®, both the “out of service” and the “override” flags
are set. The information in the present-value property will still be delivered to the hardware
layer despite being out of service.

When an overridden output comes out of its CXpro"® override, the point is put back in service
and both the “out of service” and the “override” flags are reset.

To override an output via BACnet, it is presumed that the priority array will be used, and clear all
overrides and flag the change appropriately on both sides.

All I/0 blocks have an output labelled Override . This output is true any time the point is “out of

service” or “overridden” via CXpro"P. This way the point reflects the status of the data
regardless of whether it is being overridden via BACnet or CXpro"®.
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HOW TO ENABLE A HARDWARE POINT VALUE (REMOVE MANUAL OVERRIDE STATUS)

Removing manual override status from a hardware point (enabling) means that the point will once again respond
to hardware connections or strategy conditions.

If the override duration on a hardware point has been set to 1 hour or until Midnight the point will be enabled
when the specified period has elapsed. However,

Note:
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If the override is identified as “HOA” you must use the switch on the Controller to disable it.

if the override duration as been set to Continuous the following procedure must be carried to enable
the point:

Open the Override Point dialog by selecting Change Point from the Controller tab of the Ribbon or by

clicking on the Override button in the Livelog dialog, and select the point to be overridden.

Select the Off option in the Override Duration section of
¥ Hardware Paint

the dialog,
Override Duration for Hardware Point
Click the Override button to apply the change. (‘(hﬂff 1 Hour
b idnight " Continuous

Click the Close button to close the dialog.

Bra=dn

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click
the Restart button.

The next time the LiveLog scans that point, its new value will be displayed. The LiveLog window displays
the symbol 9 beside the value of points that have been changed.

Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to
be monitored more effectively.

MANO133 rev 9
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HOW TO CHANGE THE VALUE OF A VIRTUAL POINT

The value of a virtual point can be changed using the Override Point dialog box, in a similar way to changing the value of

a hardware point. However, virtual points cannot be overridden — if conditions in a strategy change, a virtual point may
change from the value given to it in the Override Point dialog. As a result, changing the value of a virtual point is usually

only relevant in the case of setpoints, because their values are not affected by the strategy.

The procedure for changing the value of a setpoint is as follows:

Open the Override Point dialog by selecting Change Point from the Controller tab of the Ribbon

Controller | Strategy

¥4 Communications | by Download [, compare B version I Board Diagnostis | 71 | A | [E5] B vivetoo Setup E
L3 Controller %} Wipe Controller =2 Show Compare | T Time and Date G statistics Qe F@ Livelog Report
" o fln Sean Override Livelog Inte
#, BACnet 3 Auto Online 2 Maximums & Lock and Unlack Poin . Upload BACnet Points gy
Configuration Operations Testing
23« 001_01532

r

or by clicking on the Override button in the Livelog dialog.

Point No Point Name Point Type WValue Override. Time
002 Heating Water Temp Analog 0.01 15:44:08

Qutside Air Temperature Analog 0.01

OVEE'de Stop Scan Clear
and select the virtual point (setpoint) that is to be changed. Override Point
Enter the new value for the virtual point. Panttimber [13
Point Yalue |19
Note: Because the point is a virtual point, the Override Point Tupe
Duration for Hardware Points options are ‘greyed out’ & Analog
and cannot be selected. " Digita
I~ Hardware Poirt
Owerride Duration for Hardware Point
Click the Override button to apply the change. & -~

i i
Click the Close button to close the dialog,

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click the

Restart button.

The next time the Livelog scans that point, its new value will be displayed. The LiveLog displays the symbol 9

beside the value of points that have been changed.

Note: Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to

be monitored more effectively.
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WHAT IS A STRATEGY?

A Cylon Field Controller interacts with HVAC and other equipment by varying its outputs in response to inputs such
as temperature, switch settings, air flow speed etc.

The way that the controller’s outputs react in response to the controller’s inputs can be defined by the user. The
definition is called a ‘strategy’.

A strategy is the ‘user program’, stored in a Cylon Field Controller, which configures the controller for a specific role
in a BMS site. It can be described as the “implementation of a solution to a requirement on a site”.

In CXpro®®, a strategy is designed graphically using the algorithmic modules available on the modules panel. It is

saved as a strategy file on the Engineering PC and then downloaded to the controller for which it was designed,
where it tells the controller how to behave within the BMS site.

The simplest of strategies is made up algorithmic modules, hardware and virtual points. Strategies are often more
complex, however, and can also include time schedules , trendlogs and alarms.
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AN EXAMPLE OF A STRATEGY

The Problem
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The heating system of a building is too costly to run constantly.

The Solution

The heating system should be switched off when the outside air temperature rises above a certain point (for
example 23°C). It should not be switched on again until the outside air temperature drops below another pre-
defined point (in this case, 18°C).

The Strategy

A strategy to implement this solution to the problem can be designed in CXpro"® and downloaded to the
controller connected to the heating system, where it will be applied.

The strategy shown below uses the Hysteresis module to compare the outside air temperature to the two set
points defined in the module (in this case, these are set at 18 °C and 23 °C). If the outside air temperature is
greater than 23 °C, the H outputis unset (off). If itis less than 18 °C, the H output is set (on).

The strategy is saved and then downloaded to the Field Controller connected to the heating system.

Anakog Input El D Hysteress = Digital Output 5
AI Temperature S ﬂ o DD Heating Enable
Point €2 .]'J S '.31 9 Input Atz H@h@ﬁﬁ Point Ovemd= 0|
L - - - Bt t B B B B Bt B
Ovemide [[ Active Low [0
0 [onlevel: 2.00; OFf level: 4.00 i E
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HOW TO CREATE A STRATEGY

To create a strategy, follow these steps:

e Select Site, BACnet Router, and Field Controller in the Site List and double-click to open its strategy:

site Contraller | Clipboard Strateay Macros Simulation

=-§) Sites
B-Eg BACret P
=52 001 - Network
& 001 - 001 - UCU3213V
Yo
‘Sample Apps BACnet D2 Instance unber 22

Q- 2 Centre - 8.00.00-286 - o
Fle - Home Controler | sty | ®
# Comnect 3| tHconr B 5AChet Points B create o oo QJ (e Bcid iy e @i
Foisconnea | | Fpaste & BaCnet Units BBy Mansger > "N g Configuration | Grid Colour
B /0 Reorder Strategy | View StorfPause Stop Reset
Text Terminals Modules & Strategy Details ~ Help | Macros Ff Save New - L7 Background Catour

Display

Favorites

Constants.

Functions

Math
Schedules, Timers, andL...
Setpoints, Inputs, and 0. ~

»
»
Controls »
»
»
»

Al snalog Input
AO  analog output
(2 analog setpoint

3: BAChet Analog
‘BACnet Analog Priority Array
E: BACnet Binary

‘BACnet Binary Priority Array
DI pigital tnput

DO pigital Output

24 oigital Setpoint

Statistics

VA

Virtuals

Connected to: Sample Apps BACnet (3], Remote - BACnet

-

f———————100% OVR CAP NUM SCRL

If the selected Feld Controller does not already have a strategy, you willm be prompted to cre

Engineering Centre
There is no. ate
Strategy?
—Vs No
Iy

@ s Engineering Centre - 8.00.00-286
File ©  Home  Controller | Strateqy ®
& Connect 3. | CFiconr E f8acnet points [ create foY Q_} 0, Logging B crid ) New Connections
WFoisconnea | & 5acnet units BBy Manager | € Configuration | B Grid Colour
Downlosd Rda U0 Reorcer stoteey i Startpause Stop Reset
Text Terminals Modules T Strategy Details ~Help | Macros [ Save New B [ Background Colour
Controller Clipboard Strategy Macros Simulation Display
Favorites N
Constants.
& 001 - 001 - UCU3213V b
& 001-002- CBM24 Controls »
BACnet Serial Functions »
mple Apps BACnet Math S
Schedules, Timers, and L. »
Setpoints, Inputs, and O... -

=C - |

Al analog mput
AO  analog output
Bmm Analog Setpoint
E: BACnet Analog
‘BACnet Analog Priority Array
E: BACnet Binary
‘BACnet Binary Priority Aray
DI pigital input
DO pigital cutput

21 oigital Setpoint

Statistics

VA

Virtuals

-

Al

Connected to: Sample Apps BAChet (3], Remote - BACnet

ate a new one:

—————— 100% OVR CAP NUM SCRL

Click Ok to open a blank strategy
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e  Select a module from the modules panel

@ = Engineering Centre - 8.00.00-286 - olEl
& connea . hcow g sacoet Foints B crese Quiogong | Byond D} ew Conmections
el B o BB R By 8 Q%o 5.
DO e A i Tok el ot % ey Oetai “Taet | i B Sar e R sy
Cipboara swateny sy Simuitian Oisplay

Fle = Heme  Controber | Srategy o]
SutBruse Stop Reser
5B s x| 3@ soduies s @

Faurtas
Constarts

(@]
=
o
]
'-".
o0Q
(%)
(=g
=
]
—t

Contrls
Functsans
Math

BACH Sarisl
Sample Apps BACnet

IS
&

B

sal8a

Schedules, Timers, andL

ale|v|=|s e[ m

Saonts, inpus, 3nd 0.

Al Irgut

AO ansiog ouout

{20 anog setport
23 sacnet nsiog
et nalog Proey svay
23 sacnet inary

Bagnet

Pty ray
[ Tg——

DO pigtal Output
-

Statises ,
w -
Vil .

Connected u: Sameie hgps B4Cnel B, Remate - BACret Fr———_ . o

e - mms  omarr | swoesr ®
0 ot sy view sumae oo st
a8 - Suategy! box e s O wodules «a

and place it on the drawing area
it B o IE] BEIo R B % %%ios, oo R
Seact A1 nsasatil T Tominals Mosuies T tsteay Detalt by | adseros [ Sav bw E I Bactground Colowr
??g.;;"a.&,‘p :
!

e - Engineering Centre - 80000286 o
 anson Qycontiguntion B G Caloue
ste | Contole Ciobond Stntear Macon Simutaion Onsley
Faamas ,
Constarts ,
|- o001 - ucusenv
L= 01 - 00z oMz R 3
£, BACn Seril Funcions. ,
29 Sample &pps BAChet e -

Schedules, Trners, andl...
Setpoints, nputs, and O
Al anaiog Irput

AOQ ansiog Duiput
(2 anakg sepone

23 acnet anaieg

8ot Analog Prorty ey
23 sacnatmnany
Bacnet Binary Priority Aray

DI oigtal tnput

DO pigral outmat

L bigial Setpoint
Statistcs ,
™ .
Viusas 8

Connected o: Sompe 4pps BAChet 5, Remate - BACnet Fre— —— Y

If the module represents a point you will be prompted to enter a name. Enter one and click Ok .

L Engineering Centre - 8.00.00-286 - g
Fie - Home  Conrober | Stateg (o]
& connea . hcow g B S El B crese Q. o Quiogong | Byond D} ew Conmections
— e Bacnat unes wansgn connguntion B Gaa Coloue
- = Gow | a0 e o ’ Yew B P il 4
L35eket A1 (Mol Tert Temials Moduies %5 Stateay Detais * el | Macygy [ Sare ew 5 7 Basaground Colour
Ste | Contolle Cigpomra swateny sy Simuitian Oisplay
Stelis BE sy Vx| e 3@ Modies @
s-g Sees - =
g Bacne e Favorkes ,
|8 B2 01 e —— :
| e oo oon- wcvszr
| Lo o ooz o Contrals 3
- Fg BACraseim Functions ,
-2 Sample Apps EACnet e <
Sthedules, Tmers,andl_
Setponts, Inputs, 3000w
Paint Name. Al ansiog nput
AO snsiog
pontrane [Fampermtie st

(2) soaog setpont

23 sacnet nsiog
Cof] o

sacoat Anslog Brenty sy

2% sacnetnan

Bacost Binary Pauety Aray

DI oigeal tnput.

DO oigeal utout

L oigral sewaint

Sttstes .

e <

st ,

« s |l >
Setup black updated. Connected to: Sampie App: BACnel B}, Remate - BACnet T [
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Th_e module is now on the dra

Engineering Centre - 800.00-286

Fie = Mome  Commmter | Sumeny
# connect 1. E B B G [Eﬂmm °. g 0 Qoo P cro
il ] O sacner s By varager Gy contigurion B G Colowr
Comioa: View | 0 WO Reoroer sy | view Sonpwse siop Reie
et A |Modules Test Terminals Modules T8 Strategy Details *Heln  Macros Hew =
st comome | cipoaso susteay v smaston
s @ St v x|
& £g BAChe P
S
- 001 - ucuz213v
o1 -co2 - Came

-Bg BACnet Serial
-Bg Semple Apps BACet

Setup black updated

® 001 - 002 oMz
-5z BACet Sesal
-8z Semple Apps BACnet

Conneded ta: Sample Anps BACnet (5, Remate - BACnet

Once a module has been selected, it can then be:

moved
deleted
cut
copied

pasted

by using the mouse to drag the module to its new location;

Analog (1) Tem... oy

) ew Comnedtions

I3 Rackground Colour

Display.
o0 Modules

Favorites

Constants

Controls

Functions

Math

Schedules, Timers, and L
Setpuints, Inputs, and O..

Al analog Input

AO analog output

(2 analng setpoint
29 sacnet anaiog
BAIet Analog Proity Aray
29 sacneteinay
BACnet Binary Privrty Aay.
D1 pigital nput

DO Digal oupie

L' pigital Satpoint
Statistics
vav

vituals

-~ 100% OVR - NUM

To operate on a module, it must be selected, by right- clicking on it,

Al analog input

AO analog Outout

() analog setpoit

29 B0t nalog
BACnat Analog Prionty Aray
e macnet nary

BACnet Binary Prionty Amay

or by dragging a selection box around the module symbol (or symbols)

Controls

Functions

Math

Schedules, Timers, and L.
Setpoints, Inputs, and O
Al analog input

AQ anlog Output

() analog Setpuint
23 sacatanaiog
BACnst Analog Prorty Aay
22 et
BACnst Binary Priorty Aray
DI oigital tnput.

DO pigital output

P it i

by pressing the [DELETE] key on the keyboard;

by pressing [Ctrl] + [x] on the keyboard

by pressing [Ctrl] + [c] on the keyboard

by pressing [Ctrl] + [v] on the keyboard

[0}

(v v v v

PIEaC A

wing area. It can now be moved. deleted. ra(m'ed, or linked to other modules.

Note: Pasted hardware point modules may adapt some parameters to the destination point but retain
others. For example, an analog input configured as PT1000 when pasted to a UniPut™ will change

to a voltage input but retain the max and min limits (in the Advanced button) which for PT1000

could be min @ and max 0, leading to incorrect operation of the UniPut™.
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Place all the required modules on the drawing area and join them

(@]
Place other modules required to implement the strategy on the drawing area. 5
=
Modules must be positioned from left to right on the drawing area. Hardware inputs must go on the left side of E&8
the drawing area, hardware outputs on the right. Between the inputs and the outputs, organize the modules so [
that a signal flows from left to right across the strategy. @,
(0]
q 001_01.532 [ 34 ®

N o= T T T o e

Point ()| | Input | aaive Hih [ 8 Point Ovenide [0

Ee e . .
o o .Clr\ Isve.l: 1:3::.0H Isvé\:4:2)l). _

Join the modules together as required, by placing the mouse pointer over module inputs or outputs

4 001_01.532 24
-~
‘Analog Input Bl o Hyszresis = o ) Digia] Output 5
AI Temperature ﬂ DO Heating Enable
Poirz £ 3 |6 Input | aaive Hih [ 8 Point Ovenide [0
Overrice [ | AcvzLow @
C © " [Onlevel: Z.00; Off level: .00

and dragging to another modules output or input.

‘Anzlog Input 3 o Hyszress s o Digia] Output 5
AI Temperature J DO Heating Enable
Pomt— [Smpe [ Acive High @3 C [ painc Overdz
Overnde [0 o | Actve Low [ C
Gn Fevelt 2.00: OF Evel 4.00

CXpro'® displays lines between linked modules:

‘Anzlog Input 3 o Hyst=ress BN o Digral Output 5
Al Temperature 0 ﬂ : 0 DO Heating Enable
Point €| ) E)] € Inpt [ Acive High ) 5 Point Ouemice 0
Ovenide [0 | Acvelon @
On Jevek 2,00; OFF level: 4,00 :

If you cannot see a line connecting the two modules, right-click on the drawing area and select Display Options >

Display Lines > Show All Lines from the menu that appears

. Display Options 3 . Display Lines 3 . Showlgl Lines
oL Display Labels ’ Hide

Lines

Continue joining modules until all the required connections have been made.

4 001_01.532 X
.................... -
Analog Input 3 Hysteresis 15
Al Temperatura C : J """ Heating Enable
| Paint (3| T 3)3[np..|t | acive High e
[ oem=@ : : [ amelon@m
o : Onlevek 2.00; O levek 200 | © 0 0
L v
< >
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Automatic point selection

When two unconnected modules are linked together, CXpro"® automatically selects the next available virtual
point. This is the lowest numbered unused point. This number is entered in the two modules that are linked, as
an input and an output, and it is also displayed at either end of the connecting line. In the example below, the
number of the virtual point connecting the two modules is 1 and it is displayed at both ends of the connection:

Analog Input = Hysteresis 15

Al Temperature S ﬂ-
Point £ ll.J illl 2 Input Aotz High 0
Ovemide Active Low [T

On level; 2.00; Off level: 4.00

If you cannot see the point number at either end of a connection line, click Module Setup from the Display menu.

right-click on the drawing area and select Display Options > Display Labels > Show Number from the menu that

appears
_1| ..................................
A . Display Options 4 Display Lines ’ l --------------
-1 Display Labels » Hide

P — Shotkl\lumber

N [ Shobiame

N : Show Value Only (simulation)
,:lm . r— 4“\&;“ | I .....

When the output of a module which is already connected is connected to the input of another module, the point
number of this output will be written in the input.
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Selecting a connection line

(@]

To select a line connecting two modules, click the line with the left mouse button. Selected lines are displayed [
with a green hidhligh. Selected lines can then be: U%;
2

moved by using the mouse to drag the line to its new location %

(0)¢]

2

deleted by pressing the [Delete] key on the keyboard °

When a connection line is deleted, the point number in the input of the target module will be removed.

If this connection was the only one for the output of the source module, the point number will be removed from
there too. The point will now be available for other connections.

Naming a point

To give a point a name, select it and then edit the text in the Name property on the Properties pane.

- ¥ | Properties L x |
~ ? |D|g|ta| Output [9] j
= -
Type Digital Output
Service Order 9
Name Heatinl
Synchronised Status Checking...
=
Point Digital (3): false Heating En...
=
Point type Output Digital
Low threshold 101
Hink thrachnld a5 ﬂ
Name
This is the name of the module,
IAI Absohute Value w
When finished, press enter and the name will be displayed on the module in the Drawing Area.
- % | Properties o x |
~ ? |Digital Output [9] |
=] -
Type Digital Qutput
Digital Output ' Service Order 9
Heating Enable MName Heating Enable
Synchronised Status Checking...
=
Point Digital (9): false Heating En...
=
Point type Output Digital
Low threshold m
Hink thrachald as j
Name

This is the name of the module.

IAI Absohute Valse e

The name can have no more than 24 alphanumeric characters. Spaces, commas and full stops may also be used.
Each point in a controller must have a point name that is unique in that controller.
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Assigning a unit to a point

In the case of Analog points, the Units list box (which is displayed in Properties pane) contains a collection of text

strings, one of which will be displayed together with the point value.

To specify a type of unit for a point, select the line that represents it, and select a value from the Unit list.

b x| properties

o

(6 Input

~

= Point Details

Tymerase

==

=3
[On evel: 2.00; OF level:

=]

=g

7|

Number
Type
Value
Name
Unit

Show Line
Labels

Unit
This is the unit of measure for th Sec

Analog (3) Temperature [C]

3

Analog

Temperature

=C
Sy

*Fdays

Vears

If the point is a digital point, select the required unit in the Low Unit and High Unit list boxes. The units of a

digital point are text strings, which are displayed instead of the digital values @ or 1.

[ % | Properties

Heating Enable

(=]

=]

=+ a
2| =l
Point Details Digital (9) Heating Enable [, |
MNurnber 9
Type Digital
Value false
MName Heating Enable
Low Unit
High Unit
Show Line

Labels

If the list does not contain the unit you require, additional application-specific units can be entered manually in
the C:\CXproHD\ (SITENAME) \SYSTEM \site.ini file. For details on how this is done, see Appendix :: Adding
units of measurement to the system on page 209.

Additional units of measurement can also be added if points are defined using the shortcut method (see A short
cut to defining hardware points on page 72). When the tab (or comma) separated list of point definitions is
prepared, units of measurement which are not already defined in C:\CXproHD\ (SITENAME) \SYSTEM
\site.ini can be used. When the definitions are pasted to the Database Interface, the new units of
measurements will be added automatically to site.ini.
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Creating Strategies - Set the values of the module's Constants

(@]
=
Many modules can be configured by setting internal constant values. These are accessible in the Properties pane ﬁ
when the module is selected. For example, the Timer with Constant Inputs module has the following properties: =)
(2]
I % | Properties i x | g’
= Temer win Gonsmne. 2] ™ ? | j uﬁé
2 oy
1 Trigg=r ‘ Output [0 Type Timer with Constant Inputs 2
0 Reset ‘ co'"ple'"e"_'t_a B Service Order 16
[On deley: 10; OF dely: 10; Mini._. - -
— — = . Synchronised Status Disconnected
=
Trigger Digital
Reset Digital
=
On delay 10
Off delay 0
Minimum en time 0
=
Output Digital
Complement Digital
v
> Properties Page Names Modules

Creating Strategies - Add explanatory text if necessary

Text can be added to the drawing area to label parts of the strategy to explain the purpose of certain modules, or
groups of modules, within the strategy,

You can add text or edit text that is already in the strategy drawing. You can also delete, cut or copy text in a
strategy.

For details see How to add text to a strategy on page 59
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HOW TO REORDER BLOCKS IN A STRATEGY

It is possible to change the order of blocks within a Strategy, which can help to optimize the servicing process.

From the Site List , right-click on the controller and select Strategy Operations > Re-Order Module Blocks

e TR

B-2g PL Office

=52 001 - Network

L5, 2
= JE_E SampleAppsEﬁB
=58 0071 - Wet 5

L= -
&, 1112
L& 13-
&, 1114
LB 115
- B, 1116 -
L& 1121
LB, 1122 - Vi

C

=hAnnnn

Copy Strategy To
Strategy operations

Export Aspect Data
Update BACnet EDE Data

3 E'; Reorder Module Blocks

o

TS T T

This opens the Reorder Block dialog:

1]

Highlighted modules are serviced based on time, and not service order.

Reorder Modules

Service Order

L I R

The list shows modules in their Service Order .

Module

1 - Comparator

2 - BACnet Schedule

3 - Absolute Value

4 - Maximum

5 - Analog Gate

6 - Limitto 0 or 100

7 - Rounding

8 - Integer Constant

9 - Real Constant

10 - VAV Differential Pressure
11 - BACnet Schedule

12 - Holiday Schedule

13 - Time Schedule

14 - Comparator

15 - Hysteresis

16 - Timer with Constant Inputs

o]

alaldiall

Cancel

Note: Some modules serviced based on a time schedule, not necessarily according to their Service

Order . Any modules in the list that are in this category will be highlighted.

Select a module in the list and use the buttons on the right-hand side of the dialog to change its position in the

list:

EEEEEE

Move the highlighted block to the top of the list (Service number = 1)
Move the highlighted block up one position in the list

Move the highlighted block down one position in the list

Move the highlighted block to the bottom of the list

Highlight the selected block in the Strategy drawing.

Repeat until the list is in the required order.
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HOW TO UPLOAD SETPOINT VALUES S
(0]
=
It is possible for all of the controller values for all setpoints in a single Strategy to be retrieved in a single operation. 5
—
=
From the Site List , right-click on the controller and select Strategy Operations > Upload Setpoints %
(0)¢]
Site Navigation = 3
E@ Sites
E| East Hall
E‘ 007 - Network Fr 0] Strateqy D 22
: & Open '001_01.532'
: 001 - 004 545
-85 HO Black 2 4 Break I
&35, Local Natwork Eopytateoyi 1T 11
E‘ 2mrUnEE3;ntrUD‘:l Strategy operations Re-Order Module Blocks -
H L. [=] - [
ucsz-oz2 Showr Globals [ssues Report “m |
002 - UCC4net Showe Globals Table Cornpare Strategy To Controller r
[]--- Optimizer
[]... Sample Strategies Update BACnet EDE Data ! I I I I I I I
1 '

This opens the Upload Setpoints dialog:

r ~
Upload Setpoints
Paint Name Address |T pe 4 | Local Controller
a 1 Analog iR} 00o
ad 2 Analog .00 .00
[¥] aB 3 Analog 3no 3no
¥ Select/Unselct Al ‘ Update Selected | | Close: |
Ready

Select the points to be uploaded and click the Update Selected button

NAMING STRATEGY FILES

When saving Strategy files, it is recommended that you use a name which indicates the site, the BACnet Router
number and the Field Controller number.

For example, the strategy for the Air Handling Unit controller, which is Field Controller number 1 on the Rooftop
subnet (which is BACnet Router number 1) on the Office Block site might be named 0Office 001-01 AHU.STG
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HOW TO OPEN AN EXISTING STRATEGY:

A Strategy file can only be opened if it is Associated with a controller.

You can open a contoller’s Associated Strategy in one of the following ways:

1. Double-click on the controller in the Site Tree

Site List

=] @ Sites

Zo BAChet P

Tg BACnet Serial

- Tg PL Office

. OB 001 - Network

I o cived
B-Tg Sample Apps BACnet

-B2 001 - Wet Systems
&=, 1111 - CT Single Pump DPS

0! rln

Site List LY - |
=] 0 Sites
5-Sg BAChet P
2o BACnet Serial
2o PL Office
-2 001 - Network

JI = Oﬁn '001_01.532' Ctrl=0

Break
Copy Strategy To

-

Strateqy operations

Export Aspect Data

Update BACnet EDE Data

", 1123 - VT Single Pump Speed

Select the controller in the Site Tree , and select Open from the File drop-down

File - Home Controller Strategy

[ ew Recent Documents
BLQ%:E” 1001_01.532
™' Swe
[¥) save As 2 CA\CXproHDY.\D0T_03VAV.532
Save All
@ Footers
QI Page Size
QI Printer Scaling
F Print Setup
= Print
(D Licence Details
@ Close
@Dhep (Drvout XK Exit

Right-click on the controller in the Site Tree , and select the filename

1B, 1113 - CT Single Pump Speed

Note: If the strategy for the selected controller is already opened, all of these options will be disabled

(greyed-out).

Note: If you want to open a different strategy file for a controller you must first remove the existing
association, then associate the controller with the required strategy.
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STRATEGY ASSOCIATIONS

What is an "Associated" Strategy?

Each of the Field Controllers in the Site List can have a Strategy Drawing file 'associated' with it, which means that

(@]
=
[0}
[
=
=}
o0Q
(%]
=g
=
Q
=3
o
@,
[0}
%

CXpro*® is aware of the filename of the strategy corresponding to that Field Controller. When a Field Controller is

selected, its associated strategy can be opened by double-clicking, or by selecting from the right-click menu.
The icon representing the field controller changes when Strategy file is associated with it.

The relationships between controllers and strategy filenames for a particular site are stored in the file

C:\CXproHD\ [siteFolderName]\SYSTEM\associations.xml

Note: CBXi controllers at the ‘network’ level can also have Strategies associated with them.

Creating Associations

New strategies

When a new Strategy Drawing is created, a target controller must be selected. When that Strategy is saved for the
first time, it is associated with the selected target controller.

Existing strategies - manual

site List R |

E@ Sites
Bl-To BACnetIP
-Sg BACnet Serial

£1-Z2 001 - Network

i Iy
Zg PL Office Select
Lm0 -1 ne Ctri=N
: s Ea’ o Import Strategy
=] JE_E Sample 4
=2 oot -

A strategy can be associated with a field controller by right-clicking on the Field Controller and selecting "Select".
A list of all existing strategy files that are eligible to be associated with the selected controller will be displayed.
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Breaking Associations

Associations can be broken using a toolbar or right-clicked popup menu option; the link between the Site Tree
Field Controller and the Strategy Drawing is removed.

] Site List

r a8

E@ Sites

@2 BACnet IP

2o BACnet Serial

© -2 001 - Network

... 001 - 001 - UCU3213VAV
o PL Office
B2 001 - Netwark

b Eﬁ,

= Open 001_01.532'

---JE_E Sample App

Bremk

Copy Strategy To
Strategy operations

Export Aspect Data
Update BACnet EDE Data

Ctrl+=0

If an association is broken for an opened Strategy Drawing, then the Strategy Drawing will be closed and the user
will be prompted to save it if changes have been made. Breaking an Association allows the User to associate a

different Strategy Drawing to the Field Controller, using a toolbar or right-click popup menu option on the Site

Tree Field Controller.

Copying associated strategies

From the Site List , it is possible in a single operation to create a copy of the strategy associated with any Field
Controller node and associate that copy with another Field Controller node, as long as the target is of a compatible

controller type and does not already have a strategy associated with it.

Note: A Strategy cannot be copied if it is open and has been modified but not saved (the user is

prompted to save the Strategy so that the Strategy can be copied).

To copy a strategy in the Site List interface:

1. Right-click on the source Field Controller node — i.e. the controller to which the existing strategy is

associated.

5. Inthe pop-up menu, select Copy Strategy To

‘Slte List

+ B

B-§) Sites

S BACnetIp
E1-2g BACnet Serial
B 52 001 - Network
..... & 001 - 001 - UCU3213VAV
E-To PL Office
E-58 001 - Network
..... Elp, o0 R
@-2g Sample Ap P Open 00101532

Break
Copy Strategy To

Strategy operations

Export Aspect Data
Update BACnet EDE Data

Ctrl+0
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In the Copy Strategy dialog that appears, click on the Field Controller to which you want the copied
strategy to be associated

Copy Strategy

Copying Strategy 001_01.532' from
ste  [PLOfrice
Comms Contraller 001 - Network

Field Contraller (001 -001 - CBM24.

To
-1 Sies
&[5 BACnetIP
&L= 001 - Network
O

(@]
=
[0}
[
=
=}
(]
w
=g
=
Q
=3
o
@,
[0}
%

-8 BACnet Seial
-0 001 - Metwark
O 001 - 001 - UCU321 WAY

Copy Cancel

The Copy Strategy dialog displays the source Site, BACnet Router and Field Controller node details as well as the
Strategy that will be copied.

The To box contains a "tree" list of potential target Field Controllers, grouped by Site. Potential target Field
Controllers are those that:

e are of a Controller Type that is compatible with the source Field Controller Node

e do not already have an Associated Strategy

e donot have a newly created Strategy

The next available Field Controller node is always selected on the source Site. If no Field Controllers are available on
the source Site then no Field Controller is selected and the Site Tree is shown collapsed (closed).

The Copy button is enabled when a Field Controller Node is selected. When it is clicked, a new Strategy is created

and opened with the contents of the source Strategy being copied, including the Database names and Keypad
Details. The copied Strategy is then Associated with the Target Field Controller node.

Importing a Strategy

The Copy Strategy To function applies to strategy files that reside in the current Site file structure. It is possible that
files which were associated with a specific folder have been copied to locations outside the Site folders, and will
not be found by the Copy Strategy To process. In that case the Import Strategy function may be used.

To Import a strategy in the Site List interface:

1. Right-click on the target Field Controller node

The target Field Controller is the controller to which the Imported strategy will be associated.

2. Inthe pop-up menu, select Import Strategy .

| ite List L |
=Y Sites

25 BACnetIP

El-2g BACnet Serial

{522 001 - MNetwork

i LB

O-8g pLOfic oot

DE o010 New EHH
=0 ImporStratEQy

---JEE Sample £

The system will scan for suitable strategies for import

MANO133 rev 9 © Cylon Controls Ltd. 113



an04dxD

Import a Strategy

And display a list of the results.

Note:

3.

Import a Strategy

Cancel

It is possible that the list will be blank, because a strategy file will only be listed if:
a. It does not reside in the current site.
b. It has the correct embedded site, BACnet Router address and field controller address.
c. Itis not already associated with any controller.

You cannot for example import a strategy from controller number 006 on BACnet Router 5 on a
remote site onto controller number 805 on BACnet Router 5 on the local site. Neither can you for
example import a strategy from controller number 806 on BACnet Router 5 on a remote site onto
controller number 006 on BACnet Router 2 on the local site.

i.e. The file to be imported must have originated on the same controller on the same site.

Select a strategy file and click OK . The strategy will be copied to the current site, and the copy will be

associated with the selected controller.

OPENING MULTIPLE STRATEGIES

CXpro"'® allows you to have several strategies open at once. Each strategy must be opened individually as described
above. Each strategy can be minimised, maximised and arranged in a number of ways in relation to the other
open strategies.

DOWNLOADING A STRATEGY

When you have created a strategy in CXpro"®, you must download it to the targeted controller before it will
function.

CXpro"'® provides three different ways in which you can download a strategy to a controller:

Using Automatic Download, where CXpro"® automatically wipes the controller's memory and sends set-
up. You only have to download the strategy.

Using Automatic Online Downloading, where CXpro"® automatically downloads a module to the controller
as soon as it is placed on the drawing area. (If the strategy is newly created, you must first wipe the
controller's memory, place and join the modules on the drawing area and send the set-up).

Downloading manually, where you must wipe the controller's memory, send the number of blocks to be
serviced and then download the strategy.
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DOWNLOADING A STRATEGY USING AUTOMATIC DOWNLOAD

To download a strategy to the targeted controller using Automatic Download, proceed as follows:

1. Open the strategy and connect to the controller

(@]
=
[0}
[
=
=}
o0Q
w
=g
=
Q
=3
o
@,
[0}
%

2. Enable Automatic Download

3. Download the strategy

Note: When you download a Strategy to a BACnet controller from CXpro"®, any configuration that has
been set by a separate B-OWS — e.g. an Alarm Recipients list — will be wiped. You must re-

download the Alarm Recipients list, and any other B-OWS specific configuration after the Strategy
download is complete.

Open the strategy and connect to the controller

Select the target controller in the Site List and open its associated Strategy by double-clicking or selecting Open

from the File menu or right-click menu.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

@ -

File = Home Controller Strategy

’ Copnect @ Copy EI Properties Modules E Strategy
ﬁ Dls%nned LEPaste - Na\rlgatlon Macros |:| Reopen
{1 Select All L;s: [ = Page Mames @ Search
Site Clipboard View

Enable Automatic Download

To enable Automatic Download, open the Communications Configuration dialog box by clicking Communications from
the Controller tab of the Ribbon .

1% Controller Strategy
‘ﬁ Cornl}y\‘unications lil Download
4 "E Controller )sj Wipe Contry
% BACnet I'fl“ Auto Cnline

Configuration

Click the Automatic Download check box in the Download Options tab.

Communications Configuration

Download Options l Scan Options ]
[v Autgmatic Download [v Wipe controller

Automatic Download Wipe Defaults
Comman

¥ Wine Strateav

Click OK to close the Communications Configuration dialog.
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Download the strategy

Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Controller Strategy

‘ﬁ Communications Iil D-:wnl-:ukd E’El Com
% Controller )ﬁj Wipe Coritroller Shov
% BAChet 21 Auto Online

Confinuration

When you use Automatic Download, CXpro"® automatically deletes all previous points and strategies from the
controller as these could conflict with the strategy being downloaded. It then downloads the strategy and sends
the set-up (i.e. it informs the controller of the number of blocks it must service in the strategy).

While this is happening, the Downloading window is displayed.

Downloading .

Controller

Hardware Points _ ,T
Strategy Blocks _ W
Analog Setpoint Values _ ,E
pigital setpoint vaiues [ NN AN |-
BACnet Point Config ﬁ'ﬁ

Sending BACnet data via file transfer...

Close I Abort

The progress bar at the top of the downloading window shows the progress of the download, while the status

box (at the bottom of the window) tells which of the three stages in the download process (wiping the memory,
downloading the strategy or sending the set-up) CXpro"® is currently completing.

The Downloading window also includes a Complete box, which displays the number of the block of the strategy,
analog point or digital point that is currently being downloaded. In the above example, the progress bar shows
that the download is 79% complete, the complete box tells us that CXpro"® is downloading block number 251 of
the strategy and the status box tells us that CXpro"® is busy downloading the strategy to the controller.

116

© Cylon Controls Ltd. MANO133 rev 9



DOWNLOADING A STRATEGY USING AUTOMATIC ONLINE DOWNLOADING

Automatic Online Downloading is a feature of CXpro"® which causes any changes you make to a strategy to be sent to
the controller as soon as they are made.
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Warning: Automatic Online Download is not recommended for use on live plant equipment, since
downloading the Strategy in this manner can cause outputs to toggle.

To use this feature, proceed as follows:
Open the strategy and connect to the controller
Enable Automatic Online Downloading
Edit the strategy

To check that the strategy has been correctly downloaded, you can test the strategy. (See Testing a strategy with
Scan Mode on page 128)

Tip:
If you enable both options ( Automatic download and Automatic online downloading ) on the Download

Options tab, CXpro"® will automatically wipe the controller’s memory, download the modules as
soon as they are placed on the drawing area and then automatically send the set-up.

Communications Configuration

Download Options lscan Options |
v Automatic Download [v Wipe controller

Automatic Download Wipe Defaults
Common
¥ Viipe Strategy
¥ Wipe Points
I~ Wipe Time Schedules
I Wipe Hardware Points

BACnet

I~ Wipe BACnet Objects (Excluding Devi
I~ Wipe BACnet Binary Unit Strings
™ Wipe BACnet Device Name

Other
I Wipe Keypad

Iﬁ.ﬂutomatic Online Downloading
v Automatically Send Setup

Field Conttroller will be wiped before download

Corcn

An example of why you would choose both options would be if you wanted to design a basic strategy, download it
and then download any additional modules or changes you make. In that case, you would enable the first option,

i.e. Automatic Download , create the basic strategy and download it by clicking Download in the Controller tab of the
Ribbon . CXpro"® will send the set-up automatically. Then you would enable the second option on the Download
Options tab of the Communication Configuration dialog, Automatic on-line Downloading , so that each time you make a

change to the original strategy or add another module, the changes are downloaded and the set-up is sent
automatically.
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Open the strategy and connect to the controller

Select the target controller in the Site List and open its associated Strategy by double-clicking or selecting Open

from the File menu or right-click menu.

Note: If you want to change the Strategy's target to a controller on a different Site, you must change Site
using CCView or the Configuration program - selecting the controller on the CXpro"® Site List will
not change the site.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

@ -

File - Home Controller Strategy

’ Coged @ Copy EI Properties Modules EE Strategy
ﬁ Disconnect LEPaste Naulgatlon Macros I:‘ Reopen

Site
i _iSelect All List |[[=|Page Names @ Search
Site Clipboard View

Enable Automatic Online Downloading

To enable Automatic Online Downloading, open the Communications Configuration dialog box by clicking
Communications from the Controller tab of the Ribbon .
18 Contraller Strategy
l$Com unications IilD-:nu-'nI-:uad
i % Controller )ﬁ Wipe Contri

% BACnet Iflk Auto Online

Configuration

Click the Automatic Online Download check box in the Download Options tab.

e g e

It Automatic Online Downloading
v Automatically Send Setup

Field Controller will be wiped before download.

ok | cancel |

Click OK to close the Communications Configuration dialog.

Note: By opening a new Strategy you automatically deselect the Automatic Online Downloading command.
Click the Auto Onlin e button on the the Controller tab of the Ribbon to restore the option.

Edit the strategy

Edit the strategy by placing and joining the required modules on the drawing area and editing their values and
units.
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Each time a module is placed on the drawing area, two modules are joined or their values are edited, CXpro"P®
will automatically download the information to the controller.
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HOW TO DOWNLOAD A STRATEGY MANUALLY

To download manually, proceed as follows:

1. Open the strategy and connect to the controller

9. Disable Automatic download and Automatic online downloading
10. Wipe the controller's memory

11. Edit the strategy

12. Download the strategy

13. Send the set-up

To check that the strategy has been correctly downloaded, you can test the strategy. (See Testing a strategy with
Scan Mode on page 128 )

Open the strategy and connect to the controller

Select the target controller in the Site List and open its associated Strategy by double-clicking or selecting Open

from the File menu or right-click menu.

Note: If you want to change the Strategy's target to a controller on a different Site, you must change Site
using CCView or the Configuration program - selecting the controller on the CXpro"® Site List will

not change the site.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

Q :

File = Home Controller Strategy
’ Copnect @ Copy Properties | Modules |Ez| Strategy
h‘ Dis%nned L?jPaste -~ Navigation Macros D Reopen
:‘ List Page Mames @ Search

Site Clipboard View
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Disable Automatic download and Automatic online downloading

(@)

Open the Communications Configuration dialog box by clicking Communications from the Controller tab of the §

. =

Ribbon . o

%)

—

o

18 Controller Strategy 3

‘a Coml:gmi(ations lil Download U%

bt % Controller )‘DWipe Contre @
%, BAcnet £ Auto Online

Configuration

Clear the checkboxes for both Automatic Download and Automatic Online Download check box in the Download

Options tab.

Communications Configuration H

Download Options | Scan Options |

I~ Automatic Download ™ wipe controller
.  Automatic Download Wipe Defaults
r~Comman
¥ wipe Stiategy
¥ “wipe Points

[T Wipe Time Schedules
I~ “Wipe Hardware Points

r~ BACnet

[ ‘Wipe BAChet Objects [Excluding Dev
I “wWipe BAChet Binary Urit Stings
[T ‘Wipe BAChet Device Mame

Cther
’V I~ “Wipe Kevpad

I~ Automatic Online Downloading
F-tutamatically-5end-Setup—

Deselecting "Automatic Download' will reguire you to manually erase the
UC and send the setup

Carce

Click OK to close the Communications Configuration dialog.
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Wipe the controller's memory

Wipe the controller’'s memory by choosing Wipe Controller from the Controller tab on the Ribbon .

e Controller Strategy

%Communications Iil Download @Compare
Iacontmller )BWipe ﬁgntroller @Show Comp
¥ BAChet & Auto Ofline

Configuration (

This opens the Wipe Controller dialog box, allowing you to choose individual parts of the controller memory to be

wiped
Wipe Controller “
[ Clear Strategy [ Clear Schedules
[ Clear Points [ Clear Hardware Point:

[ Clear Modem Strings
[ Clear Keypad

[ Clear BACnet Data BACHet Options.. |
Mumber of datalogs INo change vl

[~ Wipe All

Current Status
’7 Idle

Wipe | Close |

Click Wipe to close the Wipe Controller box.

CXpro"® will display a message to confirm that the controller’s memory has been wiped. Click OK to close the

message box.

122

© Cylon Controls Ltd.

MANO133 rev 9



How to check the controller type to which you are downloading

To find the type of the controller to which you are downloading, open the Strategy Details dialog by clicking on
Strategy Details in the Strategy tab of the Ribbon

r Strategy

@ Copy
LT‘jPaste
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T fgBAcnet Points

B E E
& BACnet Units

View Add 110 Reorder Strategy Viev

Modules| Text Terminals Modulesngsnate%[)ﬂails Help Macr
Clipboard Strategy

Strategy Details

Strategy Blocks |Comrol|er Resources | Points Managerl

Comparator -~
BACnet Schedule
Absolute Value
Maximum
Analog Gate
Limit to 0 or 100
Rounding
Integer Constant
Real Constant
WAV Differential Pressure
BACnet Schedule
Holiday Schedule
Time Schedule
Comparator
Hysterasis
Timer with Canstart Inputs
Not Used
Not Used
Not Used
Not Used
Not Used
Not Used
Mot Used v

Click the Controller tab.

Strategy Details

Strategy Blocks Controller |Rescurces Points Managerl

Controller Type |[CBM24
Number of Modules per Strategy [1024
Number of Datalogs per Strategy (32

Input: Outputs

Universal Inputs Universal Outputs [0

8
Digital Inputs ol Digital Outputs ol
Analog Inputs 0 Analog Outputs [0

Vanable I0 16

In the example shown, the Controller Type box shows that the selected controller is a CBM24 controller.
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Edit the strategy
Edit the strategy by placing and joining the required modules on the drawing area and editing their values and
units.

Download the strategy
When you have completed the strategy, you must then download it.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

==

File - Home Controller Strategy
’ Cc@ed @ Copy Properties | Modules |Ez| Strategy
b” Disconnect LEPasle Navigatiun Ma(ms I:‘ Reopen
e Lis: Page Mames @ Search

Site Clipboard View

Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Controller Strategy

‘&Communications li‘l Download @Compare
IaCmﬂ:mller ’t}Wipe Controller Shaw Compare
%, BACnet 4 Auto Online

Configuration Ope

A warning is displayed

CXproHD

‘Warning: Downloading will wipe the controller and cycle the outputs. '
Continue? / ls

[~ Do not ask me again during current session, Ves | No |

The Downloading window will appear, to display the progress of the download.

*

Downloading

Contraller

Hardware Paints ,ﬁ 16
Strategy Elocks ’ﬁ 500
Analog Setpoint Values _ E
Digital setpoint Vaiues | RGN 54
BACnet Point Config ’ﬁlﬁ

Sending BACnet data via file transfer...

Close | Abort I

When CXpro"P has downloaded all the blocks that you specified, it will automatically close.

Following a manual download, you must “Start” the strategy by sending the setup information to the controller —
see Starting a strategy (sending the Setup) on page 125.
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STARTING A STRATEGY (SENDING THE SETUP)

When the memory of a Field Controller has been wiped and the strategy has been downloaded to it, the Controller
must be told how many blocks are to be serviced. This is called the Setup of the Strategy. Sending Setup is also
referred to as starting the strategy. If you are using Automatic download, CXpro"® sends the Setup automatically
when you download a strategy to the controller. (See Downloading a strategy using Automatic Download on page
115) Otherwise, you must send the Setup as described below.

Select the Controller in the Site Tree , and connect to it by clicking on the Connect button in the Controller tab of

the Ribbon
File - Home Controller Strategy
’ annect %Communications Iil Dow
“ar connect "E Controller )'D Wipe
% BACnet ﬂ Auto
Site Configuration

Open the Controller Configuration dialog by clicking on Controller in the Controller tab of the Ribbon

ne Controller Strategy
"&Communications [ﬁ Download
=3 %Cowoller ¥l wipe Contr

#, BACnet 2 Auto Onlin

Configuration

Controller Configuration

Mumber Of Strategy Blocks To Service EE Send
Last Compaosed Strategy Last Modified Receive

Time |1400:16 — Date [10/08/2018 — Time |1—‘1:C'C':1E- — Date [10/08/2018 —

User ID

User Mame
Drawing Reference

Strategy ID
Min Service Time

Time Synchronisation Wait After

17171

Current Status
Attention ! Error receiving setup.

Close

The number in the Number of Strategy Blocks To Service box, X (which is automatically entered by CXpro"® but can

be changed by the user), activates the first X blocks of the strategy in the Field Controller. This number, X, must be
greater than or equal to the number of the highest numbered block used by the strategy. Otherwise, the parts of
the strategy which occupy blocks with a higher number will not be serviced, and their point values will not be
updated, which may cause the strategy to fail.
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Note: If you cannot see how many blocks you have used in the strategy, open the Strategy Details dialog

by clicking on Strategy Details in the Strategy tab of the Ribbon

r Strategy

{4 copy I E T ¥ BACnet Points Ezl | |E
[F) Paste & BACnet Units

= View | Add 110 Reorder —(Strategy | Viev
L_jselect All | \Modules| Text Terminals Modules Dﬁstrate%Detalls Help Macr

Clipboard Strategy

Strategy Details

Strateqy Blocks | Controller | Resources | Points Manager |

013 Time Schedule ~
014 Comparator

015 Hysierssis

016 _Timer with Constant Inp
017 Not Used

012 Not Used

019 Not Used

020 Not Used

021 Not Used

022 Not Used

023 Not Used

024 Not Used

025 Not Used

026 Not Used

027 Not Used

028 Not Used

029 Not Used

030 Not Used

031 Not Used

032 Not Used

033 Not Used

034 Not Used

035 Not Used e

This lists all of the blocks in the targeted controller. The highest block number that is marked as
used is the number of blocks the controller must service.

The Last Composed section of the Controller Configuration dialog automatically contains the current PC time and
date. If the strategy is uploaded later, this time and date will indicate when the strategy was started.

The User ID parameter allows the application engineer to enter a unique identifying character. If the strategy is
uploaded later, this number will indicate who started the strategy.

In the User Name field the engineer can enter the name of the person that started the strategy and this can be

retrieved from the controller if the strategy is uploaded. A string of up to sixteen characters can be entered in this
field.

In the Drawing Name field the name drawing can be entered. It is recommended that the name of the drawing

containing information relevant to the strategy is stored here. If the setup is uploaded from the controller the
drawing name will be displayed in this field.

The effects of sending the setup
Sending the setup to a controller has the following effects:

e All blocks entered in the Number of blocks to service section will be serviced, even if they are not occupied

by modules. For example, if you entered 100 as the number of modules to be serviced, the first 100
blocks will be serviced by the controller.

e A controller which is sent a setup with blocks to be serviced, but without any strategy, will not send any
output signals and will not read any input signals.
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Note: If a strategy is downloaded after setup is sent, the strategy is serviced immediately. This means the
outputs will receive values from the strategy immediately after downloading. It would be
preferable to download the strategy before sending setup, since untested strategies can cause
problems in devices connected to the outputs if the output values are unstable or incorrect.
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e  Output points of modules which occupy serviced blocks take their values from the module.
e [f the controller is running without a network (stand-alone), the green LED is constantly illuminated.

e If the controller is running on a fieldbus (connected to a BACnet Router), the green LED flashes with
regular pulses.

e Analarm appears on the monitor of the connected PCif the alarm feature is active.

e The keypad program, if one exists and has been downloaded to the controller, will be started.
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TESTING A STRATEGY WITH SCAN MODE

It is important to test a strategy at various stages in its creation, to check for mistakes or faults in its design. This

is done by using Scan mode .

Preparing to test a strategy

To test a strategy the following conditions must be satisfied:
e The strategy must be open (see How to open an existing strategy: on page 110).

e The strategy must have been sent to the controller (See Downloading a strategy on page 114).

Note: Make sure that the downloaded strategy and the open strategy are the same.

e The strategy must have been started (see Starting a strategy on page 125).

How to test a strategy

In Scan mode, CXpro"® allows you to view the changes in values in a strategy as the strategy is serviced in the
controller. This is useful for testing strategies and parts of strategies for correct operation. In Scan mode , the point
values of an uploaded strategy are read by CXpro"?, displayed next to their respective inputs/outputs and updated
in real time.

To activate scan mode:
e Open the strategy and Connect to the controller by clicking the Connect button on the Strategy tab of
the Ribbon
e Display the strategy's point and constant values (page 129)
e Setthe Scan mode (page 129)

e Activate scan mode (page 130)

In scan mode, the variable point values of a strategy are updated in real time as they are serviced by the strategy
and displayed clearly in the module symbols on the drawing area. In the Rescale to 0 or 100 module of the
example above, the values of the 3 input points were changed to 10, 20 and 149.86 and its output was changed
to 100 as they were serviced by the strategy.

e  Watch the changing values of the modules in scan mode to ensure they are being serviced correctly by
the controller.
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How to Display the strategy's point and constant values

Display the point and constant values of the strategy by right-clicking on the Drawing Area and select Display
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Options > Display Labels > Show Value Only (simulation)

. Display Options 4 Display Lines k i

Display Labels 8 Hide

Show Mumber

Show Mame

. Show Valﬁﬁnly (simulation)

Setting the Scan mode

CXpro"'® can scan either the current active strategy or all of the currently open strategies. To set this, open the
Communications Configuration dialog by clicking Communications in the Controller tab of the Ribbon

Contraller Strateg
*ﬁ Communications ¥

% Contraller ’§
%, BACnet L

Configuration

Select the Scan Options tab in the dialog, ans select either the Scan Active Strategy or the Scan all Strategies radio
button.

Communications Configuration

Dowrload Options ~ Scan Eg\ions |

% Scan Active Strategy

" Scan all Strategies

Click OK to close the dialog.
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Activate scan mode

Begin scanning by clicking Scan in the Controller tab in the Ribbon .

g

Controller

Strategy

‘a Communications Iil Download |_—7é| Compare % Version r{ Board Diagnostics | 1 | 1
"3 Controller )ﬁ Wipe Controller Show Compare % Time and Date I'_.'_| Statistics o‘ ®
R 3 . . ] . O Sean | Overridt
% BACnet [ Auto Online Maximums @ Lock and Unlock % Point
Configuration Operations
—

The CXpro"® window will change to the CXpro"® scan mode window, hiding the Site List , displaying the Page

Names pane and disabling all of the Ribbon items except the Scan button

Strategy ©

Testing
% page ames Y- |

Verdying Madue 3

A+ X @ ShowPageNumbers On Drawing
Page Number | Page Hame

There are na items to show in this view.

g
"
=

Conneded ta: PL Office {4, Remote - BACnet. | L 100 HumM

To deactivate scan mode, i.e. to stop scanning the point values of the strategy, click the Scan button

again.

Suggestions for testing strategies

If a number of modules are selected in the strategy when Scan mode is activated, then only those
modules will be scanned.

The module to be tested must have been downloaded to the controller. That is, the Block number of the
module must be within the range of modules which were downloaded to the controller (see
Downloading a strategy on page 114)

A strategy should be tested in small steps during the creation process. Simple faults such as selecting
the wrong module or joining to the wrong inputs and outputs can be difficult to correct in a finished
strategy. There is also the danger that faults can result in other faults appearing in different parts of the
strategy or in other controllers.

At the end of the creation of a strategy, the whole strategy should be tested again. This prevents later
problems and time losses during the setting-up process in site.

The strategy should be checked module by module from left to right, starting with the hardware inputs
and finishing with the hardware outputs.

Individual strategy parts can be functioning correctly themselves but cause problems when connected
to other correctly functioning strategy parts. For example, the direction of analog values may fall in the
range @ % to 100 % or in the range 100 % to @ %. Digital values and their inversion may also cause
confusion.

Test a strategy before copying it or using it in another controller. Otherwise, all copies of the strategy
will also have to be tested.
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e Manually overriding hardware points allows simulation of each environmental situation to which the
strategy would be exposed.
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SECURING CBM DATA

Unlike other BMS controllers, in the CBM Strategy information can be secured against accidental loss or
unauthorised modification by password-protecting the ability to view or edit strategy information and system
information.

How to password-protect a range of blocks in a CBM strategy

To lock a range of blocks in a strategy, select Lock and Unlock from the Controller tab of the Ribbon .

Caontroller Strategy
%Communications Ii"l Download @Compare Eg\u‘ersion "T'\Board Diagnostics r
% Controller ’?}Wipe Controller Show Compare % Time and Date '-1 Statistics :
% BACnet li"l‘ Auto Online Maximums |rg' LOCkEnd Unlock |
Configuration Operations

This opens the Lock and Unlock dialog

Lock and Unlock

Lock
Enter Password |

Unlock

Current Status
Idle

Close

A

Enter a numericial password (note: the Enter Password field will only accept numbers) and click Lock

Lock and Unlock

Lock
Enter Passwaord | *+**

Unlock

Current Status
Idle

A

Close

The Lock Blocks dialog opens. Specify the start and end of the range of blocks that will be protected:

Lock Blocks

Enter Start Block

12 =]
Enter End Block | B 3&
QK | Cancel |

Click OK to close the Lock Blocks dialog

When the lock command has been received by the controller a confirmation message is displayed in the Lock

and Unlock dialog.

All of the strategy blocks within the specified range are now locked, and cannot be accessed until they are
unlocked using the password set above.
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How to access locked strategy blocks

If a range of strategy blocks in a CBM controller have been locked, it is only possible to access, view, and edit
them by first unlocking them, using the password set during the locking process.

To remove password protection from a locked range of strategy blocks, select Lock and Unlock from the

Controller tab of the Ribbon .
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Controller Strategy

%Communications Ii‘l Download @Compare 1%‘u'ersion "T'\Board Diagnostics r

I%Cor‘ltmller ’?}Wipe Contraller Sh-:wC-Jmpare %Time and Date 'ﬂstatistics 1

% BACnet Ii"l* Auto Online Maximums |:.' LockEnd Unlock | .
Configuration Operations

This opens the Lock and Unlock dialog. Enter the required numerical password (set during the locking process)

and click on Unlock .

Lock and Unlock
Lock
Enter Password | =+

Unkock

Close

Current Status
Idle

When the blocks are successfully unlocked in the controller, a message is displayed in the Lock/Unlock dialog.

The strategy blocks are now unprotected, and can be accessed from CXpro"® as normal.
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HOW TO EXPOSE POINTS ON A BACNET SYSTEM

When the Strategy has been configured for a controller that is part of a BACnet Site, the points within the
controller that are to be available to the BACnet system must be specified by selecting BACnet Points from the

Strategy tab of the Ribbon
oller Strategy

oo EHDA B w-G 1
IE| Paste .l BACnet Unlts

L« IR — View Add i) Reorder trategy

[TiSelect Al | podules Text Terminals Modules G Strategy Details Help Ma
er Clipboard Strategy
. A mma mm e

The BACnet Points dialog opens, listing all of the points used in the Strategy:

| BACnet Points Ea

[ Select BACnet Points

BaCnet | Export | Point Name [_Point Addr [ Point Type |
D Room Setting 5 Analog Setpoint
| O MaxHWater 28 Analog Virtual
] Adder/Scaler Block 19 Output 29 Analog Virtual ‘
O WeatherCom Block 8007 Inpu 30 Analog Virtual
D Heating Water Temp 2 Analog Input
D Temperature 3 Analog Input
O Alarm Enable 2 Digital Setpaint
O DigVirt_3 3 Digital Virtual
O Schedule Na. 1(0n) 4 Digital Virtual
O Hysteresis Block 15 Active High 9 Digital Output

 BACnet Point Usage Binary Unit String Usage

- —
|

Maximum BACnet 1224 I Maximum Binary Unit i 32
|

Used BACnet ’T I Used Binary Unit ’3—
|
|
|
|
|
|

Available BACnet 214 Available Binary Unit !29
Export Total ;g

rSetpuint Limits
Max Unexposed Setpoint and BACnet 324 Unexposed 0
Available Setpoints / BACnet Points 314

Resolve Duplicate Point Mames ;

OK i Cancel ; |

Tick the checkbox beside each of the points that are to be exposed, then click on OK .

Note: In BACnet, the point name must be unique. In the Cylon BACnet system they may not be unique,
so some duplicate names may appear in the list. If this is the case, click the Resolve Duplicate Point

Names... button.

This opens the Resolve Duplicate Point Names dialog, where names can be changed.

Note: The BACnet Points dialog also includes columns of checkbox to identify points that should be
included in any export to ASPECT® / INTEGRA™ — see ASPECT® / INTEGRA™ Export on page 206.
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HOW TO VIEW BACNET POINTS FROM A CONTROLLER 3
]
Q
=
=]
You can view BACnet points from a Controller by selecting Upload BACnet Points on the Controller tab on the [&E
=+
Ribbon S
(1]
@,
ne Controller Strategy 8
%Cummuni(atimns ¢4 Download P&Cumpare ‘%Versiun "T'\Buard Diagnostics a1 3 = F&Livﬂug Setup @
c % Controller ﬁ}Wme Controller E Show Compare % Time and Date '-_.'7.| Statistics Q‘ ® T F‘g LiveLog Report d
Scan  Override Llivelog g~ |nterfz
% BACnet ﬁ Auto Online r|:!| Maximums "E' Lock and Unlock Paint q Upload ﬁ[nd Points | gyild
Configuration Operations Testing

This opens the Controller BACnet Points dialog. The points are automatically uploaded so that they can be viewed,
and the dialog shows the progress of the upload and the points that have been uploaded:

Controller BACnet Points El

Uploaded BAChet Points

n Fairt Mamne |F’0intAddr‘ Paint Type | Active Unit | Inactive Uit |

Status
N Uploading BAChet point 41 of 225

N | Close |
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WHY OBJECTS ARE NAMED

Objects in the Cylon system, such as controllers, points, time schedules, datalogs, etc. are given names to make
them more identifiable. For example, it is easier to recognize a datalog named “Water Supply Temperature”
than one named “datalog_1”, which is the default name of the first datalog used inside a controller, automatically
given by the database.

RULES FOR NAMING OBJECTS

When naming an object in the system, the following rules should be remembered:
e Names inside a controller must be unique.
e Names can have a maximum of 24 characters.
e Allalphanumeric characters are permitted, except commas.
e If the name of an object in a controller is changed to a name that already exists in that controller, the
name of the original object will be deleted.

PROCEDURES FOR NAMING OBJECTS

The following list contains some of the objects in the system that can be named:
e Sites
e  Field Controllers and BACnet Routers
e Points (both hardware points and virtual points)
e Datalog and Time Schedule modules

NAMING POINTS

Types of point

There are three main types of point in the Cylon system:
e A hardware point is an input or output of a Field Controller.
e Avirtual point is used to save internal information for a controller.
e A setpoint is a type of virtual point, but its value is constant, whereas the value of a virtual point is
determined by the strategy.

Hardware points, virtual points and setpoints can be either analog or digital.

How to name points

Only hardware and setpoints can be named in CXpro"P. Virtual points are identified by their block numbers. The
procedure for naming or changing the name of a set point is the same as that for a hardware point. A brief
summary of the procedure is presented below. (For a more detailed description of how to name a point, see
Defining hardware points on page 67)

e Open the strategy.

e Select the Point module on the drawing area that is to be named or have its name changed.

e Enter or edit the ntext in the Name field of the properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

The Database Interface module can be used to enter/edit/delete names of hardware points non-graphically.
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Virtual points which are placed in a strategy as digital setpoints or analog setpoints, are points which are
controlled from outside the Field Controller . The name of such a virtual point should indicate how its value is

passed to it. The following table illustrates this:

Setpoint name How set point value is controlled
Controlled by 3rd party block
Controlled by 3rd party block

=z
Q
3
>
0a
o
iy
o)
(o]
—
%

Outair Temperature_LG

Room Temperature_WG
Can be changed via keypad

Can be changed via PC (B-OWS)

Set point_KP
Gain Factor_PC

NAMING FIELD CONTROLLER TIME SCHEDULES

Controller time schedules are saved and serviced just like modules in a controller. Naming Controller time
schedules makes it easy to locate them for editing, either using the PC, CCView or a keypad.

How to name a Field Controller time schedule

The procedure for naming or changing the name of a Controller time schedule is defined below:

e  Open the strategy.
e Select the Point module on the drawing area that is to be named or have its name changed.

e Enter or edit the text in the Name field of the properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

When naming the schedule, it is a good idea to give an indication of the module’s function. For example, if the
module is a time schedule for the heating system of the site, and is set for Monday to Friday only, the module
might be named “Heating Schedule (Mon to Fri)”.
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NAMING DATALOGS

Datalogs are saved and serviced just like modules in a controller. The contents of a Datalog can be viewed and
analysed using the Datalog Manager module. So that they can easily be identified by the Datalog Manager, they
are automatically given the same name as the point that they are logging. They are given this name when the
point is connected to the datalog.In the Reports program datalogs can be configured and archived.

How to name a datalog

Datalogs are automatically named as soon as they are connected to a point:

Open the strategy that contains the datalog.

Dstalg T
N Datalog_1
(69 Anzlog input
: Digts] input
0 Enablz
" [ egtigeer
" |Dataleg mumber: 1; Update
intarval: 900; Link: 0; Datalog
. [Trigger Options: Any Edge; Deha:
1.00; Extended length: 0

Anzlog Input 3 Digits] Output s
Al Temperature : - DO Heating Enable
Point ]y =7 Poin: Ouerice [0
Dvernc= [0 : :

On Jevel: 2.00; OF level: 4,00

Join the datalog to a point by clicking on the point to be logged, and dragging to the Datalog’s input:

Detabg T

N Datalog_1

Analog input

: igit=] it
I Enabl
) Log trigger
" |Datalog number: 1; Update
intzrval: 500; Link: &; Damslog
. |Trigger Options: Any Edge; Defa:

1.00; Extended langth: 0

Heating Enable

On Jevel: 2.00; OF level 4.00

The name of the Datalog is changed to the name of the point, and displayed in the Datalog module in the strategy.

Detabg =]
IV rempersturen
& Analog input
BT Digital inpu
[ Enab=
' Log trigger
Datalog number: 1; Update
- [intzrval 500; Link: 0; Damzlog
. |Trigger Options: Any Edge; Deka

1.00; Bxtended length: 0

‘Anzlg Input 3 Hysteress =) Digial Output g
Al Temperature - DO Heating Enable
Pont Qpay————"""""T7]
Overid=

On Jevel: 2.00; OF level: 4.00

If you want to modify the name that is automatically given, you can edit itby selecting the datalog module and
editing the Name field in the Properties pane.

It is a good idea to give an indication in the name of what part of the site the datalog belongs to, but it is not
necessary to indicate in the name that the module is a datalog, as it will only appear in list boxes allowing the
selection of a datalog. Names given to speed up the copying of strategies (for example, “Temp. Channel 17,
“Temp. Channel 2”, “Temp. Channel 3”,...), and which save time for creating dynamic graphics, are not helpful
for the end user.

Choose Save from the File menu to save the changes made to the strategy.
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MACROS - OVERVIEW

If your work in CXpro*"® involves creating the same or similar strategies repeatedly, you’ll find Macros useful for

reducing the time involved in these tasks. A Macro is a set of strategy modules grouped together into a single unit.
Macros and Macro Templates
A Macro Template is used to create a macro within a strategy. It is a definition of module types and connections,
and when it is inserted into a strategy a new Macro is created containing new instances of those module types
connected together to match the Macro Template.
e Each time a Macro Template is inserted into a strategy, a new Macro is created.
e Each Macro is an instance of a Macro Template, but a strategy can contain multiple Macros that are based
on a single Macro Template.
e  Macro Templates can be stored, and copied between strategies and controllers.
e  Each Macro can be configured and adjusted independently of the Macro Template used to create it.
e When a Macro Template is saved, it is assigned to a floating toolbar, so that it is as convenient to use as
any Engineering Centre module.
Example: An “Adder” macro.
An Adder/Scaler module accepts four inputs 2, B, C and D, and operates according to the equation
Output = A*C + B*D
It can be made into an Adder, which operates according to the equation
Output = C + D
by ensuring that its A and B inputs are always set to 1. This can be done by connecting a Real
Constant module to the A and B inputs as shown below.
R RealGonstant =] + AoderfScaler E
Y o
Output A B3|z 7| Inpur A Output &
Output B o) feme{ £ [t B
Constant A: 1.00; Constant B: 1.0 |~ ~ ° |[@ Inpie C
T B
This combination of modules can be saved as a Macro Template and reused whenever an adder is
required.
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MACRO STRUCTURE

Macro Templates are stored in CXpro"P in groups and sub-groups. A maximum of 10 Macro groups can be created.
Each Macro group can contain 20 sub-groups and each sub-group can contain up to 100 Macro Templates. In total,
20 000 Macro Templates can be created and stored in CXpro*®.

c
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7]

For example, you may want to store all Macro Templates relating to heat control strategies in a group called Heat.
This group may contain a sub-group called Boiler, which would contain Macros for boiler control strategies, such
as Optimizer, Heating Curve, etc.

MACRO DESCRIPTION (HELP) FILES

A Macro Description File is a Help file generated by the person who created the Macro Template, and is associated
with the Macro Template (it is opened by right-clicking on the Macro button). It is normally used to describe the
function and usage of the Macro Template.

When a user right-clicks on a Macro button on the floating Macro bar CXpro"® opens the editable description file
associated with that specific Macro Template. If none exists, CXpro"® opens a blank text file, which when saved will
be associated with that Macro Template. This file can be used to provide documentation about how the Macro
should be used or to record history, author or changelog details for the Macro Template.

The program used by CXpro"? to open the history file, e.g., MS Wordpad, must be specified in the
C:\CXproHD\System\wn3000.ini file under uClé6et.
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HOW TO CREATE A MACRO TEMPLATE

There are a number of steps involved in creating a Macro Template:

Create the strategy.

Add modules to the Macro Template.

Select the inputs and outputs for the Macro Template, and change their names if required.
Set names for each of the points within the Macro Template if required.

Choose a Macro group and sub-group, and give the Macro Template a name.

Choose whether to insert the Macro Template into the active strategy as a Macro.

Save the Macro Template.

N o Uk W e

The following guide to creating a Macro uses as an example a typical strategy that you might want to save as a
Macro — a “weather compensator” strategy. As an exercise in creating Macros, you may want to follow this guide,
using the weather compensator as an example.

Create the strategy

Create the strategy or part of a strategy on which you are basing your Macro Template. (If you are forming your
Macro Template from an existing strategy, then open that existing strategy).

Example — Weather Compensator macro

For example, if you were to create a Macro Template from a weather compensator strategy, you
would place two Real Constant modules and two Rescale to 0 and 100 modules on the drawing
area and join them as shown below:

The third input of the first Rescale module ( Rescale to 0 and 100 ) is to be the input of the Macro. It
is marked Outside Air Temperature in the diagram below.

The output of the 2" Rescale module ( Rescale from 0 to 100 ) is to be the output of the Macro. It is
marked Flow Temperature Setpoint in the diagram below.

: __Weather Cum ensator
0 ... 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 ... 80 °C

A=B0, B=20 o
R Real Constant = 100 B Rescale from 0 1o 100 21
A=20, B=80 N A I T )
R Real Constant 7 Output A g 7| Lower Limit A Outpart £ Flow
Y o Outpatt B € 7] Uppar Limit B _Temperature
mp__n,q@.n. [Constant A: 80.00; Constane B: 2. =€ Input Setpolnt
Output B ] (FTS)
Gonstant A 20.00; Consant B: 2. " [F 10 Resaewland100 = R
1T €3 Lowveer Limit A Output 3 |
T €3 Upper Limit B
_Dutsu:le Alr Temperature (DAT) € Input

Rescales input temperature
sothat 0 ... 20 °C becomes 0 ... 100
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Select the modules for the macro

The next stage in creating a Macro is to select on the drawing area the modules and any text that you want to be
included in the Macro. Selected modules are marked by red squares around their edges.

To select the modules for the Macro, you can drag the mouse from the top left-hand corner to the bottom right-
hand corner of the strategy to draw a box around the entire strategy so that each module and its inputs and
outputs is selected. It is not a problem if, when drawing the box, you included some unwanted modules — they
can be easily removed at the next stage.
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7]

‘Weather Cum ensator
0 20 °C Outjlde Alr Temperature is mapped to a Flow Temperature Setpomt of 20 0 °C

A=80, B=20 o
R Real Constant = m/u Rescle from 00 100 =2
A=20, B=80 o N T o
R Rzl Corstant 2 Outpm\Ga aQLcmsrLi'nitA Output £ Flow
Y o Output B ) pr———7|@ Upper Limit B Temperature
mp_,t,q@ﬁ. Constant A: 80.00; Constant B: 2.. {3 Input SBtPOII'It
Output B € fro (FTS)
Gonstant A: 20.00; Constan: B: 2. " [T 10 Resckto0and100 2 C
=TT & Lower Limit A Outpat &
77| Upper Limit B
Outslde Air Temperature (DAT) S Input
| |np||+ p s
sothat0..20°Cbecomes0..200

. Weather Cumpensatur . .
ﬂ 2[] °C Out5|de Alr Temperature is mapped to a Flow Temperature Setpmnt of 2[] SD_“C_

Real Constant =] 90U Rescalefrom Do 100 21
A - H . . . . . . . [ A .
R Real Constant = Output A € € Lower Limit A Output Flow
Ay Output B € € Upper Limit B Temperature

owrol  lemmaneesr]  mows setpoint
WP“&‘q_. . - T

(Gonstant A: 20.00; Con B 100 RescaletoQand 100 20

L) a
:[ 9 Lower Limit A Output 3 e
T £ Uppsr Limit B

‘Dutside Air Temperature (OAT)[& e | )
Rescales input temperature
5o that 0 ... 20 °C becomes 0 ... 100

MANO0133 rev 9 © Cylon Controls Ltd. 145



Add the selected modules to the Macro Template

Select Create from the Macro section of the Strategy tab on the Ribbon .

er Strategy

Q £ copy E = BACnet Points E Rose | %

8 Lﬁpaste .l= BACnet Units Marager ’
T — View Add [l{e] Reorder  Strategy View = Start/Paus
5] UiSelect Al | Madules Text Terminals Modules 1o Strategy Details Help Macros | [ Save New

Clipboard Strategy Macros

This will open the Add Modules to Macro dialog box, in which all of the modules that you selected for the Macro
Template will be listed.

Add Modules to Macro

Modules Selected for Modules Added to
020 Rescale to 0 and 100 -
021 Rescale from 0 to 100 -
022 Real Constant

023 Real Canstant s
1025 OQutside Air Temperature (OA

1026 A=20, B=80 <
1027 A=80, B=20

MOTE: Hardware modules can not be pes— = \
added to Macros. ontinue... ancel |

Note: A Macro cannot include hardware points, so if any were included in the selection they will not be
listed in the Add Modules to Macro dialog.

Note: If you click the macro button or macro menu without first selecting the modules for the macro,
you will be prompted to do so with the following error message:

Cylon Engineering Centre

1, Plesse select the modules for the macro

Select the modules in the left list box that you want to include in the Macro by holding down the [Ctrl] key and
clicking each one with the left mouse button. The selected modules will be highlighted.

Add Modules to Macro

Modules Selected for Modules Added to

020 Rescale to 0 and 100
021 Rescale from 0 to 100

022 Real Constant
023 Real Constant
1025 Outside Air Temperature [O&

1026 A=20, B=80 < |
1027 A=380, B=20

MOTE: Hardware modules can not be Continue Cancel
added to Macros,
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Note: For illustration, only the functional modules have been selected in this example. It is also
possible to include text in a Macro Template for clarity.

C
%)
=
oQ
=
Add the selected modules to the Macro Template using the following buttons: g
(%]
s Add a selected module or several selected modules to the Macro Template
B Add all modules to the Macro Template
‘ Remove a selected module or several selected modules from the Macro Template
{2 Remove all modules to the Macro Template

This Add Modules to Macro list box displays all the modules that have been added to the Macro Template. If you add

a module or modules that you later decide you do not want, you can remove that module or modules from the
Macro Template using the remove buttons (see above).

Add Modules to Macro

Modules Selected for

020 Rescale to 0 and 100
021 Rescale from 0 to 100

022 Real Constant
023 Real Constant
1025 OQutside Air Temperature ([OA&
1026 A=20, B=80
1027 A=80,B=20

MOTE: Hardware modules can not be
added to Macros.

Modules Added to

020 Rescale to 0and 100
021 Rescale from 0 to 100
022 Real Constant
023 Real Constant

Continue... | Cancel I

In this example, all 4 modules of the weather compensator strategy are required for the Macro Template and so
they are added to the list box on the right. The text has been excluded in this case, but could be included for

extra information.

Click Continue... when you have added the required modules to the Macro Template.
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Define the Macro Inputs, Outputs, Group and Name (the Create Macro dialog box)

Pressing Continue in the Add Modules to Macro dialog will open the Create Macro dialog box:

Create Macro

L
A
R Rezl Constant = 100 U Rescale from 000100 2
o )
R Real Constant Oupt AR g 7|© LowerLimz A Output
~ MMB\Sg' e T e I
NM-“@ﬁ" C emmEm et e |
omaE Sl L - . — . T 1 1
Constant A: 0.00; Constant B: 0.00 C O [F W0 ResmRw0and 100 T e T
N I = | L
TT{E Lewer Limt A Output (3}
usumzerL'm'llB
........... S e
. ... ... ... .. ... . .. .. L &
£ >
—Macro Inputs/Outputs —Macro Grouping
Inputs Cutputs
Change Mame Change Name gans
I Group |Cylon Macros VI
Change | Change | Sub Group |BACnet b
Macro Manager... |
Macro Point Configuration | ™ Insert into strategy on save Save | Cancel |

The Create Macro dialog shows the four modules that were added in the Add Modules to Macro box, and allows you

to edit input and output names, create Macro groups and sub-groups and create a history file to record any
changes that may be made to the Macro Template later.
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Define the inputs and outputs for the macro

This step refers to the Weather Compensator example (see page 144).

c
When you click on a module output, or an unconnected module input in the drawing area of the Create Macro |5
o
dialog, it is highlighted on the drawing area, and added to the relevant Macro Inputs or Macro Outputs list at the =
. ()
bottom of the dialog. 3
w
Create Macro Create Macro
R Rzal Constant Bl 199 & Resczle from Do 100 21 R Real Constant Bl 100 & Resczle from 0w 100 21
A b4 . A WL
R Real Gonstant = Dot A G| [© Lower time ] Oupr R Real Consmamt 3 Oupt A € Lower Limit A OQutpr ] &
~ | [ oumssg S Upper L 8| N o }ma — Bmppg.uma} =
Output A Q)| . Cnrs'atle'D-M:C_nrsfamE:ﬁ_M_ o (€ Input | . ompma@.n.' " [Constant A: 0.00; Gonstant B: 0.00 c [ Tnpur ‘
Output B Q| Out B O o
|Gongtant A 0.00; Constant B: 0.00 l!/‘ﬂﬂ Resczle to 0and 100 20 CovsutﬁAt-D‘D):CorsYam.B:-D‘D) L 190 Resealew 0and 100 20
s
——77{Q Lomer Limit 4] Oupt G
Upper Limit B
e
(. <
Mactro Inputs/Outputs Macro Grouping Macro Inputs/Outputs Macro Grouping
Inputs Outputs Inputs Outputs
003 Uppe Change Name Change Name - ooz Upee Change Name 004 Inpu Change Name &
I Gro r— r G
Change Change Sub Gro Change Change Sub Gre
Macro Paint Configuration [” Insert into strategy on save Macro Paint Configuration I Insert into strategy on save

Note: If you click on a connected input, an error message will be displayed: “Cannot select a module
input that is already connected to a line.”

Note: The number beside each module input is the Node number, and does not relate to the module
number.

Note: The default name for node 3 in the illustration is “Inpu”, but this can be edited - see Change
input or output label if necessary on page 150.

To remove an input or output that has been added to the Macro Template, click on it in the drawing area. The
input/output will then no longer be highlighted in the drawing area, and it will be removed from the relevant

Macro Inputs or Macro Outputs list.

You can rearrange the order of the inputs or outputs to the Macro, by double-clicking on an entry in the relevant
Macro Inputs or Macro Outputs list, and dragging it up or down within the list.
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Change input or output label if necessary

By default, the text that will be displayed on the Macro module as a label for each input will be “Inpu” and for

each output will be “Outp”:

O
- test

© Inpu | oup &

but these names can easily be edited.

To edit a Macro input or output name, select
the input/output in the relevant list box

Type a new name in the relevant Name edit

box, and click Change .

An input or output label can have no more
than 4 alphanumeric characters.

Input M ame:

Change

£

|t M ame:
0AT|

Change

i

003 0aT

Input Mame:

i
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Name and group the Macro

In order to use a Macro Template that you have created, you must give the Macro Template a name, and assign it to
a Macro group so that it can be accessed from the Macro bar .

e Macro Name

c
2.
>
oQ
<
()
[}
=
[}
7]

In the Macro Name box, enter a name for the Macro Template.

The name provided here will appear on the Macro instance when it is displayed on the drawing area. It can have
no more than 10 alphanumeric characters.

In this example, the name given to the Macro Blacialeteuning

Template is “WeatherCom”.
Name WeatherCom|
Group |Cylon Macros -
Sub Group |BACnet i

Macro Manager...

Note: The following names cannot be used when naming a macro, because they are used to indicate
Inputs, Outputs, constants etc. internally within CXpro*®:

pi (n) where n=anumeric value in the range 0-9
po (n) where n=anumeric value in the range 0-9
sb

c (n) wheren=anumericvalue in the range 0-9

bc

When the Macro Template is named, choose a Macro group and sub-group for it

e Macro Group and Sub-Group

Macro Grouping

From the Group box, select the group to which the

Macro you are creating will belong. Name |WeatherCom

The Macro Group chosen for this example is heating. Group |Cylon Macres ¥
: Cylon Macros

If no Macro Group exists, you must create a new group Heating X

(see How to create a new macro group and sub-group Macro Manager..

on page 154 ) by clicking the Macro Manager... button.

Macro Grouping

From the Sub Groups box, select the sub-group to

which the Macro Template you are creating will belong. Name [WeatherCom

The sub-group chosen for this example is Boiler. Group |Heating -
. Sub Group |Boiler -

If no sub-group exists, you must (see How to create a Boiler

new macro group and sub-group on page 154 ) by e ME”EQEF!

clicking the Macro Manager... button.
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Set names for all of the points in the Macro

When creating a Macro Template, there is a facility to
edit the names of all of the points in the Macro in a

single interface. A Macro Point Configuration button is
Macro Point Configuration

available on the Create Macro dialog:

Clicking the Macro Point Configuration button opens Macro Point Configuration
Macro Details

Name [Weathercom

Group [Gyion Maos
Subgroup [BACnet

the Macro Point Configuration dialog:

1 Analog
12 Analog

Simply enter text in the Name column against each [ Tane ‘;Tf“. Value SR [y
nalog o
. . 9 Analog *C
point, and click the OK button. 10 Anzlog <
*C

Note: If the modules selected when
creating the Macro included any
Setpoints, it is possible to set labels
for specific setpoint values

Note: This is different from setting the Input and Output names (labels) as described in Change input or
output label if necessary on page 150. Those input and output names are labels displayed on the
Macro module, the point names set here are the descriptive names stored for each of the points
in the Strategy.

Choose whether to insert the macro into the active strategy

The Insert into Strategy checkbox allows you to

immediately insert a new Macro based on this Macro
Template into the active strategy. Iﬁmsm into strategy on save 52

If you want to insert the Macro into the active
strategy, select this option before saving the Macro
Template.

Save the Macro Template

Ve Sa{ue Cancel

To save the Macro Template, click the Save button.
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The Macro Template is saved to the C:\CXproHD\Macros\ directory if it was created in a UCU or UC16 strategy, or
in the C:\CXproHD\UC32Macros\ directory if it was created in a CBM or CBT strategy. The group and subgroup
information is stored in the macro_database.db file in the same directory.

If you decide not to save the Macro Template, click the Cancel button to close the Create Macro dialog box without
saving.
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When you save the Macro Template, an entry is added to the Macro pane:

Macros

Macros
M- Legacy Macros
-] Cylon Macros
EB Heating
E-F= Boiler
L..[@ WeatherCom

The Macro symbol is the bitmap that represents the Macro on the drawing area. (See Working with Macros on
page 162).

[ . WeatherCom
3 OAT | Dmnd €3
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HOW TO CREATE A NEW MACRO GROUP AND SUB-GROUP

Macro Groups and Sub-Groups are defined in the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

E ol W BACnet Points E
4} 5Acnet Units

Strategy

ﬁCDpy
LﬁPaste

lﬂ Create .‘
Ma r]%; er

Add o] Reorder - Strategy | | View | _ Start
Text Terminals Modules & Strategy Details Help Macros| [ Save Hew
Clipboard Strategy Macros
or by clicking the Macro Manager... button on the Create Macro dialog
—Macro Grouping
Mame I
Group IConn Macros vl
Sub Group IBACnet 'l
Macra ManaEer... |
. .
This opens the Macro Manager window Eohon
B iacros) Groups [ Add
0 o =i
Rename
Export Exit
To add a group, click the Add button EEDEEE =
m Groups | Aaq
H H H Legacy Macros
while the Macros root is selected in the DR vt (e et
explorer pane (left hand side of the [ |
window)
Evort
A new group appears in the Right-hand Macro Manager
. i Macros roups
side Group pane. B Tcr— e ' e
[0 cylon Macros [ cylon Macras Delete
[ Heating E% =

Type in a name for the new group.

Export Exit
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To make a sub group in the new group, first make groups visible by clicking on the + sign to the left of the

Macros root.

Click on the group under which

you want to make a sub group.

Click on the Add button.

A new sub group appears in the
right-hand " Sub groups " pane.

Type in a name for the sub group.

You can view the subgroups under
a group by clicking on the " +"
sign to the left of the group in the
left-hand explorer pane .

Macro Manager “
BT Macros Sub Groups I Add
&[] Legacy Macros
&[] Cylon Macros Delete
=
Rename
Export Exit
Macro Manager n
=+ Macros Sub Groups | Add
{7 Legacy Macros [T Boled |
[ cylon Macras Delete
-] Heating
Rename
Export Exit
Macro Manager “
=1y Macros Sub Groups [ Add
] Legaey Macras Boiler
@] Cylon Macras Delete
%E;m
[ Boiler ﬂl
Export Exit

To close the Macro Manager , click Exit .

When a new Macro group is created, it will be listed under Macros in the View menu. When a new sub-group is
created, anicon is also created for that sub-group and displayed in the Macro sub-group bar.
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HOW TO RENAME POINTS IN A MACRO TEMPLATE

Points can be renamed from the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
@ Copy E AR f BACnet Points E [ Create .‘
Lﬁ Paste '.l= BACnet Units Manager
- View | Add o Reorder _ Strategy | | View | _ r% Start
[Tiselect Al | |Modules| Text Terminals Modules o Strategy Details Help Macros| [ Save Hew
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

Mame

Group | Cylon Macros =~
Sub Group |BACHet ~

Macra ManaEer...

Clicking on a Macro Template in the left-hand-side Macro Manager =
. . @ Macros ropes ame. e mpol

‘Tree view’ pane of the Macro Manager displays | | B i e~ - = e |
. . X & g“;‘\’s:i“ Macro ID {DBFI0DE3-TAB4-4531-B... BEER
properties of the Macro Template in the right-hand B Reating User Coatey[True — Rename
58 Boiler pg:t 14 A::lzz Edit Points

pane. & IEET pait 15 nsiog [mmn]

Faint 16 Analog
Point 17 Analog

The Macro Name , Macro ID , User Created flag, and the
list of point names are displayed.

If point names have already been defined, then an

Export Exit
Edit Point Names button will be displayed on the right-
hand side of the dialog.
If there is no point names list, then a Create Point Were (el SEing e
Names button will be displayed instead. MND;‘m
o ) ) Group [Heating
Clicking either button will open the Macro Point Name subgroup [Bailer
Prefix dialog, allowing point names to be edited for T [ T T
. 13 Analog *C
the current instance. 14 Analog <
2 e <
17 Analog *C
However, if this dialog is opened from the Macro
Manager as shown here instead of from the Create
Macro dialog, then when OK is clicked the Macro
Template is changed and any Macro instances created
afterwards will use the updated point names list.
cancel
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HOW TO SET MACRO SETPOINT UNIT LABELS

C
(%]
In the Macro Point Configuration dialog, it is possible to set labels for specific setpoint values, so that a user can for &g
example select “Night” and “Day” for a digital setpoint, or “off”, “on”, “trip” and “switch” for an analog point, §
without the need to know which numerical value matches each function. g
To set an enumerated list for a setpoint, right-click on the setpoint Winee (e CanfTgueiet
. . . . . [ Macro Details ————
in the Macro Point Configuration dialog, and select Add/Edit e [ —
Enumerates . Group [Gion Macras
Subgroup W
[ mum... [ Name [ Type [value © [ HighU. [Lowl~A
. . . . . 4 ClgRange Analog Setpoint 40,00 %
Note: This option is only available for setpoints. E—— —
13 HtgWarmUpPos po SEL 3
Note: This option will not be available when a Macro is 15| HioFrost) gFos snstogsetpont 10000 %
being added to a strategy, or when a Macro S Gomodsor  Amlgatpomt 000 %
. . . . . . . 14 FreeWwarmUpPos Analog Setpoint  0.00 %
instance is being edited within a strategy — in o T -
51 ClgWarmUpFos Analog Setpoint  0.00 %
those cases, when the Macro Point Configuration 1 Ansiog <
19 Analog “C
dialog opens the user will be allowed only to ® hnsiog <
. . . 22 Analo *C
select from an existing enumerated list, or to type = i:ilig <
26 Analog C @
a value. - : .
Za
This will open the Setpoint Enumerates dialog. Setpoint Enumerates

Value Description ‘ Drelete |

Enter a Value and Description pair, and click the Add button.The
Value/Description pair will be added to the list.

If an entry is made in error it can be removed from the list by Va5 vesaptofor " asay_|
selecting it and clicking the Delete button.
oK | Cancel |

When the list is complete, click OK to close the Setpoint Setpoint Enumerates
Enumerates dlalog Value Description | Delete

o Off

1 on

2 Trip

Value | 3 Descriptwmm Add

Cancel
R
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Macro Point Configuration

Now, when editing the setpoint, the user can select the

required value from a drop-down list. - Maco Detais
Name [HtgFreeClg
Group | cylon Macros
Subgroup | BACnet

an04dxD

[hum... [ Name [ Type [value 1 [ HighU.. [Low!A
4 ClgRange Analog Setpoint 40,00 %
33 HtgRange Analog Setpoint 20,00 %
g N
7 HtgFrostStatFos Analog Setpoint %
13 HtgWarmUpPos Analog Setpoint %
% HitgFrost1_2Pos Analog Setpoint %
5 DamperhinPos Analog Setpoint %
8 FreeFrostStatPos Analog Setpoint %
9 ClgFroststatPas Analog Setpoint %
14 FreeWarmUpPos Analog Setpoint 5
a7 FreeFrosti_2Ros Analog Setpoint %
a8 ClgFrostl_2Pos Analog Setpoint %
51 ClgWarmUpPos Analog Setpoint %
6 Analog *
17 Analog o
15 Analog °c
20 Analog “
2 Analog *
2 Analog o
B Analog s
2 Analog *
26 Analo N
b P s v
< >

Macro Point Configuration

The setpoint value is displayed in the list with the text

description Mcobetais
Name [ HtgFreeClg
Group | Cylon Macros
subgroup [BACnet
[ Type [vaue © [HighU.. [Lowia
4 ClgRange Analog Setpaint  40.00 %
33 HtgRange Analog Setpoint 4000 %
g .
7 HtgFroststatPos Analog Setpoint  100.00 %
13 HtgWarmUpPos Analog Setpoint  100.00 %
6 HigFrosti_2Pos Analog Setpaint  100.00 %
5 DamperMinPos Analog Setpaint 1000 %
s FrecFrostStatPos Analog Setpaint 000 %
9 ClgFroststatPos Analog Setpoint  0.00 %
14 FreeWarmUpPos Analog Setpaint 000 %
47 FreeFrost1_2Pos Analog Setpoint  0.00 %
48 ClgFrost1_2Pos Analog Setpaint 000 %
51 ClgWarmUpPos Analog Setpoint  0.00 %
16 Analog =C
17 Analog <
19 Analog c
20 Analog <
21 Analog ks
22 Analog =C
23 Analog <
25 Analog c
2% Analog < "
e Anston -
< >

The enumerated list is saved with the Macro template, and will be available in all instances of the Macro created

afterwards.
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HOW TO TRANSFER MACROS FROM ONE COMPUTER TO ANOTHER

It is possible to use Macro Templates created on one PC on a different PC. They must be exported from the PC on
which they are created, and added to the 'host' PC system (i.e. the PC on which they will be used) as follows:

c
2.
>
oQ
<
()
[}
=
[}
7]

Export macros from the PC on which they were created

Exporting Macro Templates as follows puts each Macro Template in a separate file with a user-identifiable name, so
that they can be easily identified and moved to the 'host' PC system.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
Copy AR f BACnet Points [ Create
S [H(T B B @uee + {
Lﬂ Paste '.l= BACnet Units Manager
f— View | Add 1o Reorder _ Strategy | | View | _ r% Start
[TiSelect All | |Modules Text Terminals Modules 1 Strategy Details Help Macros| [ Save Hew
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

MName

Group |Cylon Macros hil
Sub Group |BACnet 7

Macro ManaEer...

) Macro M
Select the Macro group that contains el aneasr
. -Ffy Macros A acros A mpol
the Macro Templates you wish to B L ey s = ! L |
t ¥l pamping
B[ Gylon Macros 1M enthoie Delete
eXpOft, e R 16 Frosti_3
Eat':“;:fg [ HtgFCigriD m
o | ree
select all of the Macro Templates - Frost 3 D neecs
o . HtgFCIgPID @ Meter
within that group that you wish to T rhomeecs 08 ormest
Meter Optimizer
export, H onmeset R
E Optimizer os Zeniltrrl\mg
. Reset eqltrl
and click the Export button. - Senaimlog [ seamodule
[ SeqCtrl 1 spiant
R Seabadnls A [T A
Select Folder ﬂ

A Select Folder dialog will open.
Select the location into which the

selected Macros will be saved. T Docorens 3
> @ Down s

F W Music

> | =] Pictures
= | H Videos
A, 05(C)

Current Selection

Folder: | Documents

Make Mew Folder Cancel
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Add exported Macros to the host PC system

Once all required Macros have been exported, copy them onto the PC on which they will be used.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
ﬁc-:upy AR f BACnet Points E
[ Paste 4} 5Acnet Units
View Add (e} Rearder _ Strategy
elect All | Modules Text Terminals Modules b Strategy Details Help
Clipboard Strategy

I [ Create
Manager
View r%

Macros| [ Save ew

Macros

LS

Start

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

Mame

Group | Cylon Macros =~
Sub Group |BACnet ~

Macra ManaEer...

Select the group and subgroup into which you wish
to import Macro Templates,

and click on the Import button.

In the standard Windows Open dialog. Multiple

files can be selected by holding the [CTRL] key while
clicking on each file.

Select the Macro Templates you wish to add, and
click the Open button.

The selected Macro Templates will be imported into
the selected group.

If the Macro Template already exists on the host
PC, an alert box will be displayed identifying the
group and subgroup of any duplicates.

If you wish to import any of the listed Macro
Templates, tick the box beside its name before

clicking the OK button. This will create a new

Macro Template on the host PC, in addition to the
existing duplicate.

Macro Manager

E-0F Macros
[ Legacy Macros
EHE Cylon Macros
. B[] BACnet
= Heating
=)

.-[@ WeatherCom

Macros [

I weathercom

Imp:
Delete
Rename
Export Exit
Search Macros »p
B~ I @

Date mo

Open
P
© - « temp » Macros v O
Organise * New folder
. seurces ” Name
| temp
] A03.m32

attachments
Macros
o

. VirtualMachines

|| A06.m32

|| WeatherCom.m32

v <

File name:  "A06.m32" "AD3.m32" v

Importing Macros

*m32 v

Cencel

Some of these macros have matching IDs to existing macros. These may have
already been imported previously. You can select which macros you would like to

import anyway.

Issue

File

<

[~ Select Al

D Macro <AD3> has same ID as <AD3=> in <UC32 Macros-»Air Syst... AD3.m32
%Macro <AD6> has same ID as <A06> in <UC32Macros-»Air Syst... ADG.m32

Cancel
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Note: Each newly imported Macro Template will be named “X New Macro”, where X is the index of
the Macro Template in the list.

To change this name, select it in the Macro Manager dialog, and click the Rename button.

c
&,
>
o
<
()
(o]
=
[©]
7}

Once all Macro Templates have been added, they are available for use in the 'host' PC.
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WORKING WITH MACROS

To access the Macro groups and sub groups that exist in a site, click on View Macros in the Strategy tab of the

Ribbon .

r Strategy

ﬁl Copy T E i 'r BACnet Points E [3 Create

L?jPaste 'll= BACHet Units Manager

" View | Add o] Reorder _ Strategy | | Vi —
i Select Al | |Modules| Text Terminals Modules 1o Strategy Details Help @33_5 [y Save New
Clipboard Strategy Macros

The Macros pane will be displayed on the right-hand side of the CXpro"® window

Macros i x|

"[—ﬂ Macros
[ Legacy Macros
[ cylon Macros

[ Heating

Macros Prop... Page .. Mod..

How to insert a macro into a strategy

To insert a Macro in a strategy, select it in the Macros pane and click in the drawing area (note the cursor

changes to the “Module Cursor” during this process)

S BEES Q- CXproHD - 1.00.00-320 - olEl
File = Home  Controller | Strategy ®
o Connect 1| tco g E € 5acnet roints E B create | € startrpause €, | B ario Oy
¥ Disconnect [ Paste & BACnet Units [y Manager | 9 < B
Download | -, Add O Reorder E View |
[Jisclect All | |Modules Text Terminals Modules T Strateay Details ~ Help | |Macros) [ Save New | &, -
site Controller | Clipboard Strategy Macros Simuiation Display
Site List =K 00101532 | 001_01:s32WeatherCom | 001_01.532:Wea..| P % | Macros L - |
=-§) Sites ~ || macos
Ho BACnet IP &[] Legacy Macros
-2 BACnet Serial [ cvlon Macros
222 001 - Network B Heating
& 001 - 001 - UCUZ2IVAY EBB@“"\Z et
B-2g PLOffice eatherCom
&2 001 - Network
&, 001- 001 - CBM24
Ba sample Apps BACnet
v |
< > Macros Prop... Page .. Mod..
Strategy saved successfully. Connedted to: Sample Apps BAChet (3], - | E—_
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le anogu: ==
) Macro Point Configuration
Nrie - Home  comroter | st ®
& Connedt gL (F] Copy D Eoiihand b Start/Pause € | B Grid O}
Foscomee| LI | pute Name [Weathercom Thi text il be prepended to L o B
Dounload each point name below.
Group [Heating -
o site Controller | Clipboard i Simulation Display
£ Subgroup | Boiler
Jsien T | .|
e Sites. Y Macros
2 2, BACet P Num.. | Name [Type [ Value [High u... [towun., D Lo
-2 BAChet Serial B e = L3 cyton Macros
nalog
552 001 - Network 25 Analog - B Heating
= 001-001-UCUI2IIVAY] | |25 Anslog < EBB@W‘: .
5-Za PLOffce 27 Analog d . eatnerCom
B2 001 - Network
=), 001 - 001 - CBM24
S0 Sample Apps BACnet
< >
v
oK > Macros Prop.. Page .. Mod..
Setup block updated. —

2 BEG Q- CXproHD - 1.00.00-320 = B
File ~ Home Controller Strategy @
Hcomnea | L | Chcopy E A BACnet Points [ creste | @ statrpause &, | Bhoria Oy
¥ Disconnect [F] Paste A Bacnet Units FRy Manager | Ty & B
Download View | Add O Reorder Strategy - o
Modules Text Terminals Modules b Strategy Details ~ peip Ry save New | 8, - 7
site. Controller | Clipboard Strategy Macros Simulation Display
site List L Kl 00101532 | 001 01s32:WeatherCom | 001 01s32Wea..|» X | [Macros < |
E-@) Sites. - - - - - ~ | [@ macros
Bo sacoat I3 Legoy s
=50 BACnet Serial & o Bmnd ) [0 cylon Macres
232 007 - Network = Heating
L. 001- 001 - UCU2IIVAY EBB@”“&: et
&-2a PL Office eathercom
2-52 001 - Network
1.1, 001- 001 - CBM24
25 Sample Apps BAChet
v
< > Macros Prop... Page ... Mad.
Setup block updated, Connected to: Sample Apps BACnet ), — | —.

The Macro instance can be renamed, and its details viewed, through the Properties pane.

Properties

ra

WeatherCom

4 001.01.532 | 001_01.53%WeatherCom | 001_01.s3.. b X

N SECSE

XS] B

~ £ > ? IWeatherCom

B General Information

Point De... | Analog

MName WeatherCojn
Point Configura...
B Inputs
B O0AT
Internal Mo... Rescaleto 0and 100
Internal Meo... Upper Limit B
Point De... | Analog
B Outputs
B Dmnd
Internal Mo... Rescale from 0 to 100
Internal Mo...  Input

=l

Name
The name of the macro.

> Macros  Properties  Page Ma...

Modules
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How to view the modules in a macro ("Expanding" a macro)

To expand a Macro, double-click on the Macro symbol on the drawing area.

4 001_01.532 001_01.s32:WeatherC
B U H WzatherCom
S8 oa

[ [x=8]

CXpro*"® will open a new strategy for the Macro’s constituent modules.

q 001_01.532 001_01.532"WeatherCom 001_01.532WeatherCom 001_01.532:WeatherCom I
P Wéai:hér‘c'r'""
i0 . 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 .., 80 °C
........ aosopl
R Real Constant o 100 ¥ Rescals from Do 100 32
A=20, B=80 Y a/,l
R Real Constant Output A 72| Lower Limit A Outh[O
Y - Output B @ —55|© Upper Lim B
[ B [Constant A+ 80.00; Gonsn: B: 2. @ o
owaBORY
[Constant A: 20.00; Constant B: 2... B 100 Resczletodand 100 32
- . . / ...........
Ao
B e T = N
L 7@ Ueeer ime Bl
Qutside Air Temperature (OAT) O et
Rescales input temperature
"""" so'that 0°. 20 °C Becomés 0...'100 o
......................... v
£ >

Note: The view settings for Lines and Point Numbers are saved with the Macro. They are not inherited
from the parent strategy. For example, if lines are not visible when a Macro is expanded, simply

right-click on the strategy drawing, select Display Options , and specify that lines are to be shown.

Note: To distinguish between the inputs and outputs of individual modules and the inputs and outputs
of the overall Macro module red highlighting is used to mark the connection points of the Macro
modaule. It also provides the full path of the strategy file that it just created when expanding the
Macro in the Window menu.

Note: Any changes made to a macro within a strategy will only affect the current strategy. The macro and
all of its module blocks are saved within the active strategy. To edit the macro strategy itself you
must open the *.etm file.
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How to Edit a Macro

It is not possible to edit an existing Macro Template, but it is possible re-save a modified Macro as a new Macro

Template. To do this, expand the Macro by double-clicking on the Macro symbol on the drawing area. &
>

4 001_01.532 001_01.s32:WeatherC U%
F.' WzatherCom §

B R

CXpro"® will open a new strategy for the Macro’s constituent modules.

001_01.s32:WeatherCom box
"

q 001_01.532 001_01.532:WeatherCom 001_01.532:WeatherCom

.. 20 °C Outside Air Temperature 15 mapped fo a Flow < Setpoint of 20, 80 °C

| A=80,B=20

R RealGonsamt 55 m/u Rescak from 00 100
a2 Besn’ . . . A, . v
R Real Consant B [ owpmad)] [ Lower Lmit A Outpun
N, ) ) | cupus@lr - 75 Usper Lmit 8]
Output A Q| [Constant A: 80.00; Gonstant B 2. I o

[Constant A: 20.00; Consmne 6 2.

u)m Rescae 0 0and 100 32

20
(€ Lower Limn Al

Qutput )

Outside Air (OAT)
) ) ) ) ) ) 'Rescales input temperature
sothat 0'... 20 °C becomes 0 ... 100

Make any required changes to the component modules of the Macro by clicking on the symbol and editing its

properties in the Properties pane.

To save the changes select Save New from the Macros section of the Strategy tab on the Ribbon .

Strategy
M copy E o g BACnet Points E [ Create
Fpaste & 5AChet Units [ Manager
View | Add /O  Reorder Strateqy | View
Tiselect All | |Modules| Text Terminals Modules & Strateay Details * Help | Macros| [ 55"&“"
Clipboard Strateqy Macras

This opens the Create Macro dialog, but in this case Macro Inputs and Macro Outputs cannot be added or deleted.

The input and output point names can be changed, as can the Macro Name , Group and Sub Group .

Create Macro

~
Weather Compensator

0....20 °C Qutside Air Temperature is mapped to 2 Flow Temperature Setpoint of 20 .. 80 °C

a=60, 5=20

R TG B oy
A=20, B=80 ~ a/.
R ewmn @ [ o= Conar Cmea] G ()
~ o Toper T

Sl Corart A 0.0, Gorwart B:0.00 G|
FEETS)

(Goremene & .00, Goreare 510.00 D

"o

ST

{0 Upper Limit B
Outside Air Temperature (OAT) (Yot
) ) " Rescales Input temperature

S0that 0'...20 °C becomes 0 ... 100
v
< >
WMacro Inputs/Qutputs Macro Grouping

Inputs Outputs
000 OAT Change Name 1 DmNd Change Name (e

Group [Heating =
Change Change Sub Group [Boiler =

Macro Manager..

Macro Foint Configuration Cancel

MANO0133 rev 9 © Cylon Controls Ltd. 165






SECTION 8: COMMUNICATING
WITH

CONTROLLERS

HHTHHETEETEN



an04dxD

COMMUNICATING WITH CYLON CONTROLLERS

When you are using CXpro"®, you will need to communicate with the Cylon controllers on the site.

e You may need to send information to a controller such as a control strategy, a command to erase its
memory, details of its setup, etc.

e You may need to get information from a controller such as its version, current setup and details of any
strategies it may contain.

e You may wish to view events within a controller, such as changes in values when a strategy is being
serviced. This can be done in Scan mode or by using the LiveLog menu option.

SENDING INFORMATION TO A FIELD CONTROLLER

In CXpro"®, downloading a strategy can be completed in a single step, when you use Automatic Download (see
page 115). When the strategy is ready to be downloaded, simply click the download button on the toolbar or
choose Download from the Communications menu and CXpro"® will download the strategy and send the set-up
automatically. Alternatively, you can use Automatic On-line Download (see page 117), where CXpro"® automatically
downloads a module as soon as it is placed on the drawing area. Or finally, if you are already familiar with
CXpro"'®, you can download manually.

Automatic download

For details of how to enable Automatic Download, refer to Downloading a strategy using Automatic Download on
page 115.

Automatic on-line download

If you use Automatic on-line download, CXpro"® will download to the controller the contents of the drawing area as
soon as each module is placed on the drawing area. In other words, you do not have to press the download
button on the toolbar or choose Download from the Communications menu. CXpro"® will download automatically.

For more detail see Downloading a strategy using Automatic Online Downloading on page 117.
The following criteria must be met for automatic on-line download to function:

e  You must wipe the controller’'s memory before beginning the strategy.
e  You must be working on-line, i.e. you must be logged in to the controller.
e You must enable automatic on-line download.

e When the strategy is completed, you must send details of the number of blocks to service to the
controller, i.e. send the set-up.

Downloading tip

If you enable both options ( Automatic download and Automatic online downloading ) on the Download setup tab,
CXpro"'® will automatically wipe the controller’s memory, download the modules as soon as they are placed on
the drawing area and then automatically send the set-up. For example, supposing that you want to design a basic
Strategy, download it and then download any changes that you make. In that case, you would enable the first
option, i.e. Automatic Download , create the basic Strategy and download it by clicking the download button on the
toolbar. CXpro"® will send the set-up automatically. Then you would enable the second option on the Download
Setup tab, Automatic on-line downloading , so that each time you make a change to the original strategy or add
another module, the changes are downloaded and the set-up is sent automatically.
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Wiping a Field Controller's memory

Although it is no longer necessary to wipe the Field Controller's memory before downloading if automatic
download is enabled, it is still necessary to wipe the controller’'s memory before using it for the first time. If you
are not using automatic download, you must manually wipe the controller’'s memory before downloading.

The effect of wiping a Field Controller’'s memory

Wiping Field Controller memory has the following effect:
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All blocks are deleted (the strategy is deleted).

The functions of the site (valves, pumps, dampers, etc. controlled by this Field Controller, are no longer
available.)

The number of serviced blocks will be set to zero. Field Controller Set-up has to be sent again.

All virtual points are assigned the value zero.

All hardware points are assigned the value zero.

All outputs go to zero volts.

Inputs do not read any signals from connected devices. This is true for manually overridden points too.

The green LED on the Field Controller flashes rapidly. If the Field Controller is running without a network
(standalone), the flashes are regular. If the Field Controller is running on a network (connected to a BACnet
Router), the flashes are irregular.

If the alarm feature is active, an alarm appears on the monitor of the connected PC.

If a keypad program for that Field Controller exists, it will be deleted.

Sending the setup to a Field Controller

If you are using Automatic Download, it is not necessary to send the setup to the controller after downloading.
Otherwise, setup must be sent manually as described in Starting a strategy (sending the Setup) on page 125.
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GETTING CONTROLLER INFORMATION

How to get the Controller version
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

0
File - Home Controller Strategy
’ Co§e¢ m Copy Modules EE Strategy
L"Disc nnect LﬁPaite Navigatian Macros |:| Reopen
..... Site
i_iSelect All List EPage Mames @Search
Site Clipboard View
Site List a g |« Strategy1
E|--0 Sites

2o BACnetIP
-2 001 - Network
— =001 - 001 - UCU3213V

e Select Version from the Operations section of the Controller tab in the Ribbon .

ne Contraoller Strategy

%Communications Ii"l Download @Compare E:';Version "T'\Board Diagnostics
u %Controller ’QWipe Controller Show Compare %Time and Date I;'_.|Statistics
&, Bacnet 21 Auto Online

Configuration

Maximums r'ELoclt: and Unlock

Operations

CXpro*"® will get the version from the controller and display it.

Version

Wersion UC32.8E 7.6.9 05/05/16 Boot Ver:06.00

Serial Number CU12205063F

[~ Ecp

Close |

Click OK to close the Version window.
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How to get the controller setup
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

==
File - Home Controller Strategy

’ Co Eed: m Copy

_é'Dlsc nnect LﬁPaste

Modules E Strategy
Namgatmn ||E| Macros |:| Reopen
E Page Mames @ Search

Site. Clipboard View
Site List 8 x [ Strategy1
By Sites
S0 BACnetIP
- B8 001 - Metwork
= 001 - 001 - UCU3213V

e Select Time and Date from the Operations section of the Controller tab in the Ribbon .

Contraoller Strategy

Jﬁ Communications |4_'| Download I-T,él Compare E!,\-’ersion r'.\ Board Diagnostics

%Controller ’BWipe Controller EShow Compare %Time and Date :..jstatistics

% BACnet k |4_'|‘ Auto Online Maximums :.' Lock and Unlock
Configuration Operations

CXpro"® will get the Setup of the controller and display it.

Controller Configuration
Mumber Of Strategy Blocks To Service I b Send |
—Last Comp d Strategy Last Modified Receive |
) = =] 08/2018 — - e | naa0E —
Time |11:57:35 = Date |14/08/2018 = ’7 Time |11.5r.35 = Date [14/08/2013 =

User ID

User Name
Drawing Reference

Strategy ID
Min Service Time

Time Synchronisation Wait After

177

r~ Current Status
Received setup from controller

Close I

Click OK to close the Time and Date window.
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How to get controller statistics
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the

==
File - Home Controller Strategy
’Co nect mCopy
ﬂ Dls%nnect LﬁPaste
[iselect AN
Site Clipboard
Site List a g 4

Properties I

Modules |Ez| Strategy

Namgatmn Macros DReopen

Site
i List E Page Names @ Search

View

Strategy1

B-52 001 - Metwork
& 001 - 001 - UCU3213V

e Select Statistics from the Operations section of the Controller tab in the Ribbon .

ne Controller Strategy

‘5 Communications
u % Controller

% BACnet

Configuration

£ Download

’QWipe Controller Show Compare
ﬁAuto COnline

E%‘u"ersion "T'\Board Diagnostics

B3 Time and Date B statistics

B, compare
| P

Maximums "_'5 Lock and Uhlock

Cperations

Ribbon :

The Statistics dialog box, shown below, appears. The Statistics dialog box contains information that comes

directly from the controller — this information allows you to check the status of the controller.

Statistics

Engineering Statistics } System Statistics | Serial Port Statistics |

Mumber of Resets ’ﬂ_
Number of Crash Detects I
Comm. Checksum Emors ’D_
Number of Bad Blocks o
Status

[~ WatchDog On

" Real Time Clock presert

Clear

oK

The Statistics dialog box has three tabs — Engineering Statistics , System Statistics , and Serial Port Statistics .
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Engineering statistics tab

Statistics

Eﬂgmeegg Statistics } System Statistics | Serial Port Statistics |

Number of Resets Clear

Number of Crash Detects

Comm. Checksum Emors
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Number of Bad Blocks

Status
[~ WatchDog On
I~ Real Time Clock present

L
Number of resets indicates how many times the Field Controller has been powered up and down
Number of crash detects the number of crash events detected since the Strategy started
Comm. Checksum errors the number of data errors that have occurred in communications
Number of bad blocks the number of bad or corrupted blocks that have been detected in the strategy

Watchdog on This shows the current status of the “Watchdog” on the Field Controller — the box is checked if the

watchdog is switched on (a watchdog is a hardware component in the controller that checks if the controller is
serviceable. When the watchdog is off, the controller is not operating)

Real time clock present indicates if a real time clock is present in the Field Controller
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System statistics tab

This tab provides information on any problems the controller may have in servicing the strategy.

Statistics

Engineering Statistics  System Statistics |Sena\ Port Sla1istic5|

Last Reset
’V |\n\rahd |Irwa|id

™ Setup Block

Mumber Of Blocks Servicing ID

Number of Bad Blocks ID
First Bad Block ID
Last Bad Block ID

Last reset Shows the date and time that the Field Controller was last reset

0K |

Set-up block indicates if the Setup block (the block in the controller that stores details of the number of blocks in

the strategy) is in place.

Number of blocks servicing shows how many blocks are servicing in the Field Controller

Number of bad blocks shows how many bad or corrupted blocks are detected in the Field Controller

First bad block The number of the first of the bad blocks (if any)

Last bad block The number of the last of the bad blocks (if any)
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Serial Port Statistics tab

CXpro"'® can display information about messages passing through the Field Controller's serial ports as follows:

Statistics

Engineering Statistics } System Statistics  Serial Port l%aﬁstics ]

Serial Port Type
¥ Subnet m
" Service
" Intemal Keypad %
" BEdemal Keypad
Total Number Keypad Information
Bytes Received |0 Owerun Emors |0 Unexpected Responses |0
Bytes Sent "}7 Framing Emors "}7 Rx Timeouts ,ﬂi
Packets Received ’0— Parity Emors ’0— Resends '0—
Packets Sent [0 o e Packet Sze NACKS [0
NACKS Recsived [0 o Undefined NACKS [0
NACKS Sent ’D— Ereak Conditions Broadcast Information
ACKS Received "}7 ’D— Faults ,ﬂi
ACKS Sent [0 CRCEmr [0
Checksum Emors ’ﬂi Packets Received OK ,‘}7
Packets Received '0—
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The first section of this panel, Serial Port Type allows you to select which of the four possible serial ports the

displayed information refers to.

Pressing the Receive button causes CXpro"? to upload information about the selected port from the Field

Controller.

Clicking on Clear causes the Field Controller to clear its memory of port statistics for the selected port.

The information displayed is the number of each of the following messages that passed through the selected

serial port since the controller's memory was last cleared:

e Number of Bytes received

e Number of Bytes Sent

e Number of Packets received
e Number of Packets Sent

e Number of NACKs received
e Number of NACKs sent

e Number of ACKs received

e Number of ACKs sent

e Number of Checksum errors
e Number of Qverrun errors

e Number of Framing errors
e Number of Parity errors

e Number of break conditions

This information can be used to diagnose low-level problems with the Field Controller's serial-port

communications, and this is usually done in consultation with Cylon Technical Support.
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How to get Field Controller Diagnostic information

CXpro"'® has a facility to display information about the operation of the UC32 controller's hardware system. This
information, referred to as 'board diagnostics' can be of use in troubleshooting unusual and low-level problems
on a Cylon site, and is intended for use primarily when communicating with Cylon technical support.

Board Diagnostic information may be viewed by selecting Diagnostics from the Controller tab on the Ribbon .

Contraller Strategy

‘&Communications l:l Download @Compare ‘%Version "T'\Board Diagnaostics

'3 Contraller @Wipe Controller Show Compare % Time and Date '-_.'_.| Statistics T}

% BACnet rﬁ Auto Online Maximums "_'E Lock and Unlock
Configuration Operations

This opens a display panel showing categories of information about the Field Controller's hardware.

Board Diagnostics
Battery Status Vedor
Battery VECTOR COUNT WALUE
DAC Reading for...
Ov switch to
Port Setup
Address
Baud Rate

Board ID Resistors
Main Board

Daughter Board

Ready

Clicking on the Receive button causes CXpro"® to upload the relevant information from the targeted Field

Controller.

How to get Field Controller Configuration information

Field Controller configuration information can be of use in troubleshooting unusual and low-level problems on a
Cylon site, and is intended for use primarily when communicating with Cylon Technical Support.

To view this information, select Maximums from the Controller tab of the Ribbon

Controller Strategy

%Communications [i'] Download @Compare %Version r.{Board Diagnostics

'3 Controller ’ijWipe Controller Show Compare % Time and Date '-_.'_.| Statistics

% BACnet Iﬂ Auto Online Maximums :.' Lack and Unlock
Configuration Cperations

This opens a display panel showing the configuration of the Field Controller's hardware.

Maximums

Maximum Subnet Address 63
Maximum Strategy Block 1024
Maximum Number of Datalogs | 32

Maximum Keypad Program Size | 20003

Close
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HOW TO SET THE CONTROLLER TIME AND DATE

e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

==

$J3]]0J3U0D YHM SuledIuNWIC

File - Home Controller Strategy

’ Cowec‘t @ Copy Properties Modules EE Strategy
L” Disctnnect L‘ﬁ Paste Na\rigation Macros |:| Reopen

= ite
i _iselect All List Page Mames @ Search
Site Clipboard View

e Select Time and Date from the Operations section of the Controller tab in the Ribbon .

ne Contraller Strategy
%Communications l:l Download f’éCompare E'a‘u‘ersion "T'\Board Diagnostics
a3 "3 Controller ’thipe Controller Show Compare % Time and Daﬁ I:.'_.| Statistics
% BACnet I‘E Auto Online Maximums r'g Lock and Unlock
Configuration Operations

This opens the Time and Date dialog.

Time and Date
Time and Date Send
) _—— 5
Time |KE:06:57 =i System Time/Date | Receive |
Date [14/08/2018 =
Time Based On
" None
" EU
" us
" Use Point 0
Current Status
Error receiving time and date from controller

In this dialog, you can check the time and date set in the targeted controller by clicking on the Receive button
(time and date are automatically received when you first open the dialog).

The Time and Date can be changed by typing a new date, by scrolling, or by pressing the System Time / Date
button, which sets the time and date to match the settings in the PC on which CXpro"® is running.

The daylight saving time scheme can be selected in the Time based on box on the Time and Date dialog:

e [f the None option is selected for Daylight Savings, then the controller will not automatically adjust its
time to match conventional Summer and Winter time.

e [f the EU option is selected for Daylight Savings, then the controller will automatically adjust its time
according to the standard European rules for Summer and Winter time.

e [f the US option is selected for Daylight Savings, then the controller will automatically adjust its time
according to the standard rules used in the USA for Summer and Winter time.

e |f the Use Point option is selected for Daylight Savings, then you can specifiy a point whose value will

determine Summer and Winter time.

If the time and date settings have been changed in the dialog box, they must be sent to the controller before
they will take effect. This is done by clicking the Send button:

Clicking the Close button closes the dialog box without sending or receiving further information.
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CHANGING THE ADDRESS OF A CONTROLLER (CBM ONLY)

CBM controller addresses must be set from software, because there are no Address DIP switches on this type of
controller. To set a controller's address from CXpro"®:

Make sure that the PC, running CXpro"®, is directly connected to the Field Controller’s service port.

Make sure that there is a site set up in CXpro"® with the PC connected to COM port:

Site Information

Sites Configuration ﬂ

Mame | Campus block R Add New Site

Directory | CAMPBLOR

Change Site

Type of Connection for this Site

(®) Serial Connection

Clear

() BACnet IP

Site List

BACnet IP
BACnet Serial

Edit Controllers

Campus block R

PL Office
Sample Apps BACnet

Delete Site

Make sure that the directly connected controller is targeted in CXpro"®’s Site List

| Site List

OK Cancel

=2 Pl Nffice

Io BACnet Serial

o Campus block R

- &2 001 - Network

L= 001-001 - CBNI%?

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

File - Home Controller Strategy

’ Cnged m Copy Properties I Modules |Ez| Strategy

Na\r\gatlon Macros |:| Reopen

ﬂDlsc

nnect L?j Paste

J— Site
L _iSelect All List PageNames @Sear(h
Site. Clipboard View

Select BACnet from the Configuration section of the Controller tab in the Ribbon

Contraller Strategy

‘&Communications
IaController

%, BACnet
%Oﬂ

Configura

In the BACnet Configuration dialog you can set the address for the controller

Controller

Device Instance

Device Name

1 Download @Compare
’?}Wipe Controller Show Compare

Iﬁ‘Auto Online
Op

BACnet Configuration
Controller Config New

I 1 [ 1 El

I 41 [ 41 |

po1-001-cemos  001-001-ceMmos [Pt -001 - CBMO
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DATALOGS

Datalogs (Trendlogs) are a feature of Field Controllers that allows point values to be recorded over a period of time.
The recorded data can be later retrieved, displayed, and analyzed with the Datalog Manager module.

Analysis of logged data is often useful in optimizing the effectiveness of a Cylon site’s controllers and strategies, and
Identifying opportunities for energy savings.

The datalog function module

The collection of point values in a datalog is implemented in a strategy by either the Datalog module or the BACnet
Trendlog module.

Datalog B
N Datalog_1

Analog input BACn=t Trendlog 4
= i L N Outside Air
[ Digital input & Temperasture Trend
[ Enzhle [ Digital input
[ Leg trigger €3 Anakg input
Datalog number: 1; Update [ Enable
interval: 900; Link: 0; Datalog :
Trigger Options: Any Edoe: Dekta: [ Leg trigger
1,00; Bxtended length: 0 Datalog Trigger Options: Any Edge

The content of a Datalog can be viewed with the Cylon Datalog Manager, and the content of a BACnet Trendlog
can be examined by a BACnet supervisor. Their use in the Strategy is identical.

Restrictions on the use of datalogs

The number of Datalogs (Trendlogs) permitted in a strategy depends on the type of controller in which the strategy
will be used.

Some controllers, such as the CBM24 can have up to 32 datalogs, with a maximum of 1024 entries per datalog.
Other controllers, such as the CBT12, have up to 6 datalogs, with a maximum of 1024 entries in each. You can
determine the number of datalogs that a particular controller can hold using the Maximums dialog box, available

from the Operatons section of the Controller tab on the Ribbon menu.

Standard Datalog sampling period

Each standard datalog module can be configured with an individual time constant for sampling data. To make the
evaluation of datalogs easier it is advisable to use the same time period for sampling data in all datalog modules. A
sampling period of 15 minutes is suggested.

The period of time over which the datalog samples is equal to the product of number of entries (104 or 192) and
the sampling frequency. For example, a datalog module on a UC16PG with a sampling frequency of 15 minutes
(900 seconds) will take samples for (192 X 15) minutes = 48 hours.

Time Stamped Datalogs

A time-stamped datalog records the time and date at which a value was recorded, along with the value. A logging
interval is not set - instead the value of the specified point is recorded:
e when the digital trigger point changes state
e when a logged digital point changes state
e or when a logged analog point changes state by more than a predefined amount from the last value
that was logged for it.
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There are several situations when such a datalog would be particularly useful. For instance, if you log the value of
a point with a conventional datalog and set the logging interval to 10 minutes, the value of the point may change
significantly and return to its original value over a period of 3 minutes, and that change might occur during the
10 minutes when the datalog is not recording. If so, the event would not be logged at all. On the other hand, if the
logging interval was 30 seconds, the event would be recorded - but the datalog could fill up and the event could
be 'flushed' before it is viewed. If so, the event would also be lost. In both of these cases, a time-stamped datalog

could record data over the period of the event only, so that the necessary data is recorded without the datalog
filling up.
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The other primary use of a time-stamped datalog is to log conditions that surround an event. For instance, when a
window is opened, the temperature of the surrounding area could be logged to see how it reacts.

Datalog sampling of digital and analog point values

Both digital and analog point values can be sampled. The datalog module has a digital input and an analog input.

Analog Input o Datzkg 2
Al goom at S N Raom
om Temperature S TemperatureA
Point £ T i) € Analog input
5 Y |
Ovemide [ [ Digital input
[ Enable
[ Log wigger

Datalog mumber: 1; Update
interval: 300; Link: 0; Datalog
Trigger Options: Any Edge; Deha:
1.00; Bxtendad length: 0

o s .
Digital Input A N Valve 2094
D I Valve 209 o £ Analog input
Point [T 7 vl (] Diigital it
AT )
Cvemide [ [ Enable
S

Datalog umber; 2; Update
interval: 900; Link: 0; Datalog
Trigger Options: Any Edge: Delta:
1.080; Bxtended length: O

How to define a datalog

To define a datalog, proceed as follows:

Select the Datalog module in the Modules pane

Modules W x|
®

I i " la

Controls »

Functions »

Math »

Schedules, Timers, and Logic »

Setpoints, Inputs, and Outputs »

Statistics -

‘ Alarm

“ BAChet Alarm

"\‘ BACnet Trendlog

D Comment

|b Control Flags

123

nmn  Counter

V' Datalog %

Meter

® Real Time Clock v

Macros Properties Page Ma.. Modules

MANO0133 rev 9 © Cylon Controls Ltd. 181



an04dxD

and place it on the drawing area (note the cursor changes to the “Module Cursor” during this process)

i onoiss2 ) oo eise | |Nigaie - | i ooz oo 0tsn | Moduies =@
Cantrols v Cantrols N
Funcions » Funcions ,
Math » Math ,
HE Schedules, Timers, and Logic v Schedules, Timers, and Logic »
Sefpoints, Inputs, and Oulputs Sefpoints, Inputs, and Outputs
Statitics - Statitics -
A aam A aam
Ay sacnet wam Ay sacnet am
Mg satnet Trendiog N4 satnet Trendlog
D comment D comment
% control Flags % control Fags
1 1
T Counter T Counter
IV pataleg IV pataleg
Heter Heter
| ® reaimme dock v o || @® real Time ciock v
< > | Macos Propemies FageNa. Madules < > Macos Propeties Pageha.. Madules

Select the datalog, and configure its properties

4 001_01.532 001_01.532 - X | Properties O x |
B £ D> ? Datalog -
‘Anzlog Input T Datakog : =]
Ro
Al Room Temperature o ) N Tmu;a;num Type Datalog
Peint O frrr— T Ansig inpet Service Order 2
Ovemide) g Eg"::"'j“" Marne Room TemnperatureA
na
5 tog wiaer Use point name  True
Darab\-; b L Synchronised 5t.. Checking...
interval: 500; Link: =]
Trigger Options: Any
L.00; Evtended langth: | Analoginput  Analeg (1): 0.00 Ro..
Enable Digital
Log trigger Digital
Digital input | Digital
=]
N Detzlog 3 Datalog number 1
Digral Input Valve 209A D .
= atalog type Analog
o] Valve 209 € Analog input gue E
= . - = Update interval 900
Point [ T EJE Digital input -
Gl N GET Log trigger opti...  Any edge
: 5 oo o Delta 1.00
Datalog number Precision 0
interval: 500; Li - —
Trigger Clptrgz s Log trigger Time interval
1.00; Exten ngth: 0
—_ — Extended length 0
Analog input
The analog value to be legged.
. v
< > Macros  Properties Page Ma.. Modules

Name

A datalog is automatically given the same name as the point to which it is joined, but can be edited if the

Point name property is set to False.
Use Point name

If True, then the Name property matches the connected point and cannot be edited.

Analog input

This shows details of the point to be logged, if an Analog point is connected

Enable

Use

The Enabling Point is a digital point, connected to the “Enable” input of the datalog module, which restarts the
sampling process if its value changes from @ to 1. If this point is not connected, then the datalog samples

continuously. In typical applicatio

ns this input is not used.
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Log Trigger

In Time-stamped datalogs, it is possible to record data when this trigger point changes. If the trigger point is not
connected, logging occurs according to the 'Minimum Change' parameter.

Digital input
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This shows details of the point to be logged, if a Digital point is connected

Datalog Number
This shows the automatically-assigned number for the Datalog within the strategy.
Datalog Type

The type (analog or digital) of the point being sampled is shown in the Type of Point to Log.

Update Interval

This is the frequency of sampling (in seconds). By default this is 900 (15 minutes) but can be edited in the
Properties pane.

Delta

If the datalog type is set to 'Time Stamped', and if the type of point being logged is analog, it is possible to trigger
a sample whenever the point value changes by more than a particular amount. This field specifies that amount of
change.

Starting a datalog

A datalog is part of a strategy and is saved with the strategy. The example below shows a datalog module linked
to a strategy:

Anakeg Setpoint o Comparator [ Digital Output 7
m Frost Protection © - |A-B o DD Baoiler Switch
Point () el Inpust A c'utp.nm.l'] — w3 Point Tvame= O
. . . . L . 13
XA ) Input B Complement [[
Y e
N IR Qutside Air
Analog Input 1 N
AI Outside Air il B -TEI11DEl'atIJI'Eﬂ
Temperature €) Anzlog input
Point & I3} [T Digital input
Overide (3 3 Enable
5 Leg trigger
Dataleg numbsar: 1; Update
intzrval: 900; Link: 0; Datalog
Trigger Options: Any Edgs; Delta:
1.00; Baended length: @

Datalogs are started along with the rest of the strategy in which they are contained, when the strategy has been
saved (see page 109), downloaded (see page 114), started (see page 125) and tested (see page 128) .

Note: If the block on which a datalog module is placed is downloaded again to the Field Controller, the
sampled data is deleted.
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Viewing the contents of a datalog

This is done on a PC running Cylon software.

The Datalog Manager program is used to view or print out datalogs, on screen or printer, as text or graphics. To
open is, click on the Datalog Manager icon in the Home tab of the Ribbon .

Home Controller Strategy
innect Cf copy T [FH Properties |[[E] Modules |[?] strategy Help r‘] g r'l r‘l r‘] r‘l
sconnect L?jPaste £ Navigation Macros Reopen Strategies a = w sh < e
= Site Configuration Database Datalog Site Eackup ME-Pro
L_iSelect All List |[=]Page Names [&]search Interface Mand.zr Organiser
Site Clipboard View Utilities

The Datalog Manager allows data from Field Controller datalogs to be viewed in a variety of ways:

e The data can be listed as text.

e Adatalog can be viewed as a graph.

e Information from multiple datalogs can be superimposed on one graph.
e The status of data points can be viewed in real-time.

e ‘Snapshots’ can be made of data from any set of analog points in a controller strategy.
For further details on the display and printing of datalogs, see the Datalog Manager manual.

Archived datalogs can be statistically evaluated by using programs like Microsoft Excel. This provides valuable
information about the operation of the site.
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ALARMS

Alarms are used in a BMS system to alert site supervisors/engineers to any difficulties that may occur on a Site.
The Cylon BACnet range supports BACnet Alarm notifications which can be made available to BACnet supervisors
such as Cylon’s Aspect™ ULI.
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The BACnet Alarm module is joined to a digital point (Binary Value). When the digital point has the value 1, the
BACnet Alarm module is activated. The Binary Value may indicate an error condition, for example a sensor going
out of normal range or a fire alarm being activated.

Alarms can also be set up directly on BACnet points via standard BACnet protocol.

Starting alarms

Alarms are parts of strategies and are saved with the strategies. The examples belowshow how alarm modules can
be linked to a strategy.

Alarms are started after the related strategies have been saved, downloaded, started and tested.

Examples of Strategies containing alarms

Alarms - Example 1: Pump Trip Switch

To illustrate the use of an alarm module in a strategy, this guide takes as an example a simple case where a
digital hardware input represents a trip-switch contact of a pump. Joining the digital input to an alarm module
means that an alarm will be generated if the pump goes off-line.

Digital Input T BACnet Alzrm B
DI Pump Tripswitch o % Pump Tripswitch
Point [ .1;] ..EJEAlar'n trigger |
Override [0 ' ' [Alamm on: 1; Notfication type: Al

Alarms - Example 2: Pump Trip Switch with delay

This case joins a digital virtual point (a delay of 60 seconds on the digital hardware input) to the alarm record
function module.

Digital Input 3] [+ Tmerwih Consmanc.. 7| BACnet Alarm g
DI Pump TripswitchA 0 o & DigVire_1
Point [ .J'J ::HgTriggr:l OL.rtp..rtEl: 715 Alzm trigger |
Overrid= [ [ Res=t Complement [ Alarm on: 1; Motfieton type: Al
"7 |Ondelay: 10; O delay: A0g M |~ 0 T

Alarms - Example 3: Room Temperature Input

In this case, an analog input (room temperature) is joined to the alarm record function module, and will cause an
alarm to be sent to the Alarm Handler program if the input value is not within the range specified in the real
constant module.

R R=zl Constant E R [ Window Comparator 8 | BAChet Alarm w

~N | fa o ‘. DigVirt_2

| Ot.rtp.rt.q@z. - 2@Lw:w\rerli1'|'rt."t Omwirdowﬁz. - {0 Alarm trigger

[ owpme® € Upper lmit B | In window [0 Al on: 1; Notfication type: Al
Constant A: 0.00; Constant B: 0.00 | @ Input € o o

Anzlog Input
AI Room Temperature
Paint €3 frp
Ovemids [T
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INTRODUCTION

A Simulation Mode is available within CXpro"®, which allows the operation of a strategy to be simulated without
the requiring a controller to be connected. This is done, in most cases, by using actual Firmware code to ensure
the simulation is as close as possible to real controllers.

Simulation Mode is access through the Simulation section of the Strategy tab onthe Ribbon

ler Strategy

@C-:py . . = l‘ BAChet Points E . E", Create % t'h! Logging E
L?jPaste I E — .I=BACnetUnits I. Manager n’ .ﬂ‘. Configuration E
— View Add I/ Rearder  Strategy View Start/Pause Stop  Reset
{iselect Al | |Modules| Text Terminals Modules & Strategy Details Help | |Macros) [ Save New 1 seconds L
Clipboard Strategy Macros Simulation
.n, Clicking this button will start and pause the simulation for the current strategy. It is enabled
b only if CXpro"® is not logged into the site. When the strategy is paused, the current
Start/Pause simulation state is still visible on the strategy.
_n_ Clicking this button will stop the simulation and clear the simulation information from the
. screen. However, the simulation state will still be preserved, and pressing the Start/Pause
Stop button will restart from where it stopped.
Clicking this button will stop the simulation, clear the simulation information from the
screen and clear any other simulation information for the strategy.
Reset
#H Logging Clicking this button will enable or disable logging of data. When released, no point logging

will happen. When pushed, any point that has logging information set will have its values
logged accordingly.

# Configuration  Clicking this button opens the Simulation Configuration dialog.
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CONFIGURING THE SIMULATION

# Configuration

Several aspects of the Simulation can be configured by pressing the button the Simulation

section of the Strategy tab on the Ribbon . This opens the Simulation Configuration dialog.

Simulation Configuration
General configuration
Simulation Speed |Norma| j
Display Progress As |Runtime ﬂ

Current simulation configuration

Start time/date [17:46:18 == |14/082018 ¥ |

Cancel ‘

The Simulation Cycle

The basic unit for a simulation is a Simulation Cycle. This corresponds to approximately 1 second of runtime on a
controller. Some modules (Hardware, Globals, time dependent modules) will be processed a fixed number of
time during a cycle. Most of the other modules will be processed a number of times that depends on the size of
the strategy. The bigger the strategy, the less the modules will be processed.

Simulation speed
The Simulation can be run manually (“Step by Step”) where each click on the start button runs one Simulation
Cycle, or automatically at one of 3 speeds: Slow (once cycle every 5 seconds), Normal (one cycle per second) or
Fast (5 cycles per second).

Display Progress As:
The progress of the current simulation is displayed in the right-most section of the Simulation Toolbar. This

progress can be displayed as Runtime (number of seconds since the simulation started) or Date/Time (current
simulation date and time)

Current simulation configuration

Start time/date:
When the Simulation Cycle is run, any time and date dependent modules — such as Time Schedules or
Datalogs/Trendlogs - will use a simulated time. The value used will be the time and date set in the Current
simulation configuration Start time/date field of the Simulation Configuration dialog, incremented by one second
on each Simulation Cycle.
This allows a Strategy to be tested for unusual behaviours at specific times such as daylight savings time, year-
end, leap years etc.

The value of this time and date will be displayed in the right-most section of the Simulation Toolbar if the Display
Progress As field is set to Date/Time.
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RUNNING A SIMULATION

When a Simulation runs, the labels at the end of lines will be updated to show the point values.

log Setpaint 1] A-B Comparator 1
t Protection -
Paint 3~ Input A Output [ ey .
. LA .
Input B Complement [ L
Datalog 2
Temer 11 N Outside Air
alog Input Tem peraturef
1tside Air -
5 | " Analog input
£ Inpu
¥P . .FI Diigital inpast
og/Digital Type: Analog e
therad/Nithered: Nitharar =

A green background means that the value is calculated by the simulation.

A red background indicates that the value has been overridden by the user.

Note: It is possible to add, update and delete modules and lines while the simulation is running. The

simulation will take it instantly into account in its calculations.

Livelog

During a simulation the livelog will display values from a simulation run so that it is possible to view point values
from different parts of the strategy simultaneously.
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POINT PROPERTIES

The Simulation mode has two sets of point properties:

e one for input points that feed into the Strategy (hardware inputs and Globals’ destinations),

2z
3
=
Q
=4
o
=]
<
o
Q.
o

e one for all the other points whose values result from the Strategy’s internal calculation.

Accessing the points properties

To open the Simulation Properties for a specific point right click and select Simulation properties . This can be done
on either Lines, Hardware 1/0 modules or connected nodes:

Lines
oM parator T
Digital Output 7
Oupt ey pp DO goiler sviiech
i 3 :
Complement (3 i

: Convert Line to Connector
Datzlog Tes - =
utside Air Simulation H{gpemes
mperaturef S e
i
t

Hardware 1/0 modules

‘Analog Input BN
Al Outcite hir
T

ure

Simulation properties

BEEEER

Connected nodes

| N Qutside Air
Temperatured

Analoq input

Hide lines

Add Destination Cennector

Convert Lines to Connectors

[ == ol

Simulﬁfion Properties
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Point value override

In a point’s Simulation properties dialog you can specify whether the value for the point will be calculated by the

Simulation, or set to a fixed value:

Analog points:

Point calculated automatically:
Pairt Value I Paint Logging |
All Paints
’7 [~ Ovenide 0.00

|— Input paoints
[ o |

Point overridden and set to 18.5:

Point Value I Point Logging I

All Points
’7 v Ovemide 185D

Input paints

[Mana -1

Digital Points:

Point calculated automatically:
Pairt Value I Poirt Logging |
All Paints
’7 [ Ovemide =

Input paints ‘

| - —1

Point overridden, and set to “Off” (boolean 0)

Point Value I Paoint Logaing I

All Points
’7 v Ovemide r

Input paints ‘

| Y- 1

Point overridden, and set to “On” (boolean 1)

Pairt Value I Poirt Logging |

All Points
’7 V¥ Ovemide I~

Input paoints
’7 INune LI
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Input point options

For input point, a selection of options is available to simulate different types of inputs. For Digital points there
are two options, for Analog points there are 7:
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Digital Input point options

Input paints
I Mone ;l

Fieed
Periodic change

¢ Fixed value
The point will have a fixed value throughout the Simulation run.

Value is “Off” for the whole Simulation run:

— Input paints
[ B
Value: r

Value is “On” for the whole Simulation run:

 Input paints
[ Foced -]
Value: v

e Periodic change
This option will change the value of the digital point during the Simulation run.

If the Random period box is unchecked, the value will change after the Basic Period specified:

Input points
IF'eriodic change ;I
Random period r
Basic period |2 Secs. LI

If the Random period box is checked, the value will change after a random period which is less than the specified

Basic Period:
Input points
IF‘eriodic change ;I
Random period v
Basic period Ia Secs. LI
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Analog Input point options:

— Input points

Random Value _]'\l

Maone i
Fixed 7.00
Random Value [
UUp (down) onby 1.00

Up (down) onby with limit
Up and down

Values from File

e None

The point is not assigned a value. The value will either be the last value that the point had, or zero if no previous
value existed.

Input poirts

e

e Fixed

The point will have a fixed value throughout the Simulation run.

— Input pairts »

Foced LI .
Value: |1ﬂ| e

=Seriesl

17
25
33
a1
49
57
&5
73
81
89
a7

105

113

121

129

137

145

153

e Random value

During each simulation cycle, the point will be assigned a random value between a given minimum and
maximum.

— Input paints

16

Random Value ;I 18—} \

12
Min Yalue: I5 10

8 #
Max Value: IH . :

ﬂﬂﬂﬂﬂﬂﬂ
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e Up (down) only

The value will change in only one direction (up or down). Use a negative step limit to go down.

— Input pairts 1
IUp {down) only LI 160 /
140 /
Start value |5 e ~
100
a0 // ——seriesl
60
40 /
20 /
>
IFmEdsteP =l |1| T RRYInERRBSE S NRRE Y
— Input paints w0
-
UD {dcwn} cnly - 80
| <] . —
Start valus I5 5
50 /
40 // Seriesl
30 /
20 /
10 I~
Handcumstepuptc. vI I1 I gy
¢ Up (down) only with limit
The value will go from a Start value to a Stop value.
— Input points 120
I Up (down) onfy with limit LI 100 /
Start value |5 2 /
&0 =——Seriesl
Stop value I'H:"l:i /
40
Ry
ol
IF\.Med Step j I‘Iﬂ 1 4 7101316192225283134374043464952555861646770
— Input paints 120
Chart Area i
I Up {down) onby with limit LI 100 /
Start value |5 80 /
60 N
Stop value I'H}[i / Tserest
40
. //
Random step up to - |3 o

1 4 71013161922252831343740434649525558616046770
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e Up and down

The value will go up and down continuously between two limits either by a specified step (fixed or random) with
a specified period (specify the time to go from one limit to the other).

— Input paints
Up and down ;I

15

Stop value I25 T serest

30

For up ko I[:l I Mone - | s
IFWEdSiE“P vI IDH T g
S mur~OaOoONT Ol dmneS 0o N T O
SNZZEAANARESNEE

— Input pairts 16

IUp and down LI 4

12

e P N/avavavaw,
Stop value |25— - E'MLH* —Seriest

Far up to IE' INone ;I

Random step up to - 0.5 ‘Ersnaz

— Input paints

16

Ii
=] A A W_— AV
Start value I15 130 / \ / \ / \ |
o NN,

Forupto |1| I Mins. ;I :

IUp and down

Stop value

e Values from file

The point value will be taken from a datalog file — at each simulation cycle the next value will be read from the
file.

This allows using real data such as a datalog of outside air temperature in the simulation. It also makes it possible
to repeat a simulation exactly if the input points from the original simulation have been logged.

— Input pairts
Walues from File LI

Fie |
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POINT LOGGING

Paint Yalue FPoirt Logging
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Mone

Time stamped logging

Foirt Walue Point Logging |

Time stamped logging -

File [ .
Sample interval IBDD

Datalog capacity 1024
(50-4036)

Any point in the strategy can be logged to a file. This can be used to review values after the strategy has run, and
analyse issues. It can also be used to feed back the value in another simulation (see “Input points options”).

Note: Logging will occur only if both
1. the settings in the point Simulation properties dialog are set and
2. the logging button stari/rause iS pressed in the Simulation section of the Strategy tab on the
Ribbon .

This means that logging can be switched on or off during a simulation by clicking the logging
button.
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OVERVIEW

A site is the name given to one or more controllers, optionally connected to a PC. The following are examples of

sites.

e A standalone Field Controller.

e  One BACnet Router with a Fieldbus of one or more Field Controllers

e A network of BACnet Routers, each with a Fieldbus of one or more Field Controllers, connected to each other
via TCP/IP.

Sites are configured in the Configuration program.
Some common procedures carried out on sites include:

e Installing a new site on the PC (see page 200)

e  Site backup (see page 201)

INSTALLING A NEW SITE ON THE PC

To install a new site on a PC, the Cylon Software Suite must be installed already.

A new site is one which has not been installed on this PC before, and for which a backup from another PC does

not exist.

WHAT HAPPENS WHEN A NEW SITE IS INSTALLED

Installing a new site involves the following events:

e Site-specific directories are created on the hard disk.

e  Site-specific information (information about network ID, telephone number, ID code, etc.) is entered in
the WN3000.ini file.

e The network size (number of BACnet Routers) is specified.

e The BACnet Routers and Field Controllers are named.

The Configuration program performs all these steps. For further details, see MAN-0041 Configuration User
Manual.

Note: Do not manually make entries to the WN3000.ini when installing a site on the PC. All necessary
changes will be made to the wN3000. ini file by the Configuration utility.
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HOW A NEW SITE IS INSTALLED ON THE PC

Installing a new site on the PCinvolves the following procedures:

e Naming the new site in the Configuration program.

saus

e Entering the size of the site (number of BACnet Routers) in the Configuration program.
e Naming the BACnet Routers and Field Controllers in the Configuration program.

e If the site is not a remote site, it can be configured as the default site (see MAN-0134 MANO0134US
CXpro*P System Configuration).
e Restarting Microsoft Windows and the CXpro"® for the changes to take effect.

SITE BACKUP

Making a site backup means making a copy of all site-relevant data on the PC onto removable media such as
network, USB flash drive, external Hard Disk or tape. A site can then be recreated on another PC running CXpro*®
from this site backup.

Making a site backup

To backup a site, right-click on the site in the Site Tree , and select Backup Site from the context menu:

L L s s
Hi =

E-Im i .
| 5. Discover Site

L Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

o
E-3o Samf

JE_E Store

You will be prompted for a location to save the backup file:

= ==

Select any suitable device or folder and click Save .
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Restoring a Site from a backup file

To restore a site from a backup, right-click on the Sites node in the
context menu:

5ite List

= O
-3

r A

Discover Site

-Ig
- 2 Import V7 Sites
H-Io

Pog .
H-1g Restore Site
---E“:. Campus block R

A-5n PL Office

Choose the required backup file and click Open :

AL ThSPC > Local DIk (C) 3 CHproHD MIRET HI »

i Name - Date moddied Type

10020801
APPLBACN

Archive
uemp BACNET®
BACMSER
Bitmaps.
CRMPBLOR
2 Eugenepesio Help
B This PC PLOFFICE
B 3D Otjects STORES
B Desiacp Synboks
2 Documents Setem
& Downioads
b Music

o oicp
& Onebiive

Temp

Templste.
UCIZMscros
= Pictunes Utiities

B videe:
u Local Disk €)
CXproD
Fie name: | ~| | CXprotD Backup (.CHB)

Open Cancel

Site Tree , and select Restore Site from the

If no site with the same name exists, then the restored site is added to the system as new site.

If a site by the same name exists, the user will be asked to choose either to overwrite the existing site or to

create a new site.

e If you choose to overwrite the site that has the same name, the existing site will be completely
overwritten. You will be asked to confirm that you want to proceed.

e If you choose to create a new site, you will be asked to enter a new name, and a new site will be added

to the site tree. The chosen name must be unique.

You can cancel the restore process at any time.
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SITE DISCOVERY

Strategy block data can now be uploaded from Cylon controllers and re-assembled into an easy-to-view layout.
This is useful when you have a Site where you do not have existing Strategy drawings or other information.

The purpose of the discovery process is to determine all of the Subnets (i.e. a Fieldous connected to a BACnet
Router) on a Site.

Note: All Subnets are searched so that the integrity of the data passed between Subnets (e.g. wide globals)
remains intact. This happens even if you are looking for information on a single Subnet.

This process can be lengthy, so please ensure that sufficient time is allocated for it.

However, you do not have to upload all Subnets at one time. If you specify a Subnet Range for a
specific upload, you can retrieve the other Subnets at a later point in time.

The upload process is started from the Site Tree , either from the Sites Icon (if the Site is not already in the tree) or from the

relevant Site node.

If the Site is not yet configured in the Site Tree

Click on the Sites icon in the Site Tree , and select Discover Site

Site List r B
=
o2

E| Import V7 Sites
00T - 001 - UCU3213V
.. 001-002- CBM24
Io BAChet Serial
H-To Sample Apps BACnet

Discover Site

This opens the Discovery Site Details dialog with all fields editable.

Discovery Site Details

Enter the details of the site you would like to discover below. For BACnet Sites with a
large number of devices, please ensure the Timeout value is large enough.

Site Details Network Type
Site Name " BACnet Serial

Site Directory * BACnet IP

Site Number |4 (Next free: 4)
Device ID Range |1 to [4134302
Wait Timeout (s) |25

MSTP Network

Cancel

Enter the Site Name and Site Directory directory.
If you do not want to retrieve all Fieldbusses on the Site, specify a Subnet Range .

Sites can be uploaded either through TCP/IP or through a serial connection. For TCP/IP connections, include the
IP Address and verify the port. Port 4950 is the default.

When configured, click Discover .
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If the Site is already configured in the Site Tree

If the Site is represented in the Site Tree —i.e. if it has been configured locally configured using the Configuration
Utility (CCConfig), click on its node in the Site Tree and select Upload Site :

Site List A x|
Sites

2o BACnetIP

o BACnet Serial

= JE.E Camr--—l..l....l,ﬂ :
EE ol Discover Site %

...... =
Export Aspect Data
o PLOf
EI_E_ ol Create BACnet EDE Data

@,, 001 - 001 - CEM24
JE_E Sample Apps BACnet

= B 01 - Wet Sucteme

Discovery Site Details

Please ensure the information is correct for the site you would like to discover, For
BACnet sites, ensure the Timeout value is large enough.

— Site Details — Network Type
Site Name |Campus block R ' BAChet Serial
Site Directory |CAI\-1PBLOR & BACnet 1P

Site Number | 5
Device ID Range “ to [4194302

Wait Timeout (s} |25

MSTP Metwork

Discover I Cancel |

The Discovery Site Details dialog will be displayed as before, but in this case the Site details are not editable.
When configured, click Discover .

After the discovery process is started, the Site Discovery Progress dialog appears showing its progress:

Site Discovery Progress

Below is the progress of the discovery process. Please wait until this is finished before
attempting to communicate with another site or press cancel to finish the process early.

r~ Site Details Summary
Name ’m “I-Am" Received Count ’O_
Mumber ’57 Properties Read Count ’0_
Network ’W

r Controller Discovery

Calling Whols on Network...

Reading Device properties...

Attempting to connect to site <Campus block R>... Cancel |

If you click Cancel to stop the process, any uploaded information is discarded and not applied to Site in CXpro*®.
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When the discovery has concluded, the discovered Fieldbusses /BACnet Routers are displayed in the Discovery

Results dialog:
" Discovery Results - X
- Site Details Summary

Name Tester Comms Contraller Count 1

= Fild Contraler Count 2

Network TCP[IP

| Mame | hum | Default Type ['ucaz | mo.Types | version [ Paddess | I

2 001 - UC32Net 1  UC32.netK/WFB.. Y 2 net WM 2.03.03 192.168.5.46
= o01-uc3224 1 uc3zae Y 3 UC32.246.2.1
= 002-uCI2is 2 uc3zie Y 2 UC32.166.2.1
Export to CSV Rescan i Continue "} Cancel

saus

The Export to CSV feature provides a convenient way to get subnet information and firmware versions of

controllers in the networks in CSV format that can be easily imported into Microsoft Excel.

If all known BACnet Routers are displayed and online in the Discovery Results dialog, click Continue to upload

Strategy information.

MANO133 rev 9

© Cylon Controls Ltd.

205



an04dxD

ASPECT® / INTEGRA™ EXPORT

This feature saves data for a Controller, Fieldbus (Subnet), or Site into a JSON-formatted text file for import into
ASPECT® or INTEGRA™, allowing applications to be automatically configured in ASPECT®-Studio or INTEGRA™ IT-
8000 .

Starting the Export

To export a Field Controller, BACnet Router, or Site, right-click on its node in the Site Tree and choose Export

ASPECT/INTEGRA Data .
B)-Fg BACnet IP
7-5o BACnet Serial
I
Ej | Discover Site
%_ g

I [}Export Aspect/integra Data
Create BACnet EDE Data
Upgrade BACnet Units

If a Field Controller is selected, that controller’s information is exported to the ASPECT® / INTEGRA™ . json file,
along with the parent network and parent site information as required to correctly import into ASPECT® or
INTEGRA™.

If a Fieldbus is selected, information for all controllers in that Fieldbus is exported along with the parent site
information as required to correctly import into Aspect.

If a Site is selected, information for all Controllers on all Fieldbusses within that site will be exported.
The points that will be exported will be those that are specified in the Export column of the BACnet Points dialog.

The BACnet Points dialog is opened by clicking on BACnet Points in the Strategy tab of the ribbon — see How to
expose Points on a BACnet system on page 134.

x|

- Select BACnet

Bacnet | Export [ Point Name [_roint adar [ point Type [

EEEEEEEEREE)
0

2

3
O Schedule No. 1 (On) 4 Digital Virtual
(m] Hysteresis Block 15 Active High 9 Digital Qutput

BACnet Point Usage | [~ Binary Unit String Usage

Maximum BACnet 224 Maximum Binary Unit 32

Used BACnet [0 Used Binary Unit B
Available BACnet [2s Available Binary Unit [
Export Total [z

Setpoint Li
Max Unexposed Setpoint and BACnet  [324 Unexposed 0

Available Setpoints / BACNet Points 31

Resoive Duplicate Point Names

oK Cancel |

[ —
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After exporting, set a name for the export file that you want. By default it is set to the name of the Site. The
filename extension must remain as . json for easy import into ASPECT® or INTEGRA™.

= Save As
T .« CXproHD » CAMPBLOR v ¢ Search CAMPBELOR »p
Organise * MNew folder 3= v [7]
. AITEMP A Name - ~
. CXproHD
.. ARCHIVE
. APPLEBACN
. dbase
. Archive
./ DRAWINGS
.. BACNMETIP
.. KEYPAD
.. BACMSERI
. MACROS
.. Bitmaps
. strat3
.. CAMPELOR
.. STRATEGY v
. ARCHIVE wila >
A RN Campus block R.json| v
Save as type: v

“ Hide Folders

Save Cancel

After setting the filename, click Save .

The process will begin to export information. The Creating Aspect Data... dialog will be displayed to show the
progress of the export:

Creating Aspect Data...

0071 - UC32netk. - 007 - UC3224
Processing: E of 12

o1
ool
o001
ool
ool
o1
ool
o1
ool
nm

- UC3Znetk -
- UC32netK -
- UC32netk -
- UC32netK -
- UC32netK -
- UC32netkK -
- UC32netK -
- UC3Z2netk -
- UC32netK -
- HE 2 natk -

012 -
012 -
012 -
012 -
012 -
012 -
012 -

o011
o1
1

uc3z224:
uc3z224:
uc3224:
uc3z224:
uc3z224:
uc3zz4:
uc3z224:
- UC3224:
- UC3224:
- HC 224

Datalog block 14 has a connected point that iz not named. A
Datalog block 131 has a connected point that iz not named.

Datalog block 250 has a connected point that is not named.

Datalog block 251 has a connected point that is not named.

Datalog block 252 has a connected point that iz not named.

Datalog block 253 has a connected point that is not named.

In path “/C/Aspect_v_Unitron/001_UC32netk/012_UC3224", "reset” iz a reserved word
D atalog block 14 has a connected point that iz not named.

Datalog block 131 has a connected point that iz not named.

Natalon black 260 has a connected noint that ie ol named

>

Close |

For any errors or warnings encountered, you will see the network (Fieldbus) name, the name of theController and
the action that should be taken. Correct these errors in the appropriate Strategy or configuration and then start
the Export process again.

You may stop the export process at any time and review the errors and warnings.

You may copy the errors and warnings from the dialog into a document or email.

When finished, click Close to complete the process.

Import into ASPECT®-Studio and INTEGRA™-ProPack

Refer to MANO129 ASPECT®-Studio for details about importing the . json data into ASPECT®.

Refer to MANO140 INTEGRA™ ProPack for details about importing the . json data into INTEGRA™.
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Launching CXpro"® from INTEGRA™-ProPack

When an export file from CXpro"® is imported into an IT-8000, it is then possible to launch CXpro"® from the
INTEGRA™ Ul — targeting a specific controller for engineering or debugging.

In order to do this, ensure you have CXpro"® installed on your computer and INTEGRA™ version 4.7 or greater is
installed on the IT-8000 or supervisor. Also, ensure that the CylonService is installed.

You must also have a copy of the CXpro"® project and strategies in CXpro*P.

Note: The CylonService uses the site name and device instance numbers to locate the strategy in

CXpro*"®, so you must ensure that the site name in the INTEGRA™ station matches the site name
in CXpro"'®. To verify or edit the site name in the INTEGRA™ station, open the property sheet for

CylonBacnetNetwork :
! Config @ Drivers  © CylonBacnetNetwork
Property Sheet

@ cylonBacnetNetwork (Cylon Bacnet Network)
[ status {ok}
[ Enabled @ true
@ Fault cause
[ Health Ok [06-May-19 10:34 AM EDT]
© Alarm Source Info Alarm Source Info
L Monitor Ping Monitor
B Baenet comm Bacnet Stack
Bl Local Device Local Bacnet Device [device:10000]
X Tuning Policies Bacnet Tuning Policy Map
[ site Name ProPack
@ uploadonstart @ e &
1 INTEGRA BacnetDeviceFolder:INTEGRA

To launch CXpro®®, right-click on the Cylon controller and choose Launch CXproHD :

“er Cylon Bacnet Device Folder

8RE Cylon Bacnet Device @Oc

4 loar Cylon Bacnet Device Folder

© orivers Launch CXproHD
6 NiagaraMetwork

e CylonBacnetMe

‘ Local Device

E Bacnet Comrgesrem Cylon Bacnet Device @ o c

Q Monitor

X TuningPolici

Views

Actions 1 Cylon Bacnet Device Folder

Cylon Bacnet Device Folder

204 3T Cylon Bacnet Device @ O c

A chill Mak a
ﬂl = D 2iVAV  Cylon Bacnet Device @ O c
s CEX_8RS

Edit Tags

A FirstFlonr e
CXpro"® will open at the project and the last-saved strategy for the selected controller, allowing you to debug,
make code changes, and download to the controller.

@ services L iselectAll | Modules Text Terminals Modules i STategy Detalls
site Controller | Clipboard Strategy
 orivers

FHmE e
O Niagarahetwork o

site List o x [ 002_01.532
 cylonBacnethetwork
E-@g) Sites
Bl Local Device H-2a 10020600
E Bacnetcomm -2 10020601 . — .
2 ‘Analog Input T
L monitor B-ig g;x: Al SwTemp
% TuningPolicies Hze i B S ———
-2 BACnetIP ek L
I chiller B 2g BACnet Serial . . Co
o CBi_RS B-2g CBXERS
P FirstFloor 5 cylonimpart_1000 _ Al ‘Analog Input _ _ _
B g NewSite RWTemp
© seps 5-g ProPack . }—"“"”‘S’J?—.!
& Files o5 cexi el
&), CBTI2VAV -
alette ) (7 e 7 _ )
0 1o SWTStPt
X B @ olonserice I Point O - #——————&
3 cylonservice
 CylonBacnethetwork
9 CylonBacnetDeviceFolder DI Digizllnpr 1%
= PmpiStat
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ADDING UNITS OF MEASUREMENT

Additional units of measurement may be added to the existing list of units in a site to allow for a greater range of
applications. Units must be added to the site.ini file in the C:\CXproHDCXpro®P?\ (SITENAME)\SYSTEM

directory

Note: Before changing the site.ini file, make a backup copy (for example, site.ini.bak).

The site.ini file can be edited in a word-processing program such as Microsoft Windows Notepad, or
Microsoft Word. If you use Word to edit the file, make sure to save the file as a "Text Only" document.

How to add units of measurement to the system

e  Make a backup copy of site.ini.
e Opensite.ini, usingaword processing program.
e Search for the [AnalogUnits] section if adding analog units, and the [DigitalUnits] section if
adding digital units.
e Either
o edit one of the entries marked “spare”
(e.g. change UNITS61="Sparel" to something like UNITS61="m/s")
or
o append the new units to the list of units
(for example, add something like UNITS74="m/s" to the end of the list of analog units).
If you add to the list in this manner, be sure also to increment the NumberUnits parameter so
that it matches the final number of units. Ensure the the number at the end of the units
variable (e.g. UNITS74) has a number at the end that matches its place in the list of units.
e Savetheamended site.ini file.
e Close and restart CXpro"®, to allow the changes to take effect. The new units can then be selected from
list boxes for point configurations.

210

© Cylon Controls Ltd. MANO133 rev 9



EXAMPLE OF ADDING UNITS TO ANALOG UNITS LIST

40 syun Suippy :: xipuaddy

0ld analog units kst: Hew list after changing:
[inalooglinits] [inalooiinits]
MNumberThits=19 Nmbherhits=21
Title="IT" Tit le="Unic"
TNITS1=" " TNITS1=" "
TNITSE=" %" THNITSZ=" %"
TNITEZ=" %rH" THITSZ=" %rH"
TNITS4=" °C" TNITS4=" °C"
TNITZE=" Bits" TNITSE=" Bit=s"
THITZE6=" o kg" UNITEE=" gilg"
THNITS?=" Hz" UMITS?=" Hz"
TNITS2=" kj. kqg" UNITSS=" kj/Eqg"
TNITE3=" kElih" THNITSS=" kiTh"
THITS10=" L/s" UNITES10=" Lss"
TNITS11=" Min" THNITS11=" IMin"
TNITE1E=" mW" TNITS1E=" m\™"
TNITZ13=" Pa" THNITS13=" Pa"
TNITS1l4=" Zek" TNITS1l4=" Zek"
TNITS1E5=" Std" THNITS15=" Stcd"
TNITS1le=" Wolt" THNITS1le=" Wolt"
THITE17=" har" UMITE17=" bar"
TNITS1lg=" K" THNITS18=" E"
TNITE13=" Thr" THNITE13=" Thr"
THNITSZ0=" ms="
UNITEZ1=" kg/m3"

Note: Units are also listed in the C:\CXproHDCXpro®#2\SYTEM\WN3000.ini. However, this file is for
legacy applications only and applies throughout the Cylon Software system, and so must not be
edited.

Note: Take care when editing site.ini not to change the section headings [AnalogUnits],
[DigitalUnits] etc.in any way, because this can cause errors in the Cylon Software system.
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FILE MANAGEMENT IN CXPROMP

On a large site with multiple BACnet Routers where more than one engineer will be commissioning software at
any one-time file management becomes very important.

You must insure that no one modifies the same strategies / global files that an engineer is currently
commissioning. To guard against this, we would recommend that all files are stored on a central computer and
only the files required for commissioning are copied onto the engineer’s laptop. We would also recommend that
each engineer is allocated a single BACnet Router to work on at any one time. At the end of each day /
commissioning period the data files for the BACnet Router are copied back onto the central computer.

The data files required to commission a single LAN are as follows:

C:\CXproHDCXproH#P\ [SiteName] \dbase \* Where * is the address of
the BACnet Router to be
commissioned.

All files under Where *** is the address of

C:\CXproHDCXpro#P\ [SiteName] \strat5\*x** the BACnet Router to be
commissioned.

The same files should be copied back to the central computer at the end of each day / commissioning period.
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CXpro"'® includes two utilities that facilitate the commissioning of BACnet Sites: the integrated Discovery Tool,
accessible from the Site Tree , and the separate application NB-Pro.

NB-PRO

NB-Pro is a generic commissioning environment for BACnet controllers. Using NB-Pro, users can setup and
configure devices to create control programs and strategies for building automation systems, including Cylon
BACnet. For details see MANO122 NB-Link & NB-Pro.

Note: For NB-Pro to work with CXpro"®, you must open the Settings menu NB-Pro and select Network
Configuration . In the Network Configuration dialog, select the Remote IP radio button in the
Communicate Via: section so that NB-Pro does not attach to the BACnet UDP port of the PC as this

would block CXpro"®. Also, register NB-Pro as a foreign device on a CBR on the network by
entering the CBR’s IP address in the Network Configuration dialog’s BBMD Device field.

DISCOVERY TOOL

The purpose of the Discovery Tool is to allow users to see all live BACnet devices, objects and properties on the
network via CXpro"®. It also allows some or all of the discovered objects to be added to an existing Engineering
Centre Site or allow a new Site to be created with the discovered objects.

For existing sites, this tool is used to compare the site configuration with the devices that are live on the
network. It is possible to change the present value property of some objects.

BACnet Explorer

The Explorer is an extension of the Discovery Tool. It is available in CXpro"® by right-clicking on a BACnet Site in
the Site Tree and selecting Discover Site .

Site Navigation x

This opens the Site Discovery dialog, which is prefilled with the selected Site’s information:

Site Discovery

Please ensure the information is comect for the site you would like to discover.
For BACnet sites, ensure the Timeout value is large enough

Stte Details

Network Type
Site Name Eazst Hall i
Ste Diectory  |EASTHALL ;
Site Number 4 o
~

Address Ra 1 to |4134302

ress Range I &
Wait Timeout () [25
MSTP Metwork No.

Discover | Cancel
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If the Discover Site option is selected from the context menu of the Site Tree’s root node,

x

Discover Site

A B | acal Mebwnardk

then the Site Discovery dialog will be blank, and can be used to create a new Site.

Site Discovery
Enter the details of the site you would like to discover below. For BAChet Sites
with a large number of devices, please ensure the Timeout value is large
enough.
— Site Details
Metworls Type
Site: Name || ™ Serial Connection
o  Uritron
Site Directory
l " BAChet
Site Number I ¥ Remote Connection
Address Range |1 to [+134302 " Uniron TCP/IP
" BACnet IP
Wait Timeout {s) |25
MSTP Network No.l
Digzover | Cancel |

The Site Discovery dialog has the following fields:

Network Type
(If an existing Site is selected, this selection cannot be changed).

If a site is not selected, select a Network Type that will apply if you choose to create a site from the Explorer
during the current exploration:

e Network 1 for Serial and Modem Sites

e Network 2 for TCP/IP or BACnet Sites

Site Name
(If an existing Site is selected, this field will not be editable).

If a site is not selected, enter a new Site Name here. If you choose to create a site from the Explorer during the
current exploration, this is the name that will be used for it.

Site Directory

The Site Directory is automatically generated from the Site Name, but it can also be user defined. Do not use

special characters in the Site Directory Name.

Site Number
(If an existing Site is selected, this field will not be editable).

If a site is not selected, specify a Site Number . If you choose to create a site from the Explorer during the current
exploration, this is the Site Number that will be used for it.
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Address Range

This can be used to limit the Discovery process. Only BACnet addresses within this range will be tested.

Wait Timeout (s)

This sets the length of time that the process will listen for I-Am responses during discovery.

Larger Sites require higher Wait Timeout(s) to explore the entire site (default 10 seconds)

Network

The user can choose a specific network to discover in this dialog box. If the user enters a network number, only
devices on that network will be displayed. Leave this blank if you want to show devices on all networks.

The Discover button will launch the progress dialog.

— ]
Site Discovery Progress

Below is the progress of the discovery process, Please wait untl this is finished
before attempting to communicate with another site or press cancel to finish
the process early.

[ Site Details Summary
[eom I BACnetExplorer Online Devices 0
Number I 5 Current Device 0

Network I BACnet

i~ Controller Discovery

Calling Whols on Metwork...

] =/l 9

Reading Device properties, .,

| )| I

i Cancel

Calling Whols on Metwork...

A Whols call is made, and then the system waits for the specified timeout (default is 10 seconds) after which it
reads the BACnet information for each Device that responded with an I-Am message. When this is complete, the

results dialog opens:
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Cylon BACnet Explorer E\L

>
e
el
o
>
a
=
Site Details I B
Name BACetExplorer This is the BACnet Explorer dialog. ?;
(@]
Number 5 >
1)
Num, Devices |9 -+
m
<
BACnetExplorer Name | MAC | Def.Type | Types | Model [ D [ vendor | Network | P Add | =3
=] Cylon BACnet Router - Chris (50 | Cvlon BACnetRo... 1 CBR. 3 Cylon BACnetR... 6000 171 a 132.168.6.38 2
T & Objectist Unitron Slave UC... 1 UC32.24B... 1 UnifronVirtual .. 1220 171 61000 o
O JRet-Lis Controller type ... 14  UC32.34B... 2 uc32. 24 1054 171 £0000 7]
Unitron Slave UC1 (2) (1220 | Cylon BACnetRo... 2 CER. 3 CylbnBAChetR.. 49 71 0 192.168.6.40
Contraller type UC32.24 {1 | Controller fypaU... 1 UC32.24B... 2 UC32.24 6767 171 51
: Controller typeU... 2 UCU12BAC... 2 ucu12 sz 17 51
B~ [¥]== Cylon BACnet Router 43 (48) | cyion BAChetRo.., 3 CBR 3 CylonBAChetR... 141077 171 0 192,168.6.35
16 objectList 001-UC3224BA.. 1  UC32.24B.. 2 uC32. 24 1907 171 51
2 UCU12BAC. 2 ucu12 14079 171 51

Controller type UC32.24 (57 | 002 -CET12
Controller type UCU12 (375
- [/]5. Cylon BAChet Router 43 (14107
[ object-List

001 - UC3224 BACnet (1410
[¥]'= 002 - CBT12 (141079)

< mn 2

I Select all devices to add to Site Rescan Network | Add Selected Devices to Site Close |

Number of devices found: 9

The results dialog contains two panels:
e The left panel contains a tree view list of the BACnet devices and objects discovered.
e The right contains information regarding the selected device or object.

It is possible that not all devices would be discovered during the specified Wait Timeout(s) ., so if necessary you
can re-scan the network for further devices by clicking the Rescan Network button. The Site Details dialog will
open again so that the settings for Address Range , Wait Timeout(s) and Network number can be adjusted. Devices
that have already been discovered will be skipped, so that further devices may be discovered even if none of the
settings are changed.

The tree view is similar to the existing site list in other applications. The site is the root node of the tree, followed
by the routers and then devices under those. Under the device nodes there are other nodes in the Object List.
Expanding this will show each object read in from the parent device.

As an extension of the Site Discovery Tool, the Explorer allows devices to be added to the Site specified in the top
left corner of the Cylon BACnet Explorer dialog (which may be an existing site or a new site that will be created
when devices are added).

To add devices to the selected site, check the box beside each required device in the Site Tree and click on the
Add Selected Devices to Site button. To quickly select all of the discovered devices check the Select all devices to add
to Site box beneath the Site Tree. Non-Cylon devices will be added as virtual controllers and have a Cylon
address of 131 or above.

When the root of the tree view is selected, the right panel contains a list of the BACnet devices found, along
with: device name , MAC address , vendor ID, model name , IP or MSTP Address , Network and estimated Controller

Type .
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rSite Details
1
= BACnet Explorer This is the BACnet Explorer dialog. Below is the list of devices that were discovered. To edit any of the details double dick on an
item in the list. To begin reading in the object list of a device expand its node in the Tree View.
Number g Any newly discovered devices will be in white, Devices that have already been configured will be highlighted in Green or Red.
Green means that the device discovered matches the addressing of the site configuration. Red means there has been a dash
MNum. Devices |8 between the device information discovered and the device information in the site configuration.
|
Mame | MAC I Type I No. Types I Model | Instance I Wendor | Netw... | IP Addr
B Cylon BACnet Router 49 (3000) | Cylon BACnetRo.., 1 CER [ Cylon BAChetR. .. 3000 171 515 192,163.6,4
s ObjectList Controller type U... 4 CET13VAV 1 ucui13 2221 171 515
Cylon BACnetRo... 2 CBR [ Cylon BACnetR. .. 43 171 77 192.168.6.3
[#]'=) Controller type UCU13 (222 | Controller type ... 1 CBM24 1 uca.24 141078 171 7
B- Cylon BAChet Router 49 (43) UCU12 CT12229... 2 CET12 1 ucu12 141079 171 77
0 Object-List
Controller type UC32.24 (14
+ UCU12 CT122290324 (1410
4 1 [ (1] | +
[V Select all devices to add to Site Rescan Metwork Add Selected Devices to Site Close |
[~ Sort Objects By Instance Number

Number of Devices found: 8 /4

There is also a column ( No. Types ) which shows the number of possible Cylon controller types this device could
be.

Cylon devices are initially set as a CBM24 controller type, but this can be changed in the Controller Properties

dialog. The ‘Type’ of a non-Cylon device cannot be changed in the Controller Properties dialog, but if they are

added to the Site, they will appear as CBM24 in CXpro"'®, and this can be changed in the Configuration utility
(CCConfig).

To open the Controller Properties dialog, double-click on the device in the right-hand panel.

r Controller Details

Name I Controller type UC3224
Model I UCc3z. 24
Address I 1

Possible Types ICBM24 LI
Device Instance I 141078
Number

oK I

—Controller Details

Name I BASRT-E
Model I BASRT-B
Address I 4

Possible Types I 3rd Party LI

Device Instance 1970
Number

oK I Cancel |

You can then change the Name , Type, Address, and Device Instance Number before adding them to the site.

Note: This will only change the name of the device in the database on the PC, it will not change the
name on the device itself.

When the device node of the tree is expanded or double-clicked, the object list of that device will be read in. As
each object is received from the device it will be added as a child to that device node. At this stage the right-hand
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panel will display the object list with a column for object ID, object type , object name , and present value and this
list will be populated as objects are read in.

—

Cylon BACnet Explorer [ 0

[~ Site Detail
— l—E,CHEEmcm This s the BACnet Explorer dialog.

|

Number 5
Num, Devices | 10

>
©
©
o
3
=
x
os]
>
(@]
=}
(0]
-
m
x
=
o
=
]
=
(7]

[] 5y BAChetExplorer « [ Object Name | ObjectID | Object Type [ value
Cylon BACnet Router - Chris Unitron Slave UC1 (2) 1220 {8) Device 0.00
1.17 analog 17 (2) Analog Value  0.00

1@ obectist 1.18 analog 18 (2) Analog Value 0,00
=8 [ =R unitron Siave UCL (2) ( 115 anzlog 19 (2) Analog Value  0.00
18 tniton Siave U1, | | 1:20anlog 20 (2 Anclog Value 000
1.21analog 2 (2) Analog Value  0.00

@ 1.17analog (17 1.22 analog 2 (2) Analog Value  0.00

& 1.18analog (1) 1.129 digital 12 (5) Binary Output 0,00

. +.18 analog (18] 1.130 digital 130 (5) Binary Cutput  0.00
L1181 15andog (1) 1131 digital 131 (5) Binary Output  0.00

@ 120anaba () |z | 1132 digital 132 (5) Binary Cutput 0,00

~[] @ 1.21analeg (21) 1.133 digital 133 {5) Binary Output  0.00
C18 L22andoa 22) 1.134 digital 134 (5)Binary Cutput  0.00

-~ ] @ 1.129 digital (125)
] 1130 digital {130)
16 1131 digital (131)
[J@ 1.132 digital (132)
16 1133 digital (133)

~[] @ 1134digital (134

& [7] =) Controller type UC32.24

16 controller type UC3

] 6 sacnet RTC Trendic

[ 6 sacnetRTC Trende

Cylon BACnet Router 49 (49)
] 6 object-List -

2 —

I select all devices to add to Site Rescan Network /Add Selected Devices to Site Close

Successfully read Object list from Device

When an object is selected in the tree view, the properties of that object will be read from the device and the
right-hand panel will contain the properties and values of that object.

From the results dialog, the user will be able to change the present value property for some of the objects.

Note: To refresh a specific object, right-click on that object.
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Check Against Existing Devices

When using the BACnet Explorer on an existing site, any discovered devices must be checked against those that
have already been configured. This is done by comparing the Device Instance Number of each discovered device
against the Device Instance Number of any devices on the site configuration already.

For any discovered devices that have the same Device Instance Number as a device on the PC, there will be a
comparison made between the MAC address discovered and the Cylon address.

e |f these match, the device will be highlighted in the list in green to signify that the devices match. A
matching device cannot be edited.

e [f they do not match, then the device in the list control will be highlighted in red to alert the user to this
mismatch. The user will be given a choice to resolve the mismatch

e [f the Device Instance Number does not match any other ID on the PC, then this discovered device will
not be highlighted and will be left white. Non-matching devices can be edited.

Changing the Present_Value Property

The present value can only be written to commandable BACnet objects. Commandable objects always have the
‘present value’ property and two additional properties —Priority Array and Relinquish Default.

e Analog Output, Binary Output and Multi-State Output objects are always commandable.

e Analog Value, Binary Value and MultiState Value objects can be commandable, but this is decided by
the vendor.

To change the present value of a commandable object, double-click on the present value property in the right
panel. If the object has the required properties, this will open the Change Present Value Dialog :

= r
Change Present Valus m M

Below is the Priority Array of the -

gelected object. To change a | Priofity | Value |
value, select the checkbox and
enter the new value, Leave the
value blank or set to "NULL" if
you would like to relinguish this
value.

MULL
MNULL
MULL
MNULL
MNULL
MULL
MNULL
mm
MNULL
MULL
MNULL
MNULL
MULL
NULL
12,567
2.58

Object Details

Device ID ,W
Object Name | Analog

Object Instance 10

Object Type ,m
Present Value 12.57

Th ke B v Ao e

—
n

REEOOO0OOO0ROOOOOO0O

[
@

Change Selected Values

Close |

The table on the right-hand side of this dialog shows the current priority array of the object. To change or
relinquish the value, you must select the checkbox beside the relevant priority index. By selecting the checkbox,
you can edit the value at that array. To relinquish that value, clear the contents in the box or set it to “NULL".

When the Change Selected Values button is clicked, the value for any priorities whose checkbox is ticked will be

sent to the BACnet object. This will update the priority array on the device and to show this, the list items,
present value andpriority array, in the Explorer dialog will be updated too.
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HOW TO CONFIGURE A CONTROLLER’S BACNET SETTINGS

When a Field Controller is first commissioned, its address must be set by connecting CXpro"® directly to the
controller by RS232 link (Service Port). If points on the controller are to be exposed on a BACnet network, or if
CXpro*® is to communicate with the Field Controller by BACnet Tunneling, then the Field Controller's BACnet address
(Device Instance Number) must also be set.

These device settings, and others, can be set from CXpro*"® as follows:

Note: Some parameters can be set over Ethernet connection, but Controller Address and Baud Rate can
only be set when the Engineering PC is connected to the controller by RS232 link.

In CXprot®, select BACnet Configuration from the Controller tab of the Ribbon

me Controller Strategy
%Communications lﬂ Download |_'_’E|Co
ect % Contraller )?:'EWipe Contraller Shs
#, BACnet & Auto Online

Configllx?tion
a

This opens the BACnet Configuration dialog, which defines how the Controller will communicate on the BACnet

network, and how it will communicate with CXpro"® for configuration over BACnet.

In this dialog, each current value and the proposed new values can both be displayed at once. Defaults can also
be automatically generated.

3

Note: Only Device Name , Router Address and MSTP Max Masters will be editable when the Engineering PC

is connected over Ethernet. In order to edit the other parameters, it must be connected by RS232
serial link.
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The parameters that define how the Controller communicates on the BACnet system are:
e Device Instance

Enter the required BACnet address (0 —4194303).
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Note: The number set here in the Field Controller (when connected serially) must match the Device
Instance Number set in CXpro"®.

e Device Name
Any descriptive text.

¢ Tunneling Properties: Site and Comms Ctrl

Note: All of the Cylon controllers throughout the BACnet system must have the same CXpro"P “Site
Number”.

In the Device Properties dialog set the Site and Comms Ctrl matching the position of this Controller in the Site
defined in the Cylon Configuration utility (CCConfig).

e MSTP Max Masters

This must be equal to or greater than the highest address used on the BACnet MS/TP fieldbus, because this
controller will not pass data to devices with addresses higher than this. The optimum situation is that this value is
set in all devices to exactly the value of the highest address on the fieldbus. (1 - 127)

Note: It is recommended that you address your controllers consecutively starting at 1, with the MAX

Master value matching the Maximum Controller address value. For optimum efficiency there should
be no gaps in the device addresses.

e APDU Timeout

(@ ... 60 seconds) this value should be left at its default unless there is a problem.
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COMMISSIONING A RANGE OF CONTROLLERS QUICKLY (MASS COMMISSIONING)

CXpro"® includes a utility to quickly commission the MAC, Max Masters, Device IDs and Names of Cylon controllers.
The utility can be launched by right-clicking on a Site or a Router in the Site List :

Site List N < ]
=] @ Sites
E-$o 10020801
2o BACnet P
JE_E BAChet Serial
':I-E Campus block R

001_02.532

i)
(R o R )
{

m
T Eln

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

&

rnln
=
2

| C ; mission BACnet Devices

B

Site List

LN < R 001_02.532

=- 0 5

ites

10020801
BACnet IP
BACnet Serial
Campus blocl
PL Office

Sample|

kR

Export ASPECT/INTEGRA Data
Update BACnet EDE Data

Comi I. sion BACnet Devices

Stores

. 1Al

Note: The devices must be configured within CXpro"® before they can be accessed by this utility.

If launched from a router, only the devices on that subnet will be pinged. If launched from the site, all devices on

the site will be pinged.

Commission BACnet Devices

All Devices Serial Mumber | MNetwork ‘ MAC Device ins... | Name | Max Masters | Strategy Type
515 30 3001 CEM desk test 0 Strategy ID: 0
Commission Devices
Finding online devices...
Apply |
—Offiine [ Misconfigure|
serialtumber | 1 |
515 2 4000 001-002-CBX... CBX-8RB Strategy ID: 0 Offline
515 1 405 CBX Chris Desk CBX-8R3 Strateqy ID: 0 Offline

>

Recondle Issues |

Rescan | Timeout (s) |5

Close |
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When pinging is complete, the Commission BACnet Devices dialog is displayed:

Commission BACnet Devices

All Devices Serial Number | Network | MAC Device ins... | Name | Max Masters | Strategy Type
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: 0

I
o
3
3]
=
73
5
=3
=}

oQ
IS
o
=}
3
=
=}
[}
o)
1%
g
=
=5

Applvl

~Offine / Misconfigured Devices

Serial Number | Network | MAC Instance (PC) | Instance (Ctrl) | MName | Type (PC) | Type (Ctrl) | Strategy Type | Issues
515 3 3443 001-003-CB... (CBMOB Strategy ID: 0 Offline
515 2 4000 001 -002 -CBX... CBX-8R3 Strategy ID: 0 Offline

Device instance does not m

< >

Recondle Issues |

Rescan I Timeout (s) |5 Close |

The upper-right pane of the the Commission BACnet Devices dialog lists all of the devices configured in the CXpro®
Site that have been successfully discovered on the BACnet network.

The lower pane of the the Commission BACnet Devices dialog lists devices that are configured in the CXpro"P Site

but have not been successfully identified on the BACnet network. Devices that partially match the CXpro"® Site
configuration are highlighted in red — for example a device has been found that matches the MS/TP Network
Number and MAC Address of a configured device, but the Device Instance Number does not match.

If you want any of the devices highlighted in red to be included in the Commissioning process, tick the checkbox
to the right of red highlight. When all such devices have been selected, click the Reconcile Issues button.

The configuration of the device in the CXpro"® Site will be updated to match the corresponding discovered
device, and the device listing will move to the top-right pane:

Commission BACnet Devices

All Devices Serial Number | Netwark | MAC Device ins... | Name | Max Masters | Strategy Type
- CBV S - Integral Actuator CH16744165C 515 1 4000 CEX Chris Desk 50 CBV US - Integral Actuator
CU12142008F 515 30 3001 CEM desk test 127 Strategy ID: 0

- Offline f Misconfigured Devices
Serial Number | MNetwork | MAC Instance (PC) | Instance (Ctrl) | Name | Type {PC) | Type (Ctrl) | Strategy Type | Issues
515 3 3443 001-003-CB... (CBMO3 Strategy ID: 0 Offiine
515 2 £ 001-002-CBX... CBX-8R8 Strategy ID: 0 Offline
< >
Recondle Issues |

Rescan | Timeout (s) |5 Close |

Note: If reconciling might create duplicate IDs, the conflicting offline devices are renumbered to a
value above 4000000 to ensure that they will be unique.
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If no match is found for the MS/TP Network Number and MAC Address of a configured device, that device is listed in
the lower pane as 0ffline, marked with a grey background and cannot be included in the Reconcile Issues
process.

To retry pinging offline devices, click the Rescan button on the bottom left of the dialog.

The upper-left pane of the Commission BACnet Devices dialog shows categorized devices found organized by
strategy ID.

Sk N AN AT AR TR AR

Ser

133
123
122
143
13
122

This groups devices by the type of strategy they contain (e.g. single or dual duct VAV, or RTUs, Fancoils etc), so
that common properties can be edited together.

Clicking on All devices will show only the properties that are common to all devices of MAC, Max masters, Device
ID, Name, Serial Number and Strategy Type.

Clicking on a strategy type in the left-hand pane means that additional parameters common to that strategy type
will become available in the right-hand pane:

= Al Devices Senal Numbee  MAC Max Masters Device ID Narne Type Input Config  Output Config
| Sgle Duct VAV) 3
el Ot VAV 12345671 1 127 12341 VAVST386 137 48 18
Fan Col 12345672 2 127 12342 VAVST388 137 43 18
RTU 12345673 3 127 12343 VAVST390 137 4 18
12345674 4 127 12244 VAVST392 137 43 18
12245675 : 127 1245 VAVSTI34 137 43 18
12345676 3 7 12346 VAVST3% 137 48 18

Each of the fields can be edited individually.

However, it is also possible to copy a single value to multiple controllers at once, so that device types that are
installed identically - for example VAVs — can be configured in bulk very quickly (similar to copy & paste in a
spreadsheet program).

When appropriate, editing a single field will be assisted by a properties window that indicates what the setting
value will mean:

CEes

Serial Number MAC Max Masters Device 1D MName Type Input Con Output Config
! 12345671 1 127 12341 VAVST386 137 43 18
12345672 2 127 12342 VAVST™"™" T - -
12345673 3 127 12343 vays] VAVST386 Config Properties
12345674 4 127 12344 WAVST Pudillary heat True
12345675 5 127 12345 WAVST Control Method ~ Standard
12345676 13 7 12345 WAVST
Control Methed
This is the control sequence applied to this
VAV

Apply Cancel
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When all of the fields have been configured, click the Apply button, and the full set of edited parameters will be
sent to all controllers. A progress dialog will be displayed, indicating progress and highlighting any failures:
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Progress
Serial M... MAC Max Masters Device 1D Name Progress
12345671 1 127 12341 WAVST386 Complete
12345672 2 127 12342 WAVST388 Controller write failure. ]
12345673 3 127 12343 WAVST3S0 Complete
12345674 4 127 12344 WAVST392 In Progress
12345675 5 127 12345 WAVST394
12345676 6 7 12346 WAVST396
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